Warranty

Spirent Communications, Inc. (“Spirent”) warrants that its Products will conform to the description on the face of order, that it will convey good title thereto, and that the Product will be delivered free from any lawful security interest or other lien or encumbrance.

Spirent further warrants to Customer that hardware which it supplies and the tangible media on which it supplies software will be free from significant defects in materials and workmanship for a period of twelve (12) months, except as otherwise noted, from the date of delivery (the “Warranty Period”), under normal use and conditions.

To the extent the Product is or contains software (“Software”), Spirent also warrants that during the Warranty Period, the Software which it supplies will operate substantially in accordance with the specifications supplied by Spirent for such Software. Spirent does not warrant that the functions contained in the Software will meet a specific requirement or that the operation will be uninterrupted or error free. Spirent shall have no warranty obligations whatsoever with respect to any Software which has been modified in any manner by Customer or any third party. The Warranty Period for Wireless software products shall be defined as ninety (90) days from the date of delivery.

Defective Products and Software under warranty shall be, at Spirent’s discretion, repaired or replaced or a credit issued to Customer’s account for an amount equal to the price paid for such Product provided that: (a) such Product is returned to Spirent after first obtaining a return authorization number and shipping instructions, freight prepaid, to Spirent’s location in the United States; (b) Customer provides a written explanation of the defect or Software failure claimed by Customer; and (c) the claimed defect actually exists and was not caused by neglect, accident, misuse, improper installation, improper repair, fire, flood, lightning, power surges, earthquake, or alteration. Spirent will ship repaired Products to Customer, freight prepaid, within ten (10) working days after receipt of defective Products.

Except as otherwise stated, any claim on account of defective materials or for any other cause whatsoever will conclusively be deemed waived by Customer unless written notice thereof is given to Spirent within the Warranty Period. Spirent reserves the right to change the warranty and service policy set forth above at any time, after reasonable notice and without liability to Customer.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, ALL IMPLIED WARRANTIES, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, NONINFRINGEMENT AND FITNESS FOR A PARTICULAR PURPOSE, ARE HEREBY EXCLUDED, AND THE LIABILITY OF SPIRENT, IF ANY, FOR DAMAGE RELATING TO ANY ALLEGEDLY DEFECTIVE PRODUCT SHALL BE LIMITED TO THE ACTUAL PRICE PAID BY THE CUSTOMER FOR SUCH PRODUCT. THE PROVISIONS SET FORTH ABOVE STATE SPIRENT’S ENTIRE RESPONSIBILITY AND CUSTOMER’S SOLE AND EXCLUSIVE REMEDY WITH RESPECT TO ANY BREACH OF ANY WARRANTY.
Contents

About this Guide ......................................................... 1
Purpose ................................................................. 2
Audience ............................................................... 2
Manual Content ......................................................... 2
Conventions ............................................................. 4
Related Manuals ......................................................... 5
Online Help ............................................................. 5
How to Contact Us ....................................................... 6

Chapter 1: AST II Overview ................................................. 7
What Is AST II? .............................................................. 8
  Features and Capabilities ............................................. 9
Supported RFCs ........................................................... 10
Why Test with AST II? .................................................... 10
  Summary of AST II Tests ............................................... 11

Chapter 2: Basic AST II Theory .............................................. 13
General Test Terminology .............................................. 14
General Test Methodology ............................................. 20
  Basic Phases of an AST II Test ....................................... 20
  Basic AST II Test Structure ......................................... 23
General Steps to Set Up and Run Tests ................................ 39

Chapter 3: Install and Connect ............................................. 41
SmartBits Hardware Requirements ..................................... 42
PC Requirements ....................................................... 44
Installing AST II ......................................................... 45
Connection Procedures .................................................. 46
  Synchronizing Chassis ................................................ 46
  Setting up SmartBits Connections ................................ 47
  Establishing a SmartBits-AST II Connection ..................... 50
  SmartCard/Module Port Display in the Main Window ............. 52
  Preparing the DUT/SUT ............................................. 53
  Connecting SmartBits to the DUT/SUT ......................... 54

Chapter 4: Basic Navigation and Tools .................................... 55
The Main Window .......................................................... 56
  Selecting the Display ................................................. 56
### Contents

- **Main Window (Setup and Run Display)** ................................................. 57
  - Tabs ................................................................................. 58
  - Menus ............................................................................. 61
  - Toolbar ......................................................................... 68
  - Shortcut Bar ..................................................................... 70
  - Connection Indicator Light .................................................. 71
- **Main Window (Results Display)** ......................................................... 72
  - Results Tabs ...................................................................... 73
  - Status Bar ......................................................................... 79
- **Test Results** .................................................................................. 80
  - Saving Test Results ............................................................. 80
  - Exporting Test Results .......................................................... 80

### Chapter 5: General Test Setup

- **The General Test Setup Process** ......................................................... 83
- **Reserving SmartCards/Modules for the Test** ........................................ 85
  - Viewing the Available SmartCards/Modules ....................................... 86
  - Reserving and Unreserving SmartCards/Modules .................................. 87
- **Configuring the SmartCard/Module Ports** .......................................... 88
  - Changing Parameter Values ................................................................ 88
  - How to Configure Ports ..................................................................... 89
- **Setting the Test Options** ................................................................... 94
- **Setting the Frame Setup Parameters** .................................................. 98
- **Specifying Custom Frame and Burst Sizes for a Test** ............................ 104
  - Using Test Configuration Files ....................................................... 106
    - Saving Your Test Configuration to a File ......................................... 107
    - Loading a Previously-Saved Configuration File .............................. 108
    - Editing a Previously-Saved Configuration File .............................. 109

### Chapter 6: Forwarding Test

- **About the Forwarding Test** ............................................................... 111
  - What this Test Allows You to Measure .............................................. 112
  - What this Test Allows You to Determine ......................................... 113
- **Test Overview** ................................................................................... 113
- **Test Methodology** ............................................................................ 118
- **Selecting the Ports for the Test** .......................................................... 119
- **Configuring Test Parameters** ............................................................ 121
  - Running the Test ........................................................................... 126
    - Recommended Testing Method ...................................................... 127
- **Viewing Test Results** ........................................................................ 127

### Chapter 7: Congestion Control Test

- **About the Congestion Control Test** ................................................... 133
  - What this Test Allows You to Measure .............................................. 134
  - What this Test Allows You to Determine ......................................... 134
- **Test Overview** ................................................................................... 135
- **Test Methodology** ............................................................................ 136
- **Selecting the Ports for the Test** .......................................................... 137
Appendix G: Revision History ........................................... 267
Glossary ........................................................................... 269
Index .................................................................................. 273
About this Guide

In About this Guide...

This portion of the user guide covers the following topics:

- Purpose . . . . 2
- Audience . . . . 2
- Manual Content . . . . 2
- Conventions . . . . 4
- Related Manuals . . . . 5
- Online Help . . . . 5
- How to Contact Us . . . . 6
Purpose

This user guide provides information on all procedures required to perform tests using AST II 3.10 application software. This includes details on software installation, connection procedures, test setup and operation, and test results interpretation.

Audience

This user guide is for users of AST II 3.10 software. It is assumed that users of this guide are familiar with Microsoft Windows and SmartBits equipment, and have an intermediate knowledge of data communications theory.

Manual Content

This guide contains the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1, “AST II Overview.”</td>
<td>Provides an overview of AST II, including information on its features, supported hardware, and a summary of the AST II tests.</td>
</tr>
<tr>
<td>Chapter 2, “Basic AST II Theory.”</td>
<td>Provides information on the basic theory of AST II, including general test terminology, test methodology, and the basic steps to set up and run tests.</td>
</tr>
<tr>
<td>Chapter 3, “Install and Connect.”</td>
<td>Provides information on installing AST II and connecting your PC, SmartBits chassis, and DUT.</td>
</tr>
<tr>
<td>Chapter 4, “Basic Navigation and Tools.”</td>
<td>Provides information on how to use the various windows of AST II.</td>
</tr>
<tr>
<td>Chapter 5, “General Test Setup.”</td>
<td>Provides information on general test setup including reserving and configuring ports, and setting the test options and frame setup parameters common to all AST II tests.</td>
</tr>
<tr>
<td>Chapter 6, “Forwarding Test.”</td>
<td>Describes the Forwarding test, including test methodology, parameter setup, and test results.</td>
</tr>
<tr>
<td>Chapter 7, “Congestion Control Test.”</td>
<td>Describes the Congestion Control test, including test methodology, parameter setup, and test results.</td>
</tr>
<tr>
<td>Section</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Chapter 8, “Address Learning Test.”</td>
<td>Describes the Address Learning test, including test methodology, parameter setup, and test results.</td>
</tr>
<tr>
<td>Chapter 9, “Address Caching Test.”</td>
<td>Describes the Address Caching test, including test methodology, parameter setup, and test results.</td>
</tr>
<tr>
<td>Chapter 10, “Error Filtering Test.”</td>
<td>Describes the Error Filtering test, including test methodology, parameter setup, and test results.</td>
</tr>
<tr>
<td>Chapter 11, “Broadcast Forwarding Test.”</td>
<td>Describes the Broadcast Forwarding test, including test methodology, parameter setup, and test results.</td>
</tr>
<tr>
<td>Chapter 12, “Broadcast Latency Test.”</td>
<td>Describes the Broadcast Latency test, including test methodology, parameter setup, and test results.</td>
</tr>
<tr>
<td>Chapter 13, “Forward Pressure Test.”</td>
<td>Describes the Forward Pressure test, including test methodology, parameter setup, and test results.</td>
</tr>
<tr>
<td>Appendix A, “Search Algorithms.”</td>
<td>Lists the search algorithms that are used by various tests in Search mode.</td>
</tr>
<tr>
<td>Appendix B, “Formulas.”</td>
<td>Lists the formulas that are used by AST II to calculate various values such as the Interburst Gap (IBG).</td>
</tr>
<tr>
<td>Appendix C, “Valid Test Parameter Values.”</td>
<td>Lists the valid parameter ranges for many of the test parameters common to the various AST II tests.</td>
</tr>
<tr>
<td>Appendix D, “Test Results Counters.”</td>
<td>Lists and describes the test results counters for all of the AST II tests.</td>
</tr>
<tr>
<td>Appendix E, “ESD Requirements.”</td>
<td>Explains the proper process for handling and storing electrostatic discharge sensitive (ESDS) devices, assemblies, and equipment.</td>
</tr>
<tr>
<td>Appendix G, “Revision History.”</td>
<td>Describes the changes to this document since the last revision.</td>
</tr>
<tr>
<td>Index</td>
<td>A comprehensive index of terms used in the manual.</td>
</tr>
</tbody>
</table>
Conventions

This guide uses the following typographical conventions. These conventions cover the usage of **bold** and *italic* font styles, font types, and how important information is indicated in SmartBits documentation:

- **Italic**s are used to indicate titles of books, volumes, documents, sections of documents (such as chapters), window names, tabs, options, field or parameter names, and for general emphasis. For example:
  - The *SmartFabric User Guide* describes tests devices used in SANs (Storage Area Networks).
  - The *Traffic* area of the window contains four options.
  - The test results provide information on the *frame loss* of the device.

- **Bold** is used in procedures to indicate the following: selections or choices made during a procedure (such as menu options you choose, or tabs or buttons you click), the parameter or option you are specifying a value for in a procedure, and the values for parameters or options. You also use it to indicate directory paths. For example:
  - To connect to your SmartBits chassis click the **Connect** button or choose **Tools > Connect**.
  - To transmit traffic for 10 seconds for each *iteration* of the test, enter **10** in the **Test Duration** field.
  - The configuration files are automatically saved to the Config folder that was created when you installed WebSuite/Firewall (**C:\Program Files\Config**).

- **Courier** is used to indicate text you enter or input or for code samples.

- The terms **DUT** and **device under test** as well as **SUT** and **system under test** are used interchangeably in this guide. **DUT/SUT** is also used to indicate either.

- The terms **packet** and **frame** are used interchangeably.

The term **SmartCard** refers to a printed circuit board used in a SmartBits 200/2000 chassis. The term **module** generally refers to a printed circuit board used in a SmartBits 600/6000B/6000C chassis. The term **card** is often used in SmartBits software applications and in this manual to refer to either type of circuit board.

Notes, cautions, and other important user information are shown as follows:

---

**Note:** Calls attention to additional information or explanation.

**Caution:** Calls attention to procedures or practices that should be followed to avoid damage to hardware, or corruption and possible loss of software files and/or data.

**Warning:** Calls attention to operating procedures or practices that should be followed to avoid bodily injury or damage to equipment.
Important: Calls attention to important information or characteristics that might be overlooked.

Tip: Calls attention to helpful information about a product’s operation or setup that eases its use.

Indicates the beginning of a procedure.

Related Manuals

Additional manuals related to this AST II User Guide are listed below. All of these manuals are available in the Product Literature area of the Spirent Communications website at www.spirentcom.com.

- **AST II API User Guide.** Describes how to implement AST II tests by using customized command lines. The API may be used in either a PC or UNIX environment.
- **SmartBits System Reference Manual.** Describes all SmartBits hardware, accessories, and software applications.
- **SmartBits 600/6000B/6000C Installation Guide.** Explains the general hardware installation procedure for the SmartBits 600/6000B/6000C chassis. Also contains troubleshooting and cable information.

Online Help

AST II provides online Help for all windows and tabs. You can access online Help using one of the following methods:

- From the window you want Help about, press the **F1** key.
- Choose Help > **Contents** to view the entire contents of the Help file.
- Choose Help > **Search** to search by a specific topic or word.
How to Contact Us

Technical support is available Monday through Friday between 07:00 and 18:00 Pacific Standard Time.

To obtain technical support for any product, please contact our Technical Support Department using any of the following methods:

Toll Free: 1-800-SPIRENT (1-800-774-7368)
(available in the U.S. and Canada)

Phone: 1-818-676-2300

Fax: 1-818-880-9154

E-mail: support@spirentcom.com

In addition, the latest versions of user manuals, application notes, and software and firmware updates are available on our website at:

http://support.spirentcom.com

Company Address

Spirent Communications, Inc.
26750 Agoura Road
Calabasas, CA 91302
USA
Chapter 1
AST II Overview

In this chapter...
This chapter covers the following topics:

• What Is AST II? . . . . 8
• Why Test with AST II? . . . . 10
• Summary of AST II Tests . . . . 11
What Is AST II?

AST II is an industry-standard performance analysis tool for testing Layer 2 LAN switching devices. AST II consists of tests based on RFC 2285 and RFC 2889, which specify the terminology and methodology for use in benchmark testing of LAN switching devices.

The various AST II tests allow you to measure key performance criteria of your LAN switching devices such as:

- Throughput
- Frame loss
- Latency when forwarding broadcast traffic.
- Performance under congested conditions, including:
  - Determining if head of line blocking exists
  - Determining if forward pressure exists
- Address handling, including:
  - Address learning rate
  - Address caching

For information on the features, capabilities, supported RFCs, and a list of the various AST II tests, see the following sections:

- Features and capabilities of AST II, see page 9.
- RFCs supported by AST II, see page 10.
- Summary of the various AST II tests, see page 11.
Features and Capabilities

AST II provides the following features and capabilities:

- Tests single or multiple devices in a system configuration
- Supports multi-chassis operation
- Supports multiple users

**Note:** The *SmartBits System Reference* manual that was provided with your SmartBits chassis includes details on multi-chassis and multiple user operation.
- Provides configurable test parameters such as the following (the availability of the specific parameters depends on the test being used):
  - Test mode (Profile or Search)
  - Number of trials
  - Duration
  - Frame size
  - Burst size
  - Load
  - Number of ports in the test
  - Traffic distribution and direction
  - Number of addresses per port

**Note:** See “General Test Terminology” on page 14 and the Glossary for definitions of these terms and other key AST II terms and concepts.
- Scalable to 1023 ports. Depending on the type of test, a port can transmit, transmit and receive, or just receive.
- Allows you to set up a SmartCard/module port as a *monitor* port to record the test frames and non-test frames transmitted by the DUT/SUT during tests (not available for all tests).
- Allows you to save test configurations and test results to a single .ast file.
- Allows you to load a test configuration file to configure tests easily.
- Test results can be viewed in chart or tabular format (the charts can be exported as HTML files).
- Tabular test results can be exported in .csv format and opened later in applications such as MS Excel.
- Real-time counters can be viewed as events occur during a test.
Supported RFCs

AST II supports the following RFCs:

- IETF RFC-2889, “Benchmarking Methodology for LAN Switching Devices.”

Why Test with AST II?

AST II provides a series of tests that you can use to measure key performance criteria of Layer 2 LAN switching devices. The tests enable you to simulate extreme conditions to determine how the device performs. For example, you can use AST II to measure not only the frame loss and throughput of a LAN switching device, but you can simulate congestion on the test ports of the device to see how it responds to congestion.

The ability to test devices by simulating real-world conditions is a valuable tool that can be used to:

- Verify the functionality and performance of LAN switching devices.
- Accelerate the development and deployment of LAN switching technology.

Benefits of Performance Testing with AST II

In performance testing, AST II enables you to:

- Identify performance issues and boost product performance. AST II’s high port density allows you to test the capacity of the backbone of the DUT/SUT using hundreds of ports.
- Perform comparative product testing.
- Generate comprehensive performance test results for publication in industry-sponsored comparative analyses and reports.
- Shorten your development cycle and reduce your testing effort. AST II’s repeatable tests and short test times reduce the overall development cycle.

AST II Answers Key Performance Questions

AST II can provide answers to the following questions:

- What is the throughput of the DUT/SUT, and how do increases in the load, frame size and burst size affect throughput?
- What is the frame loss at a certain load, and how do increases in the load affect frame loss?
- How well does the DUT/SUT forward broadcast traffic, and what is the latency?
• How does a DUT/SUT handle congestion, and does head of line blocking or forward pressure exist?
• What is the maximum rate at which the DUT/SUT can learn addresses?
• What is the maximum number of addresses the DUT/SUT can handle?
• Is the DUT/SUT able to filter errored frames (such as undersized or oversized frames), and what types of errors does it have trouble filtering?
• How do increases in the load, frame size, and burst size affect error filtering performance?

Summary of AST II Tests

Table 1-1 lists and describes each AST II test. For detailed information about a particular test, see the test’s specific chapter in this manual.

Table 1-1. Summary of AST II Tests

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forwarding Test</td>
<td>Allows you to determine the overall forwarding performance of the DUT/SUT including frame loss rate and throughput using fully-meshed, partially-meshed, or non-meshed traffic distributions. See Chapter 6, “Forwarding Test.”</td>
</tr>
<tr>
<td>Congestion Control Test</td>
<td>Allows you to determine how the DUT/SUT handles congestion and if head of line blocking exists. See Chapter 7, “Congestion Control Test.”</td>
</tr>
<tr>
<td>Address Learning Test</td>
<td>Allows you to determine the address learning rate of the DUT/SUT (the maximum rate at which the DUT/SUT can learn addresses). See Chapter 8, “Address Learning Test.”</td>
</tr>
<tr>
<td>Address Caching Test</td>
<td>Allows you to determine the address caching capacity (the maximum number of addresses) the DUT/SUT can handle. See Chapter 9, “Address Caching Test.”</td>
</tr>
<tr>
<td>Error Filtering Test</td>
<td>Allows you to determine the error filtering performance of the DUT/SUT. You can specify various error types for the test. See Chapter 10, “Error Filtering Test.”</td>
</tr>
<tr>
<td>Broadcast Forwarding Test</td>
<td>Allows you to determine the forwarding performance of the DUT/SUT when forwarding broadcast traffic using one-to-many or many-to-many traffic distributions. See Chapter 11, “Broadcast Forwarding Test.”</td>
</tr>
</tbody>
</table>
### Table 1-1. Summary of AST II Tests (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Broadcast Latency Test</td>
<td>Allows you to determine the latency of the DUT/SUT when forwarding broadcast traffic. This test utilizes a one-to-many traffic distribution. See Chapter 12, “Broadcast Latency Test.”</td>
</tr>
<tr>
<td>Forward Pressure Test</td>
<td>Allows you to determine how the DUT/SUT handles congestion and to determine if forward pressure exists. See Chapter 13, “Forward Pressure Test.”</td>
</tr>
</tbody>
</table>
Chapter 2
Basic AST II Theory

In this chapter...
This chapter covers the following topics:

- General Test Terminology . . . . 14
- General Test Methodology . . . . 20
- General Steps to Set Up and Run Tests . . . . 39
General Test Terminology

Table 2-1 lists and defines terms that are used in this guide to describe the various AST II tests and parameters you will encounter when setting up tests. Be sure to review these terms before you begin reading the chapters on the individual tests. For definitions of more common terms and concepts, see the Glossary.

Table 2-1. General Test Terminology

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acceptable Frame Loss</td>
<td>The number of frames that can be lost without frame loss being declared during a test. This parameter is used for the tests that support Search test mode. Frame loss is declared when the amount of frame loss is greater than your specified Acceptable Frame Loss value. This parameter applies only to the Forwarding and Broadcast Forwarding tests when using Search mode to measure throughput. See “Search” on page 18 for details on Search mode.</td>
</tr>
<tr>
<td>Backoff Rate</td>
<td>The rate in percent that the Load is decreased for the next iteration of the test after the DUT/SUT fails (frame loss occurs) at the current Load. This parameter applies only to the Forwarding and Broadcast Forwarding tests when using Search mode. See “Search” on page 18 for details on Search mode. For information on the algorithms used in Search mode, see Appendix A, “Search Algorithms.”</td>
</tr>
</tbody>
</table>
| Duration          | This parameter allows you to specify whether you want to the iterations of the test to run for a specified amount of time, or if you want the test to run continuously until you manually stop it (this option is not available for all tests). See “Iteration” on page 15 for a description of iteration. There are two options for Duration:  
  * **Seconds**: The iterations of the test run for the amount of time (in seconds) you specify. This option is available in both Profile and Search mode.  
  * **Continuous**: The test runs continuously until you manually stop it. This option is not available when the test mode is set to Search. Unlike the Seconds option, the parameter values (such as Frame Size, Burst Size, and Load), do not vary during the test. The values used for Frame Size, Burst Size, and Load for the test are the specified Start values which remain constant throughout the test. This option is useful if you want to test how the DUT/SUT handles traffic when the Frame Size, Burst Size, and Load are constant. Note: When you select Continuous, you can not specify the number of trials (the Number of Trials parameter is disabled). In addition, all of the test parameters that are required to define the test when in Search or Profile mode (for example, the Step, Stop, Min, and Max values for Frame Size, Burst Size, and Load) are disabled. |
Table 2-1. General Test Terminology (continued)

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fully-Meshed</strong></td>
<td>One of the traffic distribution patterns. All ports in the test transmit to every other port in the test and receive traffic from all other ports in the test simultaneously.</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td></td>
</tr>
<tr>
<td><strong>General Test Setup</strong></td>
<td>Refers to setup required before you can run any AST II tests. This involves connecting your PC, SmartBits chassis, and the DUT/SUT, reserving SmartCards/module ports, configuring ports, setting test options and frame setup options. See “General Steps to Set Up and Run Tests” on page 39 for more information.</td>
</tr>
<tr>
<td><strong>Iteration</strong></td>
<td>An iteration is the smallest phase of a test, and occurs within a trial. Different iterations within the same trial are distinguished by different test parameter value(s). See “Trial” on page 19 for the definition of a trial.</td>
</tr>
<tr>
<td></td>
<td>Unlike trials, you do not specify the number of iterations for a test. AST II will run all the iterations necessary based on your test setup. Anytime there is a change in a test parameter (for example, Frame Size or Burst Size), a new iteration is started automatically.</td>
</tr>
<tr>
<td></td>
<td>Iterations allow you to see exactly how the DUT/SUT performed during the test for a particular parameter value (for tests with a single parameter), or parameter values (for tests with more than one variable parameter). The number of the iteration is displayed in the test results. See Figure 2-2 on page 26 for a diagram showing iterations in a sample test.</td>
</tr>
<tr>
<td><strong>Monitor Port</strong></td>
<td>A SmartCard/module port that is part of the test but functions differently that the other enabled ports in the test. The following tests support the use of a monitor port:</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="List" /></td>
</tr>
<tr>
<td></td>
<td>Setting a port as a monitor port allows you to use that port to listen passively and record the traffic transmitted by specific ports on the DUT/SUT during the test (including test frames and non-test frames). The frames that the monitor port receives are recorded in the test results. You select the port you want to use as a monitor port in the main window when you select the ports for the test.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>In order to use this feature, you must make sure that you:</td>
</tr>
<tr>
<td></td>
<td>1. Select the ports on the DUT/SUT that you want to send traffic to the monitor port.</td>
</tr>
<tr>
<td></td>
<td>2. Configure the DUT/SUT so that all traffic (including test frames and non-test frames) from the selected ports are copied to the SmartCard/module monitor port.</td>
</tr>
</tbody>
</table>
### Table 2-1. General Test Terminology (continued)

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Non-Meshed</strong></td>
<td>One of the traffic distribution patterns. All of the non-meshed traffic distribution pattern options are port pairs. You can set up the test to have a single port-pair, or multiple port-pairs. There are three options for this traffic distribution pattern.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Option 1: Bidirectional A to B and B to A.</strong></td>
</tr>
<tr>
<td>Single port-pair</td>
<td><img src="image" alt="Single port-pair Diagram" /></td>
</tr>
<tr>
<td>Multiple port-pairs</td>
<td><img src="image" alt="Multiple port-pairs Diagram" /></td>
</tr>
<tr>
<td>Port 1 A B Port 2</td>
<td>Port 1 A B Port 2</td>
</tr>
<tr>
<td>Port 3 A B Port 4</td>
<td></td>
</tr>
<tr>
<td><strong>Option 2: Unidirectional A to B.</strong></td>
<td></td>
</tr>
<tr>
<td>Single port-pair</td>
<td><img src="image" alt="Single port-pair Diagram" /></td>
</tr>
<tr>
<td>Multiple port-pairs</td>
<td><img src="image" alt="Multiple port-pairs Diagram" /></td>
</tr>
<tr>
<td>Port 1 A B Port 2</td>
<td>Port 1 A B Port 2</td>
</tr>
<tr>
<td>Port 3 A B Port 4</td>
<td></td>
</tr>
<tr>
<td><strong>Option 3: Unidirectional B to A.</strong></td>
<td></td>
</tr>
<tr>
<td>Single port-pair</td>
<td><img src="image" alt="Single port-pair Diagram" /></td>
</tr>
<tr>
<td>Multiple port-pairs</td>
<td><img src="image" alt="Multiple port-pairs Diagram" /></td>
</tr>
<tr>
<td>Port 1 A B Port 2</td>
<td>Port 1 A B Port 2</td>
</tr>
<tr>
<td>Port 3 A B Port 4</td>
<td></td>
</tr>
</tbody>
</table>
### Table 2-1. General Test Terminology (continued)

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partially-Meshed</td>
<td>One of the traffic distribution patterns. There are three basic options: one-to-many, many-to-one, and many-to-many. Since you must also specify the traffic direction (bidirectional or unidirectional) there are a total of six possible partially meshed traffic pattern options. These options are:</td>
</tr>
<tr>
<td></td>
<td><strong>Option 1</strong>: Many-to-one, bidirectional.</td>
</tr>
<tr>
<td></td>
<td>![Diagram of Option 1]</td>
</tr>
<tr>
<td></td>
<td><strong>Option 2</strong>: Many-to-one, unidirectional.</td>
</tr>
<tr>
<td></td>
<td>![Diagram of Option 2]</td>
</tr>
<tr>
<td></td>
<td><strong>Option 3</strong>: One-to-many, bidirectional.</td>
</tr>
<tr>
<td></td>
<td>![Diagram of Option 3]</td>
</tr>
<tr>
<td></td>
<td><strong>Option 4</strong>: One-to-many, unidirectional.</td>
</tr>
<tr>
<td></td>
<td>![Diagram of Option 4]</td>
</tr>
</tbody>
</table>
### Table 2-1. General Test Terminology (continued)

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
</table>
| **Partially-Meshed** (continued)   | - *Option 5: Many-to-many, bidirectional (m-to-n).*  

```
M  N
<table>
<thead>
<tr>
<th>Port 1</th>
<th>Port 2</th>
<th>Port 3</th>
<th>Port 4</th>
</tr>
</thead>
</table>
| ![Diagram](attachment:diagram.png)  
```

For this option, the number of (m) ports and (n) ports does not have to be equal.

- *Option 6: Many-to-many, unidirectional (m-to-n).*  

```
M  N
<table>
<thead>
<tr>
<th>Port 1</th>
<th>Port 2</th>
<th>Port 3</th>
<th>Port 4</th>
</tr>
</thead>
</table>
| ![Diagram](attachment:diagram.png)  
```

For this option, the number of (m) ports and (n) ports does not have to be equal.

<table>
<thead>
<tr>
<th><strong>Profile</strong></th>
<th>One of the test available test modes. This mode provides an overall view of the DUT/SUT’s performance as the test parameter(s) vary (increase). In this mode, you have the option of specifying the length of the test iterations, or you can choose to run the test continuously. See “Profile Mode (Duration set to Seconds)” on page 25 and “Profile Mode (Duration set to Continuous)” on page 27 for details.</th>
</tr>
</thead>
</table>
| **Resolution**                     | The finest adjustment in percent possible for the Load during the test. This parameter applies only to the Forwarding and Broadcast Forwarding tests when using Search mode to measure throughput.  

The smaller the Resolution value, the more accurate the test results. Smaller Resolution values also increase test time. If the required adjustment to the current Load is less than the Resolution, the trial stops.  

For example, if your Resolution setting is 5.0%, and the required adjustment to the current Load is less than 5.0%, the trial stops.  

See “Search” on page 18 for details on Search mode. |
| **Search**                         | One of the available test modes. This mode allows you to use a binary search algorithm to measure the throughput. See “Search” on page 18 for details. See Appendix A, “Search Algorithms” for information on the search algorithms used to determine the test measurements. |
Test Parameters  
Refers to parameters that are specific to a particular AST II test. Once you have completed the steps for your general test setup (see “General Test Setup” on page 15), you must set the parameters for the test you want to run. The procedures for setting test parameters are given in the chapters for each particular test.

Trial  
AST II enables you to repeat a test a number of times without having to reconfigure and restart the test by allowing you to specify the number of trials for the test. You can choose to run one trial or multiple trials. AST II repeats the test based on the number of trials you specify. Running multiple trials also allows you to test the consistency of the performance of the DUT/SUT over a number of trials.

If you specify more than one trial, AST II reruns the test with the same exact parameter settings for each trial. Within a trial, test parameters can vary depending on the test and your test setup. The phase of the test that distinguishes different values for the test parameter(s) is called an iteration (see “Iteration” on page 15).
General Test Methodology

This section provides information on the general test methodology of AST II, including the basic phases of the AST II tests (see “Basic Phases of an AST II Test” below), and the basic structure of the tests during the testing phase (see “Basic AST II Test Structure” on page 23).

Basic Phases of an AST II Test

AST II test phases include how the application processes input, performs the test, and returns status information and test results. Each of the phases is described in Table 2-2 below. See Figure 2-1 on page 22 for a diagram of the AST II test phases.

Table 2-2. Phases of an AST II Test

<table>
<thead>
<tr>
<th>Phase</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Validation</td>
<td>All the user-specified arguments are checked for proper (valid) ranges and values. If invalid values are detected, an error message appears.</td>
</tr>
<tr>
<td>Test Reset</td>
<td>• All previous port groups are cleared.</td>
</tr>
<tr>
<td></td>
<td>• All participating ports are added to test groups.</td>
</tr>
<tr>
<td></td>
<td>• All VFDs are cleared.</td>
</tr>
<tr>
<td></td>
<td>• All triggers are cleared.</td>
</tr>
<tr>
<td></td>
<td>• All alignment and CRC error generation is cleared.</td>
</tr>
<tr>
<td></td>
<td>• Transmit mode is set.</td>
</tr>
<tr>
<td></td>
<td>• All port counters are cleared.</td>
</tr>
<tr>
<td>Port Validation</td>
<td>In the port validation phase, Speed, Duplex, Autonegotiation, Flow Control, and Interface parameters are set and verified for each port in the test.</td>
</tr>
<tr>
<td>Link Check</td>
<td>Each port in the test is checked for a valid link before the start of each iteration of the test. If no link has been established, an error is returned.</td>
</tr>
<tr>
<td>Address Learning</td>
<td>Address learning is performed. See “Setting the Test Options” on page 94 for details.</td>
</tr>
<tr>
<td>Test Setup</td>
<td>Frame transmission parameters are calculated and set for each port. The frame transmission parameter values can vary based on the Frame Size, Load, Burst Size, Duration, Speed, Duplex, and Interface settings.</td>
</tr>
</tbody>
</table>
Test Iteration

The test ports transmit and receive frames for the specified duration (duration may not apply depending on the test type). If a port fails to transmit the required number of frames, an error message appears. If the test phase is long, periodic status reports are performed to update you with intermediate results.

For details on what takes place during this phase of the test, see the “Test Methodology” section of the chapters that cover the tests.

Results

All port counters are read and results are calculated and recorded for the current iteration, and AST II prepares for the next iteration by returning to the Link Check phase. If this is the last iteration, final (summary) results for the entire test are calculated and recorded.
Figure 2-1. Basic Phases of an AST II Test
Basic AST II Test Structure

This section briefly describes the basic structure of the AST II tests. The chapters that cover the individual tests contain more detailed information on the tests. See “General Test Terminology” on page 14 for definitions of terms that are used in this section.

For topics covered in this section on the basic AST II test structure are:

- Number of trials for the tests, see “Number of Trials” below.
- Test parameters, see “Test Parameters” below.
- Test modes, see “Test Modes” on page 24.

Number of Trials

For all of the AST II test types, you can specify more than one trial for each test. When you specify more than one trial, the test repeats using the same parameter values based on the number of trials you specify (for example, if you specify 4 trials, the test repeats 4 times). Using more than one trial per test allows you to determine how consistently the DUT/SUT performs under the same conditions. See “Trial” on page 19 for a definition of trial.

Test Parameters

Depending on the test, from one or three parameters can vary. Since only one parameter can vary from iteration to iteration, tests with multiple variables may contain many more iterations than tests with a single parameter. Table 2-3 below lists the parameters for each test and the order in which the parameters vary.

Table 2-3. Test Parameters

<table>
<thead>
<tr>
<th>Test</th>
<th>Parameter(s) / Sequence of Variation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Caching</td>
<td>Number of Addresses</td>
</tr>
<tr>
<td>Address Learning</td>
<td>Address Learning Rate</td>
</tr>
<tr>
<td>Broadcast Forwarding</td>
<td>1 Load</td>
</tr>
<tr>
<td></td>
<td>2 Burst Size</td>
</tr>
<tr>
<td></td>
<td>3 Frame Size</td>
</tr>
<tr>
<td>Broadcast Latency</td>
<td>Frame Size</td>
</tr>
<tr>
<td>Congestion Control</td>
<td>1 Load</td>
</tr>
<tr>
<td></td>
<td>2 Burst Size</td>
</tr>
<tr>
<td></td>
<td>3 Frame Size</td>
</tr>
<tr>
<td>Error Filtering</td>
<td>Load</td>
</tr>
</tbody>
</table>
Chapter 2: Basic AST II Theory

General Test Methodology

Table 2-3. Test Parameters (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Parameter(s) / Sequence of Variation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forward Pressure</td>
<td>Frame Size</td>
</tr>
<tr>
<td>Forwarding</td>
<td>1 Load</td>
</tr>
<tr>
<td></td>
<td>2 Burst Size</td>
</tr>
<tr>
<td></td>
<td>3 Frame Size</td>
</tr>
</tbody>
</table>

Test Modes

The various AST II tests use different test modes to test the DUT/SUT. Some of the tests support more than one test mode and allow you to choose the mode (for these tests, you select the mode when you configure the test parameters using the Test Setup tab). Some of the AST II tests are set to run automatically in a particular mode. Table 2-4 below lists the test modes for each AST II test and whether or not you need to specify the test mode.

The different test modes are:

- **Profile**: Provides an overall view of the DUT/SUT’s performance as the test parameter(s) vary (see Table 2-3 on page 23 for a list of the parameters for each test). In this mode, you can specify the length of the test iterations in seconds, or run the test continuously until you stop it. See “Profile Mode (Duration set to Seconds)” on page 25 and “Profile Mode (Duration set to Continuous)” on page 27.

- **Search**: Measures throughput using a binary search. The test measurements available in this mode vary from test to test. Since Search mode is implemented slightly differently for some of the tests, there are two sections that discuss Search mode based on the test type. See “Search Mode (Forwarding and Broadcast Forwarding tests)” on page 28 and “Search Mode (Address Learning and Address Caching tests)” on page 34.

Table 2-4. Test Modes

<table>
<thead>
<tr>
<th>Test</th>
<th>Available Test Mode(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Caching</td>
<td>Search only. You do not need to specify the mode.</td>
</tr>
<tr>
<td>Address Learning</td>
<td>Search only. You do not need to specify the mode.</td>
</tr>
<tr>
<td>Broadcast Forwarding</td>
<td>Profile and Search. You must specify the mode you want.</td>
</tr>
<tr>
<td>Broadcast Latency</td>
<td>Profile only. You do not need to specify the mode.</td>
</tr>
</tbody>
</table>
Table 2-4. Test Modes (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Available Test Mode(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Congestion Control</td>
<td><em>Profile only.</em>&lt;br&gt;You <strong>do not</strong> need to specify the mode.</td>
</tr>
<tr>
<td>Error Filtering</td>
<td><em>Profile only.</em>&lt;br&gt;You <strong>do not</strong> need to specify the mode.</td>
</tr>
<tr>
<td>Forward Pressure</td>
<td><em>Profile only.</em>&lt;br&gt;You <strong>do not</strong> need to specify the mode.</td>
</tr>
<tr>
<td>Forwarding</td>
<td><em>Profile and Search.</em>&lt;br&gt;You <strong>must</strong> specify the mode you want.</td>
</tr>
</tbody>
</table>

**Profile Mode (Duration set to Seconds)**

*Figure 2-2 on page 26* shows an example (partial, not all iterations are shown) of the basic test structure of the tests that use *Profile* test mode when *Duration* is set to *Seconds*. Using these settings, the test parameters vary according to your *Start* rate, *Step* rate, and *Stop* rate settings. The length of each iteration is defined by your *Duration* setting. In this example:

- The number of trials specified is one. If two or more trials were specified, the test would repeat using the same exact parameter values and number of iterations.
- The test parameters are *Load*, *Burst Size*, and *Frame Size*. The values are as follows:

As shown in *Figure 2-2 on page 26*, only one parameter varies at once, and each time a parameter varies, the test generates a new iteration. See *Table 2-5 on page 29* a list all of the iterations of a test in which these *Load*, *Burst Size*, and *Frame Size* values are used. See “*When is the test complete?*” on page 26 for information on when the test stops.
When is the test complete?

In Profile mode when the Duration option is set to Seconds, the test stops when all the trials you specified in your test setup have been completed. If you specified more than one trial, the test repeats using the same parameter values for each iteration based on the number of trials you specify.

For example, if you specify 4 trials, the test repeats a total of 4 times. The number of iterations per trial and the values of the specific parameters does not change from trial to trial.
Profile Mode (Duration set to Continuous)

Figure 2-3 shows the basic test structure for the tests that use Profile mode when Duration is set to Continuous. Using these settings, the test parameters remain constant throughout the test and you do not specify the length of the test. The test runs continuously until you manually stop it.

Note: Since the length of the test is controlled manually and the parameters do not vary, the concept of trials and iterations do not apply to when the Duration option is set to Continuous in Profile mode.

In this example, the test parameters are *Load*, *Burst Size*, and *Frame Size*. The values are as follows:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Parameter</th>
<th>Values</th>
<th>Parameter</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load</td>
<td>Start = 10%</td>
<td>Burst Size</td>
<td>Start = 1</td>
<td>Frame Size</td>
<td>Start = 64</td>
</tr>
</tbody>
</table>

As shown in *Figure 2-3*, the parameters remain constant during the test.
Search Mode (Forwarding and Broadcast Forwarding tests)

Unlike Profile mode, only the Burst Size and Frame Size vary according to your Start, Step, and Stop settings when running the Forwarding and Broadcast Forwarding tests in Search mode (these tests can be run in either mode).

The Load is automatically adjusted up or down from iteration to iteration based on whether the DUT/SUT passes or fails at the current Load. The amount of adjustment up or down is determined by the search algorithm the test uses to calculate the Load for the next iteration.

Since the Load does not increment stepwise as it does in Profile mode, the Load parameter options in Search mode are different than the options provided in Profile mode. The Load parameter options in Search mode allow you to specify an initial, minimum, and maximum Load rate, not a Step rate. This allows you to define minimum and maximum threshold Load for the test. During the test, the Load is adjusted up or down within the range defined by the minimum and maximum values. If either the specified minimum (Min) or maximum (Max) Load threshold is reached, the current trial stops. For details on when the test is complete, see “When is the test complete?” on page 33.

In addition to the differences in the way the Load varies during the test, there are aspects to Search mode not found in Profile mode when running the Forwarding and Broadcast Forwarding tests. These additional aspects are:

- **Search algorithms**
  These algorithms are used to calculate the Load for the next iteration based on whether the DUT/SUT passes or fails at the current Load. See Appendix A, “Search Algorithms” for information on the search algorithms.

- **Pass/fail criteria**
  The criteria used to determine if the DUT/SUT fails at the current Load. The criteria vary depending on the type of test you are running. See page 29 for more information.

- **Binary search parameters**
  These parameters allow you to specify the amount of frame loss allowable for the test, the accuracy of the test, and the rate the Load is decreased after the DUT/SUT fails at the current Load. See page 29 for more information.

**Note:** Although the Address Learning and Address Caching tests also use Search mode, the algorithms, pass/fail criteria, and binary search parameters are not the same as the Forwarding and Broadcast Forwarding tests. For a description of the Address Learning and Address Caching tests, see “Search Mode (Address Learning and Address Caching tests)” on page 34.
Pass/Fail Criteria

In *Search* mode, the *Load* increases or decreases from iteration to iteration automatically depending on whether the DUT/SUT passes or fails at the current *Load* when running the Forwarding and Broadcast Forwarding tests. Table 2-5 lists the criteria used to determine whether or not the DUT/SUT passes or fails.

For information on the algorithms used to calculate the *Load* for the next iteration after the DUT passes or fails, see Appendix A, “Search Algorithms.”

Table 2-5. Pass/Fail Criteria

<table>
<thead>
<tr>
<th>Test Measurement</th>
<th>Test</th>
<th>Pass/Fail Criteria</th>
</tr>
</thead>
</table>
| Throughput       | Broadcast Forwarding and Forwarding | Based on frame loss.  
|                  |      | **Pass**: Frame loss is less than your Acceptable Frame Loss setting.  
|                  |      | **Fail**: Frame loss is greater than your Acceptable Frame Loss setting. |

Binary Search Parameters

Three parameters are required in *Search* mode that are not required in *Profile* mode for the Forwarding and Broadcast Forwarding tests. These parameters allow you to define various aspects of the binary search. You specify these parameters using the *Test Setup* tab when you configure the test parameters.

Table 2-6 lists the additional parameters. As shown in Figure 2-3, the parameters remain constant during the test.

Table 2-6. Binary Search Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>Allows you to specify the accuracy of the search. The <em>Resolution</em> defines the finest adjustment possible in the <em>Load</em> from iteration to iteration. The smaller the <em>Resolution</em> value, the more accurate the test results. See “<em>Resolution</em> on page 18 for more information.</td>
</tr>
<tr>
<td>Backoff Rate</td>
<td>Allows you to specify the rate that the <em>Load</em> decreases after the DUT/SUT fails at the current <em>Load</em>. This parameter is one of the variables used in the algorithms used to calculate the <em>Load</em> for the next iteration of the test after the DUT/SUT fails. See Appendix A, “Search Algorithms” for more information on the algorithms.</td>
</tr>
</tbody>
</table>
Figure 2-4 on page 31 below shows the basic test structure for the Forwarding and Broadcast Forwarding tests when using *Search* mode. In this example:

- The number of trials specified is one. If two or more trials were specified, the test would repeat using the same initial, minimum, and maximum *Load* values, and the same *Start*, *Step*, and *Stop* *Burst Size* and *Frame Size* values.

- The *Load*, *Burst Size*, and *Frame Size* values are as follows:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Load</em></td>
<td>Initial = 10%, Min = 10%, Max = 30%</td>
</tr>
<tr>
<td><em>Burst Size</em></td>
<td>Start = 1</td>
</tr>
<tr>
<td><em>Frame Size</em></td>
<td>Start = 64</td>
</tr>
</tbody>
</table>

- As shown in *Figure 2-4 on page 31*, only one parameter varies at once, and each time this occurs, the test generates a new iteration. See page 26 for information on when the test stops.
**Figure 2-4.** Test Structure (Search Mode, Forwarding, and Broadcast Forwarding Tests)

**Note:** For a detailed description of each iteration of this example test, see page 32.
Chapter 2: Basic AST II Theory

General Test Methodology

Iterations 1 through 6

The first iteration begins with the Load at the specified Initial value, and the Burst Size and Frame Size begin at their respective specified Start values. The Load increases from its Initial value to its Max value in iterations 1 through 6 (this means that the DUT/SUT passed at each Load level for iterations 1 through 6). With each increase, the Load value for the next iteration is calculated using the appropriate algorithm.

Note: Each time the Load reaches its Max value during the test in Search mode, results are recorded. This allows you to review the DUT/SUT’s performance for that particular Burst Size and Frame Size combination.

Iterations 7 through 12

Beginning in iteration 7, the Burst Size increments based on its Step value, and the Load returns to its Initial value. The Load increases as it did in iterations 1 through 6 since the DUT/SUT passes at each of the Load level for these iterations.

Iterations 13 through 15

Beginning in iteration 13, the Burst Size increments again based on its Step value, and the Load returns to its Initial value. In iterations 13 to 15 the Load increases since the DUT/SUT passes at the Load levels for these iterations.

In iteration 15, the DUT/SUT fails. This means frame loss is declared (frame loss occurred or it was greater than the specified Acceptable Frame Loss).

Iterations 16

The Load decreases from the level in iteration 15. The new Load value for iteration 16 is calculated using the appropriate algorithm. The algorithm used depends on whether the DUT/SUT passes or fails.

The DUT/SUT fails again in iteration 16. Since the required change in the Load for iteration 17 is less than the Resolution setting, the throughput measurement is reached.
When is the test complete?

In Search mode, each trial stops when one of the following conditions have been satisfied:

- The specified minimum Load threshold is reached (Min).
- The specified maximum Load threshold is reached (Max).
- The required change in the Load for the next iteration (as calculated using the formulas above), is less than the specified Resolution. For example, if the specified Resolution is 5, and the required change in Load for the next iteration is 2, the test is complete.

If you specified more than one trial, the next trial begins. Once all of the specified trials have been run, the test is complete.

Note:  Unlike Profile mode, the number of iterations per trial can vary depending on the DUT/SUT’s performance. For example, if the DUT/SUT passes at levels where it failed during other trials, the number of iterations may increase. If the DUT/SUT fails at levels where it passed in other trials, the number of iterations may decrease.
Search Mode (Address Learning and Address Caching tests)

The basic test structure for the Address Learning and Address Caching tests in Search mode is different from the Forwarding and Broadcast Forwarding tests in Search mode. Unlike the Forwarding and Broadcast Forwarding tests, the Address Learning and Address Caching tests are run only in Search mode (you do not need to select the mode).

**Note:** In this section, address tests refers to both the Addresses Learning and Address Caching test.

For the address tests, the Learning Rate (Address Learning test), or Number of Addresses (Address Caching test) are automatically adjusted up or down from iteration to iteration based on whether the DUT/SUT passes or fails at the current Learning Rate/Number of Addresses. The amount of adjustment is determined by the search algorithm the test uses to calculate the Learning Rate/Number of Addresses for the next iteration.

The Learning Rate/Number of Addresses parameter options allow you to specify initial, minimum, and maximum rates for each parameter. This allows you to define the starting rate, as well as the minimum and maximum threshold Learning Rate/Number of Addresses rates for the test. During the test, the Learning Rate/Number of Addresses are adjusted up or down within the range defined by the minimum and maximum values. If either the specified minimum (Minimum) or maximum (Maximum) threshold is reached, the current trial stops. For details on when the test is complete, see “When is the test complete?” on page 38.

The main differences between the Forwarding and Broadcast Forwarding tests and the Address Learning and Address Caching tests in Search mode are:

- In the address tests, the Burst Size and Frame Size do not vary, they remain constant throughout the test.
- In the address tests, you do not select the test mode.
- The search algorithms used in the address tests are different.
- The address tests do not require the additional binary search parameters used by the Forwarding and Broadcast Forwarding tests in Search mode.
- The address tests require that you set up a monitor port to detect flooding.

For more information on the search algorithms, and the pass / fail criteria for the address tests, see the following sections.

- Search algorithms, see Appendix A, “Search Algorithms.”
- Pass / fail criteria, see “Pass/Fail Criteria” on page 35.

**Note:** Although the address tests are run in Search mode and utilize a binary search, you do not to specify any binary search parameters.
Pass/Fail Criteria

In Search mode, the Learning Rate/Number of Addresses increases or decreases from iteration to iteration automatically depending on whether the DUT/SUT passes or fails at the current Learning Rate/Number of Addresses. The criteria used to determine whether or not the DUT/SUT passes or fails is the same for both tests (see Table 2-7).

For information on the algorithms used to calculate the Learning Rate/Number of Addresses for the next iteration after the DUT/SUT passes or fails, see Appendix A, “Search Algorithms.”

### Table 2-7. Pass/Fail Criteria

<table>
<thead>
<tr>
<th>Test</th>
<th>Pass/Fail Criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Learning and Address Caching</td>
<td>Based on whether or not flooding occurred on the monitor port.</td>
</tr>
<tr>
<td></td>
<td>Pass: Flooding did not occur.</td>
</tr>
<tr>
<td></td>
<td>Fail: Flooding did occur.</td>
</tr>
</tbody>
</table>

Figure 2-5 on page 36 below shows the basic test structure for Address Learning and Address Caching tests. In this example:

- The number of trials specified is one. If two or more trials were specified, the test would repeat using the same initial, minimum, and maximum Learning Rate/Number of Addresses values, and the same Burst Size and Frame Size values.
- The Learning Rate/Number of Addresses, Burst Size, and Frame Size values are as follows:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learning Rate/Number of Addresses</td>
<td>Initial =10%</td>
</tr>
<tr>
<td>Burst Size</td>
<td>1</td>
</tr>
<tr>
<td>Frame Size</td>
<td>64</td>
</tr>
</tbody>
</table>

As shown in Figure 2-5 on page 36, only one parameter varies at once, and each time this occurs, the test generates a new iteration. See page 26 for information on when the test stops.
Chapter 2: Basic AST II Theory

General Test Methodology

Figure 2-5. Test Structure (Search Mode, Address Learning and Address Caching Tests)

Final measurement is reached (the required change in the Learning Rate/Number of Addresses for the next iteration is less than the Resolution setting.)
Note: For a detailed description of each iteration of this example test, see page 37.

**Iterations 1 through 4**

The first iteration begins with the Learning Rate/Number of Addresses at the specified Initial value, and the Burst Size and Frame Size at their respective specified values. The Learning Rate/Number of Addresses increases from its Initial value in iterations 1 to 4 (this means that the DUT/SUT passed at each Learning Rate/Number of Addresses level for iterations 1 through 4). With each increase, the Learning Rate/Number of Addresses value for the next iteration is calculated using the appropriate algorithm.

**Iterations 5 through 6**

In iteration 5, the DUT/SUT fails. This means flooding occurred at the current Learning Rate/Number of Addresses. The Learning Rate/Number of Addresses is reduced for iteration 6 using the appropriate algorithm. In iteration 6, the DUT/SUT fails again, and the Learning Rate/Number of Addresses is reduced again for the next iteration.

**Iterations 7 through 8**

In both iteration 7 and 8, the DUT/SUT passes. The Learning Rate/Number of Addresses is increased from iteration 7 to 8 and 8 to 9 using the appropriate algorithm.

**Iterations 9 and 10**

In iteration 9, the DUT/SUT fails and the Learning Rate/Number of Addresses is decreased for iteration 10.

The new Learning Rate/Number of Addresses value for iteration 10 is calculated using the appropriate algorithm. The algorithm used depends on whether the DUT/SUT passes or fails.

Since the required change in the Learning Rate/Number of Addresses for iteration 10 is less than 2, the final test measurement is reached (both of the address tests use a resolution of 2).
When is the test complete?

In **Search** mode, each trial stops when **one** of the following conditions has been satisfied:

- The specified minimum *Learning Rate/Number of Addresses* threshold is reached (**Minimum**).
- The specified maximum *Learning Rate/Number of Addresses* threshold is reached (**Maximum**).
- The required change in the *Load* for the next iteration is **2**.

If you specified more than one trial, the next trial begins. Once all of the specified trials have been run, the test is complete.

**Note:** Unlike **Profile** mode, the number of iterations per trial can vary depending on the DUT/SUT's performance. For example, if the DUT/SUT passes at levels where it failed during other trials, the number of iterations may increase. If the DUT/SUT fails at levels where it passed in other trials, the number of iterations may decrease.
General Steps to Set Up and Run Tests

The general steps involved in setting up and running tests include: connecting your PC, SmartBits chassis, and the DUT/SUT, reserving SmartCards/module ports, configuring ports, setting test options and frame setup options.

Table 2-8 lists the general steps required to set up and run an AST II test. Refer to the appropriate section for more information on each step.

Table 2-8. General Steps to Set Up and Run Tests

<table>
<thead>
<tr>
<th>Step</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Setting up a SmartBits connection between your PC and your SmartBits chassis.</td>
<td>“Setting up SmartBits Connections” on page 47.</td>
</tr>
<tr>
<td>2 Connecting AST II to your SmartBits chassis.</td>
<td>“Establishing a SmartBits-AST II Connection” on page 50.</td>
</tr>
<tr>
<td>3 Prepare the DUT/SUT.</td>
<td>“Preparing the DUT/SUT” on page 53.</td>
</tr>
<tr>
<td>4 Connecting your SmartBits chassis to the DUT/SUT.</td>
<td>“Connecting SmartBits to the DUT/SUT” on page 54.</td>
</tr>
<tr>
<td>5 Reserve SmartCards/modules for the test.</td>
<td>“Reserving SmartCards/Modules for the Test” on page 85.</td>
</tr>
<tr>
<td>6 Configuring port parameters.</td>
<td>“Configuring the SmartCard/Module Ports” on page 88.</td>
</tr>
<tr>
<td>7 Setting the “Options” and “Frame Setup” parameters.</td>
<td>“Setting the Test Options” on page 94 and “Setting the Frame Setup Parameters” on page 98.</td>
</tr>
<tr>
<td>8 Selecting the type of test you want to run.</td>
<td>For steps 8 through 11, refer to the chapter that covers the test you want to run.</td>
</tr>
<tr>
<td>9 Setting test parameters specific to the test.</td>
<td></td>
</tr>
<tr>
<td>10 Starting the test.</td>
<td></td>
</tr>
<tr>
<td>11 Viewing test results.</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 3
Install and Connect

This chapter provides information on the AST II installation requirements, the AST II installation procedure, and procedures for connecting your PC, chassis, and DUT/SUT.

In this chapter...
This chapter covers the following topics:

- SmartBits Hardware Requirements . . . . 42
- PC Requirements . . . . 44
- Installing AST II . . . . 45
- Connection Procedures . . . . 46
SmartBits Hardware Requirements

AST II supports the SmartBits hardware listed in Table 3-1, Table 3-2, and Table 3-3. Operation of AST II, requires at least one of the supported chassis types is needed, plus two or more SmartCards/modules that are supported by the chassis.

Table 3-1.  Supported SmartBits Chassis

<table>
<thead>
<tr>
<th>Chassis</th>
</tr>
</thead>
<tbody>
<tr>
<td>SmartBits 200</td>
</tr>
<tr>
<td>SmartBits 2000</td>
</tr>
<tr>
<td>SmartBits 600</td>
</tr>
<tr>
<td>SmartBits 6000B</td>
</tr>
<tr>
<td>SmartBits 6000C</td>
</tr>
</tbody>
</table>

Table 3-2.  Supported SmartBits 200/2000 SmartCards

<table>
<thead>
<tr>
<th>SmartCard</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GX-1405B</td>
<td>1000Base-LX Ethernet, 1-port, multi-mode, 850nm</td>
</tr>
<tr>
<td>GX-1405Bs</td>
<td>1000Base-LX Ethernet, 1-port, single mode, 1310nm</td>
</tr>
<tr>
<td>GX-1420B</td>
<td>10/100Base Ethernet, Copper, 1-port</td>
</tr>
<tr>
<td>ML-5710A</td>
<td>10Base-T Ethernet/USB, 2-port, SmartMetrics</td>
</tr>
<tr>
<td>ML-7710</td>
<td>10/100Base-TX Ethernet, 1-port, SmartMetrics</td>
</tr>
<tr>
<td>ML-7711</td>
<td>100Base-FX Ethernet, 1-port, multi-mode, 1300nm, SmartMetrics</td>
</tr>
<tr>
<td>ML-7711s</td>
<td>100Base-FX Ethernet, 1-port, single mode, 1310nm, SmartMetrics</td>
</tr>
<tr>
<td>SX-7210</td>
<td>10/100Base-TX Ethernet, MII, 1-port</td>
</tr>
<tr>
<td>SX-7410B</td>
<td>10/100Base-TX Ethernet, 1-port</td>
</tr>
<tr>
<td>SX-7411</td>
<td>10/100Base-FX Ethernet, 1-port</td>
</tr>
</tbody>
</table>
Table 3-3. Supported SmartBits 600/6000B/6000C Modules

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAN-3100A</td>
<td>10/100Base-TX Ethernet, 8-port</td>
</tr>
<tr>
<td>LAN-3101A/B</td>
<td>10/100Base-TX Ethernet, 6-port, SmartMetrics</td>
</tr>
<tr>
<td>LAN-3102A</td>
<td>10/100Base-TX Ethernet, 2-port, SmartMetrics</td>
</tr>
<tr>
<td>LAN-3200A</td>
<td>1000Base-SX Ethernet, 2-port, multi-mode, 850nm</td>
</tr>
<tr>
<td>LAN-3200As</td>
<td>1000Base-LX Ethernet, 2-port, single mode, 1310nm</td>
</tr>
<tr>
<td>LAN-3201B/C</td>
<td>1000Base Ethernet, GBIC, 1-port, SmartMetrics</td>
</tr>
<tr>
<td>LAN-3300A</td>
<td>10/100/1000Base-T Ethernet, Copper, 2-port, SmartMetrics</td>
</tr>
<tr>
<td>LAN-3301A</td>
<td>10/100/1000Base-T Ethernet, Copper, 2-port, TeraMetrics</td>
</tr>
<tr>
<td>LAN-3302A</td>
<td>10/100Base-T Ethernet, Copper, 2-port, TeraMetrics</td>
</tr>
<tr>
<td>LAN-3306A</td>
<td>10/100Base-T Ethernet, Copper, 4-port, TeraMetrics XD</td>
</tr>
<tr>
<td>LAN-3310A</td>
<td>1000Base-X Ethernet, GBIC, 2-port, SmartMetrics</td>
</tr>
<tr>
<td>LAN-3311A</td>
<td>1000Base Ethernet, GBIC, 2-port, TeraMetrics</td>
</tr>
<tr>
<td>LAN-3320A</td>
<td>10/100/1000 Mbps and Gigabit Ethernet Fiber, 2-port, SmartMetrics XD</td>
</tr>
<tr>
<td>LAN-3321A</td>
<td>10/100/1000 Mbps and Gigabit Ethernet Fiber, 2-port, TeraMetrics XD</td>
</tr>
<tr>
<td>LAN-3324A</td>
<td>10/100/1000 Mbps and Gigabit Ethernet Fiber, 4-port, SmartMetrics XD</td>
</tr>
<tr>
<td>LAN-3325A</td>
<td>10/100/1000 Mbps and Gigabit Ethernet Fiber, 4-port, TeraMetrics XD</td>
</tr>
<tr>
<td>LAN-3327A</td>
<td>10/100/1000 Mbps and Gigabit Ethernet Fiber, 1-port, TeraMetrics XD</td>
</tr>
<tr>
<td>LAN-3710AE</td>
<td>10GBase-ER Ethernet, 1-port, 2-slot, single mode, 1550nm</td>
</tr>
<tr>
<td>LAN-3710AL</td>
<td>10GBase-LR Ethernet, 1-port, 2-slot, single mode, 1310nm</td>
</tr>
<tr>
<td>XLW-3720A</td>
<td>10Gbps Ethernet, Optical, 1-port, SmartMetrics</td>
</tr>
<tr>
<td>XLW-3721A</td>
<td>10Gbps Ethernet, Optical, 1-port, TeraMetrics</td>
</tr>
</tbody>
</table>

**Notes:**

- For information on the latest firmware levels for the supported SmartCards and modules, refer to the AST II Release Notes shipped with the software.
- To check the firmware of the SmartCards/modules installed in your chassis, select **Help > About** within the AST II application.
PC Requirements

- An IBM or compatible PC with an available COM port or an Ethernet interface card
- Pentium II processor 266 MHz or higher
- One of the following operating systems:
  - Windows 98, Second Edition
  - Windows NT 4.0, Professional Edition, Service Pack 6a
  - Windows XP, Professional Edition, Service Pack 1
- 64 MB of RAM for Windows 98
- 128 MB of RAM for Windows NT
- 15 MB free hard disk space (for installation)
- SVGA monitor with 800 x 600 or better resolution
- Optional: For chassis synchronization, either a synchronization cable or two GPS receivers and antennas, plus an additional SmartBits 200 or 2000 chassis. Refer to the Using GPS/CDMA with SmartBits document that accompanies the GPS unit for more information.
Installing AST II

AST II can be used with Windows 98/2000/NT/XP systems (see “PC Requirements” on page 44 for the specific operating systems that are supported). AST II ships on a CD-ROM and is also available from the Spirent Communications Customer Service Center website at http.support@spirentcom.com.

To install AST II, follow the steps below:

1. To install AST II from a CD, insert the CD into your PC’s CD-ROM drive. The AST II installer program will launch automatically.
2. To install AST II from the Spirent Communications Customer Service Center website:
   a. Login to the website and select Downloads > All Software from the menu bar.
   b. Under the SmartBits heading, click Applications and then click on the Advanced Switched Tests II (AST II) listing.
   c. Click the Download button on the Software Downloads AST II web page to copy the .exe file to your PC, then click on the .exe file to launch the AST II installer program.
3. Follow the instructions on the installer screens to install AST II properly.
4. After installing AST II, you need to install the key file that enables you to use AST II with your particular SmartBits chassis. This key file is contained on the 3.5-inch disk that is shipped with the AST II CD. Insert the disk into your PC and locate the key file, which appears in the format Flowkey.txt. Copy this file into the AST II program directory.

Notes:
- If you are using a purchased version of AST II: If the key file is not present in the program directory (or if the key file does not match the chassis to which you are trying to connect), the application will start up in a 15-minute demo mode. After fifteen minutes, the application will disconnect from the chassis. You can restart the application for another fifteen minutes as many times as you want.
- If you are using a demo (10- or 30-day trial) version of AST II: Demo versions allow you to connect to any chassis and use the software for the extent of the trial period. Once the trial period is over, you are permanently locked out of the software.
- To update the firmware for the chassis or modules you plan to use for AST II testing, follow the instructions in the Release Notes for the firmware. You can also use the Download Manager online help.
- To run AST II with multiple chassis, please contact Spirent’s Technical Support department for a multiple chassis keyfile (see “How to Contact Us” on page 6).
Connection Procedures

Before you can begin running tests, you must:

- Physically connect your PC to a SmartBits chassis using either an Ethernet or Serial connection. To do this, see the *SmartBits 200/2000 Installation Guide* or *SmartBits 600/6000B/6000C Installation Guide* that was shipped with your chassis.
- Set up SmartBits connections using AST II.
- Establish a connection to a SmartBits chassis using AST II.
- Connect the SmartBits chassis to a DUT/SUT.

Synchronizing Chassis

If you are using multiple chassis, synchronize the chassis by using either:

- An Expansion In and Expansion Out port of the chassis and a synchronization cable.
- GPS (Global Positioning System) by connecting a GPS receiver to the SmartBits chassis and then synchronizing clocks between the various chassis using GPS. For more information, refer to the documentation enclosed with your GPS equipment.
- CDMA (Code Division Multiple Access) by connecting a CDMA receiver to the SmartBits chassis and then synchronizing clocks between the various chassis using CDMA. For more information, refer to the documentation enclosed with your CDMA equipment.

**Important:** When using a multiple chassis arrangement that contains a SmartBits 600, 6000B, or 6000C chassis, you must use a synchronous, CAT-5, straight-through (not crossover) cable to connect the chassis together. The cable should be one meter (1m) or less in length (an appropriate synchronous, CAT-5, straight-through cable is shipped with your SmartBits chassis). The use of the synchronous cable is required in order for overall test results to be accurate (not just latency test results, but all test results).

Also, all of the chassis in the arrangement must be booted in the proper order. You must first boot the chassis that contains the master clock. Next, wait ten seconds and then boot the next chassis in the chain. Wait another ten seconds and then boot the next chassis, and so on. It is important that you wait ten seconds before booting the next chassis in line. For detailed information on multiple chassis operation, refer to the *SmartBits 200/2000 Installation Guide* or the *SmartBits 600/6000B/6000C Installation Guide*. 
Setting up SmartBits Connections

Once you have physically connected your PC to the chassis, you need to set up a SmartBits connection in AST II that corresponds to the physical connection (Ethernet or Serial).

The following procedures explain how to set up both Ethernet or Serial SmartBits connections. Prior to performing these procedures, your PC must be physically connected to the SmartBits chassis and AST II must be installed on your PC.

Setting up an Ethernet or Serial Connection

To set up an Ethernet or Serial connection between AST II and a SmartBits chassis, follow these steps:

1. Make sure that the SmartBits chassis is physically connected to your PC and is powered on.
2. In the main AST II window, select SmartBits > Connections. The Setup SmartBits Connections window appears (see Figure 3-1).
   - To add an Ethernet SmartBits connection, see “Setting up an Ethernet Connection” on page 48.
   - To add a Serial SmartBits connection, see “Setting up a Serial Connection” on page 49.

![Setup SmartBits Connections Window](Figure 3-1)
Chapter 3: Install and Connect

Connection Procedures

Setting up an Ethernet Connection

1. In the Setup SmartBits Connections window, click the Add IP... button. The IP Connection window appears.

   ![IP Connection Window]

   In the IP Connection window, do the following:
   - Enter the IP Address of the chassis.
   - Verify the default TCP Port default value (16385) here.
   - Enter a Name for the SmartBits connection. If you do not enter a name, the default name “SMB” is used.

2. Click OK. The new SmartBits connection now appears in the Setup SmartBits Connections window as shown below.

   ![Setup SmartBits Connections Window]

   You are now ready to connect to the chassis using AST II (see page 50).
Chapter 3: Install and Connect
Connection Procedures

Setting up a Serial Connection

1. In the Setup SmartBits Connections window, click the Add Serial... button. The Serial Connection window appears.

   ![Serial Connection Window]

   - Select the COM Port that you are using to connect your PC to the chassis.
   - Select the Baud Rate (default is 38400).
   - Enter a Name to identify the connection here. If you do not enter a name, the default name “SMB” is used.

   Click OK. The new SmartBits connection now appears in the Setup SmartBits Connections window as shown below.

2. In the Serial Connection window, do the following:
   - Select the COM Port you are using to connect your PC to the chassis.
   - Select the Baud Rate (default is 38400).
   - Enter a Name for the SmartBits connection. If you do not enter a name, the default name “SMB” is used.

3. Click OK. The new SmartBits connection now appears in the Setup SmartBits Connections window as shown below.

   ![Setup SmartBits Connections Window]

   The Name is the name you entered in Step 2 above.

You are now ready to connect to the chassis using AST II (see page 50).
Establishing a SmartBits-AST II Connection

After you have set up the Ethernet and/or serial SmartBits connections that you will need for testing (see “Setting up SmartBits Connections” on page 47), you can actually connect AST II to one of the chassis.

To connect AST II to your SmartBits chassis, follow the steps below:

1. Launch AST II by double-clicking the AST II icon on your PC. The main AST II window appears.
2. Choose SmartBits > Connections. The Setup SmartBits Connections window appears (Figure 3-2).

   ![Figure 3-2. Setup SmartBits Connections Window](image)

   Make sure the checkbox next to the SmartBits connection you want to use is selected.

   Once you select the connection, click OK.

3. Select the SmartBits connection that you want to use by checking the checkbox next to the connection.
4. Click OK.
5. Click the Connect button on the toolbar.

   Once connected, the main window reappears showing the available ports (see Figure 3-3 on page 51). At the bottom of the main window, the connection indicator light appears green, indicating that you are connected to the chassis.
Chapter 3: Install and Connect

Connection Procedures

Figure 3-3. Main Window After Connecting to Chassis

**Note:** If you are having difficulty connecting to the chassis, make sure that the SmartBits connection selected in the Setup SmartBits Connections window (choose SmartBits > Connections) is the right connection for the chassis.
SmartCard/Module Port Display in the Main Window

This section describes the display of the SmartCard/module ports in the Ports pane of the main window. Once you connect to a chassis using AST II, the Ports pane displays all of the available SmartCard/module ports for each chassis to which you are connected.

The factors that affect the display are:

- Whether you entered a name when you created the SmartBits connection to which you are connected (see “SmartBits Connection Names”).
- The type of chassis (see Table 3-4).

**Note:** The display of the available SmartCard/module ports is not affected by whether or not you have multiple IP SmartBits connections, or if you are using multiple chassis.

SmartBits Connection Names

When setting up a SmartBits connection for a SmartBits chassis, you can assign a specific name to each connection. If you entered a name, each port in the chassis for that connection contains the name you entered (see “Setting up SmartBits Connections” on page 47 for details on entering a name for the SmartBits connection). If you did not enter a name, AST II assigns the default name of SMB.

The numbering that follows the name you specified (or the default name) varies depending on the type of chassis (see Table 3-4).

AST II displays the ports in the main window in the same manner as they appear on the chassis. For all types of chassis, the name of the SmartBits connection is the first portion of each port name that appears in the main window.

Depending on the type of chassis, the markings that follow the connection name in the port names indicate the particular port in the chassis. The following table describes the port numbering scheme for all chassis types.

**Table 3-4. Port Numbering for Various SmartBits Chassis**

<table>
<thead>
<tr>
<th>Chassis Type</th>
<th>Port Numbering</th>
</tr>
</thead>
<tbody>
<tr>
<td>SmartBits 200/2000</td>
<td>This example shows six ports in a chassis with the SmartBits connection name of “Chassis 1.” The number following the SmartBits connection name indicates the slot and port.</td>
</tr>
<tr>
<td></td>
<td>Chassis 1 1</td>
</tr>
<tr>
<td></td>
<td>Chassis 1 2</td>
</tr>
<tr>
<td></td>
<td>Chassis 1 3</td>
</tr>
<tr>
<td></td>
<td>Chassis 1 4</td>
</tr>
<tr>
<td></td>
<td>Chassis 1 5</td>
</tr>
<tr>
<td></td>
<td>Chassis 1 6</td>
</tr>
</tbody>
</table>
Preparing the DUT/SUT

Before you begin connecting the DUT/SUT to your SmartBits chassis, it is recommended that you identify and configure the DUT/SUT ports that you want to test.

When you are ready to start the ASTI II general test setup (see Chapter 5, “General Test Setup”) you will be configuring the ports to match the configuration of the DUT/SUT. By configuring the DUT/SUT ports now, you will be prepared for the general test setup.

To prepare the DUT/SUT, follow these steps:

1. Verify that the DUT/SUT has been configured for the type of test you want to run.
2. Identify and label the ports you want to test.
3. Ensure that each port to be tested is configured.
Connecting SmartBits to the DUT/SUT

After identifying and configuring the DUT/SUT ports that you want to test, you are ready to connect the DUT/SUT to the SmartBits chassis.

**Note:** For more information about setting up the hardware and your SmartBits chassis, refer to the *SmartBits 200/2000 Installation Guide* and the *SmartBits 600/6000B/6000C Installation Guide*.

**Tips:**
- If you are using a ML-7711 SmartCard with a fiber interface, label each fiber cable connecting a SmartBits port to a DUT/SUT port.
- Remove all linked cables from the DUT/SUT that are not part of the test. These ports could receive traffic that may cause your *throughput* results to be less than the actual *throughput* for the number of ports used in your test.
- AST II does not allow hot-swapping of SmartBits cards. You must do the following to change SmartCards:
  a. Choose SmartBits > Disconnect.
  b. Change SmartCards.
  c. Connect the new SmartCards to the DUT/SUT by choosing SmartBits > Connect.

To connect your SmartBits chassis to the DUT/SUT, follow the steps below:

1. Using the appropriate cables, connect each SmartCard port to the DUT/SUT port you want to test. You can connect them in any order. If you are using a ML-7711 Fiber SmartCard, make sure that the fiber cable is never bent to a radius of less than 1.5 inches.
2. Check the DUT/SUT's link light to verify that the cables are correctly connected.
Chapter 4
Basic Navigation and Tools

This chapter describes the main AST II window menus, toolbar, tabs, and how to save test results.

In this chapter...

This chapter covers the following topics:

- The Main Window . . . . 56
- Main Window (Setup and Run Display) . . . . 57
- Main Window (Results Display) . . . . 72
- Test Results . . . . 80
The Main Window

The main window is the starting point for all AST II activities. You use the main window to open other windows, select SmartCard/module ports for the test, set up tests, run tests, view results, and more. Other windows and options that you access from the main window are discussed in the procedures in which you encounter them.

The main window has two display modes:

- **Setup & Run** which you use to set up and run tests, see “Main Window (Setup and Run Display)” on page 57.
- **Results**, which you use to view test results, see “Main Window (Results Display)” on page 72.

Selecting the Display

To select the desired display mode, use the Setup & Run and Results buttons provided in the Shortcut bar located on the left-most side of the main window (Figure 4-1). This layout allows you to check test setup while a test is running, if necessary.

![Figure 4-1. Selecting the Main Window Display](image-url)

Click the **Setup & Run** button to choose the display for setting up and running tests.

The Shortcut bar also provides buttons you can use to launch (start) tests.

See “Shortcut Bar” on page 70 for details.

Click the **Results** button to choose the display for viewing test results.
Main Window (Setup and Run Display)

When you launch AST II, the main window appears in the Setup & Run display (Figure 4-2). This display provides access to the tabs and buttons used to set up and run the various tests.

When you start a test, the display changes to the Results display, which you use to view test results. See “Main Window (Results Display)” on page 72 for information on the Results display.

Figure 4-2. The Main Window (Setup and Run Display)
Tabs

The main window contains four tabs that you use to set up the various AST II tests. These tabs are:

- **Test Setup**: see “Test Setup Tab” below.
- **Frame Setup**: see “Frame Setup Tab” on page 59.
- **Options**: see “Options Tab” on page 60.
- **Card Setup**: see “Card Setup Tab” on page 61.

Test Setup Tab

The **Test Setup** tab is used to select the type of test you want to run, select the ports you want to include in the test, and configure various test parameters such as **Frame Size**, **Burst Size**, **Load**, and **Duration**.

The fields that are available in the **Test Setup** tab depend on the type of test selected. Instructions on how to use the tab are provided in the chapter for each specific test.
Frame Setup Tab

The Frame Setup tab is used to configure how the frame should be structured and how the addresses should be mapped within the frame. These settings apply to all tests.

See “Setting the Frame Setup Parameters” on page 98 for instructions on how to use this tab.

Figure 4-4. Frame Setup Tab
Options Tab

The Options tab is used to specify options that include Load and Learning Rate units, address learning characteristics, test execution timing, and error handling behavior. You can also specify whether or not you want test results to be emailed to a certain address upon test completion.

The Load units option only applies to tests that include the Load parameter. The address learning options apply to all tests except the Address Learning and Address Caching tests. See “Setting the Test Options” on page 94 for instructions on how to use this tab.

![Options Tab](image)

**Figure 4-5.** Options Tab
Card Setup Tab

The Card Setup tab is used to configure the operational characteristics of each SmartCard/module port. Parameters include Speed, Duplex, Autonegotiation, Flow Control, Payload, Multiuser, Status, and Interface type. These settings apply to all tests.

See “Configuring the SmartCard/Module Ports” on page 88 for instructions on how to use this tab.

<table>
<thead>
<tr>
<th>Port</th>
<th>Card Model</th>
<th>Speed</th>
<th>Duplex</th>
<th>Autonegotiation</th>
<th>Flow Control</th>
<th>Payload</th>
<th>Multiuser</th>
<th>Status</th>
<th>Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chas1A1</td>
<td>LAN-3325A</td>
<td>1G</td>
<td>Full</td>
<td>Disable</td>
<td>☑️ Enable</td>
<td>All Zeros</td>
<td>Reserve</td>
<td>Enable</td>
<td>Fiber</td>
</tr>
<tr>
<td>Chas1A2</td>
<td>LAN-3325A</td>
<td>1G</td>
<td>Full</td>
<td>Disable</td>
<td>☑️ Enable</td>
<td>All Zeros</td>
<td>Reserve</td>
<td>Enable</td>
<td>Fiber</td>
</tr>
<tr>
<td>Chas1A3</td>
<td>LAN-3325A</td>
<td>1G</td>
<td>Full</td>
<td>Disable</td>
<td>☑️ Enable</td>
<td>All Zeros</td>
<td>Reserve</td>
<td>Enable</td>
<td>Fiber</td>
</tr>
<tr>
<td>Chas1A4</td>
<td>LAN-3325A</td>
<td>1G</td>
<td>Full</td>
<td>Disable</td>
<td>☑️ Enable</td>
<td>All Zeros</td>
<td>Reserve</td>
<td>Enable</td>
<td>Fiber</td>
</tr>
<tr>
<td>Chas1B1</td>
<td>LAN-3325A</td>
<td>1G</td>
<td>Full</td>
<td>Disable</td>
<td>☑️ Enable</td>
<td>All Zeros</td>
<td>Reserve</td>
<td>Enable</td>
<td>Fiber</td>
</tr>
<tr>
<td>Chas1B2</td>
<td>LAN-3325A</td>
<td>1G</td>
<td>Full</td>
<td>Disable</td>
<td>☑️ Enable</td>
<td>All Zeros</td>
<td>Reserve</td>
<td>Enable</td>
<td>Fiber</td>
</tr>
<tr>
<td>Chas1B3</td>
<td>LAN-3325A</td>
<td>1G</td>
<td>Full</td>
<td>Disable</td>
<td>☑️ Enable</td>
<td>All Zeros</td>
<td>Reserve</td>
<td>Enable</td>
<td>Fiber</td>
</tr>
<tr>
<td>Chas1B4</td>
<td>LAN-3325A</td>
<td>1G</td>
<td>Full</td>
<td>Disable</td>
<td>☑️ Enable</td>
<td>All Zeros</td>
<td>Reserve</td>
<td>Enable</td>
<td>Fiber</td>
</tr>
<tr>
<td>Chas1A1</td>
<td>LAN-3325A</td>
<td>1G</td>
<td>Full</td>
<td>Disable</td>
<td>☑️ Enable</td>
<td>All Zeros</td>
<td>Reserve</td>
<td>Enable</td>
<td>Fiber</td>
</tr>
</tbody>
</table>

Figure 4-6. Card Setup Tab

Menus

The main window contains the following seven menus:

- File; see “File Menu” below.
- Edit; see “Edit Menu” on page 62.
- View; see “View Menu” on page 63.
- SmartBits; see “SmartBits Menu” on page 64.
- Test; see “Test Menu” on page 64.
- Results; see “Results Menu” on page 65.
- Help; see “Help Menu” on page 66.

Note: Many of the functions provided through menu options are also available by using the AST II toolbar (see “Toolbar” on page 68).
Chapter 4: Basic Navigation and Tools

Main Window (Setup and Run Display)

File Menu

The *File* menu allows you to open, save, and create configuration files and test results files.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Creates a new test configuration <code>.ast</code> file. If you changed the values of the configuration parameters from the default values, use this option to reset the parameters to the default values.</td>
</tr>
<tr>
<td>Open</td>
<td>Opens the <em>Open</em> window. Use this window to open (load) a test configuration <code>.ast</code> file.</td>
</tr>
</tbody>
</table>
| Save      | The *Save* option works as follows:  
  - If you select *Save prior to running a test*, the current configuration is saved to an `.ast` file.  
  - If you select *Save after running a test*, both the current configuration and test results are saved to a single `.ast` file. |
| Save As   | Saves the current test configuration to a new `.ast` file. You must specify the name for the new file. |
| Exit      | Closes the AST II program. |

**NOTE**: A list of recently used `.ast` configuration files appears below the *Save As* option. Select the file in the list you want to use.

Edit Menu

The *Edit* menu provides a *Copy* option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copies the content from the selected tab to the clipboard (applies to the <em>Chart</em>, <em>Summary</em>, or <em>Details</em> tab). You can paste the content into other applications such as Excel or Word. If you copied the content from the <em>Summary</em> or <em>Details</em> tab, the content is pasted in tab-delimited format.</td>
</tr>
</tbody>
</table>
View Menu

The View menu allows you to hide or display various parts of the main window, such as the toolbar and status bar.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbar</td>
<td>When selected, the toolbar is displayed (see “Toolbar” on page 68).</td>
</tr>
<tr>
<td>Status Bar</td>
<td>When selected, the status bar displays status information on the test once you start the test (see “Status Bar” on page 79).</td>
</tr>
<tr>
<td>Shortcut Bar</td>
<td>When selected, the shortcut bar is displayed (see “Shortcut Bar” on page 70). You can also use the View menu to display the shortcut bar (see “View Menu” on page 63).</td>
</tr>
<tr>
<td>Enable Logging</td>
<td>Enables status messages to be logged. If you select this option, all status messages are logged in a text file that you can view using the Status Messages option.</td>
</tr>
<tr>
<td>Status Messages</td>
<td>Opens a window in Notepad that lists the status messages for the test (see Figure 4-7). For this option to work, the Enable Logging option must be selected.</td>
</tr>
</tbody>
</table>

![astui.txt - Notepad](image)

**Figure 4-7.** Example of Status Messages in Notepad
SmartBits Menu

The SmartBits menu provides options that allow SmartBits chassis connection setup and chassis connect/disconnect.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect</td>
<td>Connects your PC to one or more SmartBits chassis, as defined in the Set up SmartBits Connections window (see the Connections option below).</td>
</tr>
<tr>
<td>Disconnect</td>
<td>Disconnects your PC from all of the SmartBits chassis to which you are connected. You can also use the Disconnect button to do this (see “Toolbar” on page 68).</td>
</tr>
<tr>
<td>Connections</td>
<td>Opens the Set up SmartBits Connections window. Use this window to set up a SmartBits connection between your PC and a SmartBits chassis, and then select the chassis to which you want to connect. Use the Connect option (or the Connect button) to actually connect to the selected chassis.   See Chapter 3, “Install and Connect,” for details on how to set up a SmartBits connection and connect to a chassis.</td>
</tr>
<tr>
<td>Connect on Start</td>
<td>If selected, AST II connects to all of the chassis selected in the Set up SmartBits Connections window when launched.</td>
</tr>
</tbody>
</table>

Test Menu

The Test menu allows you to start, stop, pause, and resume tests.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run</td>
<td>Runs (starts) the test (a second menu appears that allows you to select the test). You can also start a test by using the buttons in the Shortcut bar (see “Shortcut Bar” on page 70), or the Run button in the toolbar (see “Toolbar” on page 68).</td>
</tr>
<tr>
<td>Run Current</td>
<td>Runs (starts) the current test (the test type selected in the Test Setup tab).</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops the test. You can also stop the test using the Stop button in the toolbar (see “Toolbar” on page 68).</td>
</tr>
</tbody>
</table>
Chapter 4: Basic Navigation and Tools

Main Window (Setup and Run Display)

Results Menu

The Results menu allows you to export (save) test results from the Results display in the main window to other types of files.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pause</strong></td>
<td>Temporarily pauses (stops) the test. You can also use the Pause button in the toolbar to pause the test (see “Toolbar” on page 68). Use the Resume option (see below) or the Resume button on the toolbar to resume (restart) the test.</td>
</tr>
<tr>
<td><strong>Resume</strong></td>
<td>Restarts the test after a pause. The test begins again at the point it was stopped using the Pause option (see above). You can also use the Resume button in the toolbar to resume (restart) the test (see “Toolbar” on page 68).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Browse List</strong></td>
<td>Opens the Browse Results window. This window contains identifiers for test results for tests run using the same test configuration. If you run a test more than once without changing the configuration, each test result is assigned a unique identifier which appears in the browse list window. This allows you to select the particular test result you want to view using the identifiers. If you change one or more test parameters and run the test, you are prompted to overwrite/save the existing test results (to an .ast file).</td>
</tr>
<tr>
<td><strong>Export Graph</strong></td>
<td>Exports (saves) the Chart tab as a .jpg file. You must have the Chart tab selected to select this option.</td>
</tr>
<tr>
<td><strong>Export Summary</strong></td>
<td>Exports (saves) the test results displayed in the Summary tab as .csv files. You must have the Summary tab selected to select this option.</td>
</tr>
<tr>
<td><strong>Export Detailed</strong></td>
<td>Exports (saves) the test results displayed in the Details tab as .csv files. You must have the Details tab selected to select this option.</td>
</tr>
<tr>
<td><strong>Export to HTML</strong></td>
<td>Exports (saves) the results displayed in the selected results tab (Chart, Summary, Details, or Counters) as HTML files. You can also do this by using the Results button on the toolbar (see “Toolbar” on page 68).</td>
</tr>
</tbody>
</table>
Note: For information on saving test results, including .csv files, see “Test Results” on page 80.

Help Menu

The Help menu provides options for displaying AST II online help, opening the IBG calculator, and viewing details about the AST II software you are running.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Topics</td>
<td>Opens online Help.</td>
</tr>
<tr>
<td>IBG Calculator</td>
<td>Opens the IBG Calculator window (see Figure 4-8 on page 67). Use this window to calculate the IBG (interburst gap). See “Calculating the InterBurst Gap (IBG)” on page 252 for details on how to use this window.</td>
</tr>
<tr>
<td>About AST II</td>
<td>Opens the About AST II window (see Figure 4-9 on page 67). This window displays the AST II software version level plus the version of API and the SmartBits Programming Library used to support AST II. This window also displays the name and number of each port, the current firmware and required firmware for each SmartCard/module, and the name of the chassis (scroll to view the chassis name). If you need to download updated versions of firmware for your SmartCard/modules, click on the link in the middle of the window to go to the Spirent Communications Customer Service Center website at <a href="http://support.spirentcom.com">http://support.spirentcom.com</a>, from which you can download the firmware.</td>
</tr>
</tbody>
</table>

Chapter 4: Basic Navigation and Tools
Main Window (Setup and Run Display)
Chapter 4: Basic Navigation and Tools

Main Window (Setup and Run Display)

Figure 4-8. IBG Calculator Window

Figure 4-9. About AST II Window
Chapter 4: Basic Navigation and Tools

Main Window (Setup and Run Display)

### Toolbar

The main window toolbar provides buttons for creating, opening, and saving configuration files, connecting and disconnecting from the chassis, starting and stopping tests, viewing results, and more. Many of the toolbar functions are available by using the main window menus (see “Menus” on page 61). This table lists and describes the toolbar buttons.

**Table 4-1.** Toolbar Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="open.png" alt="Open configuration file" /></td>
<td>Opens the default test configuration .ast file. If you changed the values of the configuration parameters from the default values, use this option to reset the parameters to the default values.</td>
</tr>
<tr>
<td><img src="open.png" alt="Open window" /></td>
<td>Opens the Open window. Use this window to open (load) a test configuration .ast file.</td>
</tr>
</tbody>
</table>
| ![Save configuration and results](save.png) | Allows you to do one of the following:  
- If you select this option **prior to running a test**, the current configuration is saved to an .ast file.  
- If you select this option **after running a test**, both the current configuration and test results are saved to a single .ast file. |
| ![Connect to chassis](connect.png) | Connects your PC to one or more SmartBits chassis, as selected in the Setup SmartBits Connections window (see the Connections button below). |
| ![Disconnect from chassis](disconnect.png) | Disconnects your PC from all of the SmartBits chassis to which you are connected (you can also choose SmartBits > Disconnect to do this). |
| ![Setup connections](setup.png) | Opens the Setup SmartBits Connections window. Use this window to set up a SmartBits connection between your PC and your SmartBits chassis, and then select the chassis to which you want to connect. Use the Connect button (or choose SmartBits > Connect) to actually connect to the selected chassis.  
See Chapter 3, “Install and Connect,” for details on how to set up a SmartBits connection and connect to a chassis. |
| ![Run test](run.png) | Runs (starts) the test selected in the Test Setup tab. You can also start tests by choosing Test > Run, or use the buttons in the Shortcut bar (see “Shortcut Bar” on page 70). |
| ![Pause test](pause.png) | Temporarily pauses (stops) the test. You can also choose Test > Pause to pause the test. Use the Resume button or choose Test > Resume to resume (restart) the test. |
### Table 4-1. Toolbar Buttons (continued)

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="" alt="Restart" /></td>
<td>Restarts the test after a pause. The test begins again at the point it was stopped by using the <em>Pause</em> option (see page 68). You can also choose <strong>Test &gt; Resume</strong> to resume (restart) the test.</td>
</tr>
<tr>
<td><img src="" alt="Stop" /></td>
<td>Stops the test. You can also stop the test by choosing <strong>Test &gt; Stop</strong>.</td>
</tr>
</tbody>
</table>
| ![Browse Results]() | Opens the *Browse Results* window. This window contains identifiers for test results for tests run using the same test configuration. If you run a test more than once without changing the configuration, each test result is assigned a unique identifier that appears in the browse list window. This allows you to select the particular test result you want to view using the identifiers.

If you change one or more test parameters and run the test, you are prompted to overwrite/save the existing test results (to an .ast file).

You can also open the *Browse Results* window by choosing **Results > Chart Wizard**. |
| ![Chart Wizard]() | Opens the *Chart Wizard* window. Use this window to select the ports you want to view in the test results. You can also open the *Chart Wizard* window by choosing **Results > Chart Wizard**. |
| ![Export]() | Exports (saves) the results displayed in the *Chart*, *Summary*, and *Details* tabs as HTML files. You can also do this using the **Results** menu (see “**Results Menu**” on page 65). |
| ![IBG Calculator]() | Opens the *IBG Calculator* window (see *Figure 4-8 on page 67*). Use this window to calculate the IBG (interburst gap). You can also use the **Help** menu to open this window (see “**Help Menu**” on page 66). |
| ![About AST II]() | Opens the *About AST II* window (see *Figure 4-9 on page 67*). This window displays the AST II software version level plus the version of API and the SmartBits Programming Library used to support AST II. This window also displays the name and number of each port, the current firmware and required firmware for each SmartCard/module, and the name of the chassis (scroll to view the chassis name). If you need to download updated versions of firmware for your SmartCard/modules, click on the link in the middle of the window to go to the Spirent Communications Customer Service Center website at [http://support.spirentcom.com](http://support.spirentcom.com), from which you can download the firmware. |

You can also use the **Help** menu to open this window (see “**Help Menu**” on page 66). |
Shortcut Bar

The main window provides a shortcut bar (Figure 4-10), which you can use to launch the various AST II tests. (You can also use the Test menu to start the tests; see “Test Menu” on page 64.) The Setup & Run and Results buttons at the top and bottom of the Shortcut bar can be used to select the desired main window display (see “Selecting the Display” on page 56).

You have the option of hiding or displaying the Shortcut bar. To hide it, click the X button at the top right of the Shortcut bar as shown in Figure 4-10. To display it, choose View > Shortcut bar.

Figure 4-10. Shortcut Bar
Connection Indicator Light

The main window includes an indicator light at the bottom right of the window. This light indicates whether or not AST II is connected to a SmartBits chassis (see Table 4-2). The number of current connections to the chassis is also displayed.

Table 4-2. Connection Indicator Light Indications

<table>
<thead>
<tr>
<th>Color</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>AST II is not connected to your chassis.</td>
</tr>
<tr>
<td>Green</td>
<td>AST II is connected to your chassis.</td>
</tr>
</tbody>
</table>
Main Window (Results Display)

As soon as you start a test, the main window changes from the Setup & Run display to the Results display (Figure 4-11). This display includes four tabs that you can select, depending on the type of test results you want to view (chart, summary results, detail results, or counters). In the example shown in Figure 4-11 the Chart tab is selected.

See “Results Tabs” on page 73 for descriptions of the tabs.

![Figure 4-11. AST II Main Window (Results Display)](image)
Results Tabs

The Results display contains four tabs that you use to view test results. These tabs allow you to view results in chart or table format, and you can choose to view summary results or detailed results.

Availability of the tabs depends on the type of test you are running. The following paragraphs describe each of the tabs, including which tabs are available for each test, and how to select the results you want to view.

These Results display tabs are:

- **Chart**; see “Chart Tab” on page 73.
- **Summary**; see “Summary Tab” on page 76.
- **Details**; see “Details Tab” on page 77.
- **Counters**; see “Counters Tab” on page 78.

**Note**: AST II also allows you to save the results displayed in the results tabs in a variety of formats. See “Saving Test Results” on page 80.

Chart Tab

The Chart tab allows you to view charts of the test results for each test type. You can use the Chart Wizard to specify the particular test ports that you want plotted in the chart (you can view up to a maximum of 15 ports). See “Using the Chart Wizard” on page 75 for information on how to select the ports.

The Chart tab also allows you to select the test results for particular test parameter values (such as Frame Size and Burst Size values) that you want to view (the available parameters depend on the type of test).

The charts can be exported as .jpg files or HTML files using the Results menu (see “Results Menu” on page 65).

*Figure 4-12 on page 74 shows an example of the Chart tab from the Forwarding test. In this example, the selected test parameter values are 576 bytes for Frame Size and 50 for Burst Size.*
Select the **Frame Size** you want to view here.

Select the **Burst Size** you want to view here.

Note: You can change the display format by right-clicking in the middle of the chart. A pop-up menu appears giving you two options: **Manhattan** (as shown here), and **Ribbon**. Select the desired option.

**Figure 4-12.** Chart Tab
Using the Chart Wizard

After selecting the ports to be used in a test, you can use the Chart Wizard to select the ports to be included in the Chart tab. You must select the ports you want plotted in the chart before you run the test.

To select the ports, follow these steps:

1. Open the Chart Wizard window by choosing **Results > Chart Wizard**. The Chart Wizard window appears (Figure 4-13).

![Chart Wizard Window](image)

**Figure 4-13.** Chart Wizard Window

2. In the **Ports** pane, select the ports you want to view by moving them to the **Selected** pane using the arrows.

3. Click **OK**.
Summary Tab

The Summary tab (Figure 4-14) displays the exact same information as the Chart tab, but in tabular format. The summary results can also be exported as .csv or HTML files using the Results menu (see “Results Menu” on page 65).

Like the Chart tab, the Summary tab allows you to select the test results for particular test parameter values that you want to view (such as Frame Size and Burst Size values).

Figure 4-14 shows an example of the Summary tab from the Forwarding test. In this example, the selected test parameter values are 512 bytes for Frame Size and 50 for Burst Size.

![Figure 4-14. Summary Tab](image-url)

Select the Frame Size you want to view here.

Select the Burst Size you want to view here.

<table>
<thead>
<tr>
<th>Frame Size</th>
<th>10.00 %</th>
<th>20.00 %</th>
<th>30.00 %</th>
<th>40.00 %</th>
<th>50.00 %</th>
<th>60.00 %</th>
<th>70.00 %</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>16.5471</td>
<td>33.2380</td>
<td>44.3547</td>
<td>52.3113</td>
</tr>
<tr>
<td>17 FA1</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>16.5471</td>
<td>33.2380</td>
<td>44.3547</td>
<td>52.3113</td>
</tr>
<tr>
<td>17 FA2</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>16.5471</td>
<td>33.2380</td>
<td>44.3547</td>
<td>52.3113</td>
</tr>
<tr>
<td>17 FA3</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>16.5471</td>
<td>33.2380</td>
<td>44.3547</td>
<td>52.3113</td>
</tr>
<tr>
<td>17 FA4</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>16.5471</td>
<td>33.2380</td>
<td>44.3547</td>
<td>52.3113</td>
</tr>
</tbody>
</table>
Details Tab

The Details tab (Figure 4-15) displays detailed test results for the test in table format. The data is organized by iteration for each port in the test, and you can select the iteration you want to view. Results are available for all of the iterations of the test. If you set up a monitor port for the test (not available for all tests), this tab displays test results for this port. The detailed results can also be exported as .csv or HTML files using the Results menu (see “Results Menu” on page 65).

Like the Chart and Summary tabs, the Details tab allows you to select the test results for particular test parameter values that you want to view.

Figure 4-15 shows an example of the Details tab from the Forwarding test. In this example, the selected test parameter values are 512 bytes for Frame Size, 50 for Burst Size, and 10% for Load.

![Details Tab](image)

Note: The exact set of data displayed in the Details tab depends on test type. For a list of the data that is presented in the tab, see the “Viewing Results” section of the chapter that covers the specific test.

Figure 4-15. Details Tab
Counters Tab

The Counters tab (Figure 4-16) allows you to view real-time data as the test runs. The tab is the same for all of the tests. See Appendix D, “Test Results Counters” for information on this tab, including descriptions of the various Counters tab fields.

<table>
<thead>
<tr>
<th>Port</th>
<th>Received Frames</th>
<th>Transmitted Frames</th>
<th>Received Triggers</th>
<th>Received Bytes</th>
<th>CRC Errors</th>
<th>Align Errors</th>
<th>Oversize Errors</th>
<th>Undersize Errors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mine 2-1</td>
<td>659667</td>
<td>844596</td>
<td>281657</td>
<td>85717376</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Mine 2-2</td>
<td>632458</td>
<td>844596</td>
<td>281546</td>
<td>106554624</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Mine 2-3</td>
<td>656751</td>
<td>844596</td>
<td>281649</td>
<td>84064128</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Mine 2-4</td>
<td>657517</td>
<td>844596</td>
<td>281643</td>
<td>84156176</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Figure 4-16. Counters Tab
Status Bar

The status bar only starts reporting status after you start a test. For this reason, it only appears in the Results display, not the Setup & Run display of the main window.

The status bar appears in the lower left area of the main window and reports the status of the test as the test progresses through the various test phases (see Figure 4-17 for some examples). The status bar reports information on the various phases of a test based on test setup, including:

- SmartCard/module chassis ports used in the test.
- Performance of autonegotiation (if specified).
- Verification of links.
- Performance of address learning (if specified).
- The current test iteration (including the number of the trial).
- Indication that the test was aborted due to an error.

![Figure 4-17. Status Bar Messages](image)

**Note:** For more information on the various phases of the AST II tests, see “Basic Phases of an AST II Test” on page 20.
Test Results

AST II allows you to both save and export tests results once the test is complete. When you save test results, you save the test results data for the test to a single .ast file (the results data contained in all of the tabs is recorded). See “Saving Test Results” below for details.

When you export test results, you can output the test results data for the selected results tab (Chart, Summary, or Details) in a variety of formats. The available formats vary depending on the tab you have selected. See “Exporting Test Results” below for details.

Saving Test Results

Once a test is complete, you can save test results. When you do this, both the test configuration and test results are saved in a single .ast file. You can open the file later and review the test results by clicking on the various results tabs. You can also use this .ast file to configure tests at a later time.

Once the test is complete, you can save the test results by choosing File > Save or by clicking the Save button. The .ast file is saved to the specified default directory.

Exporting Test Results

Exporting test results allows you to output test results in a variety of formats that can be used by other applications. The formats that are available vary depending on the results tab you have selected. The following table lists the formats that are available for each results tab.

**Note:** You must have the tab selected before you can export the test results data for that tab.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart</td>
<td>.jpg and HTML</td>
</tr>
<tr>
<td>Summary</td>
<td>.csv and HTML</td>
</tr>
<tr>
<td>Details</td>
<td>.csv and HTML</td>
</tr>
</tbody>
</table>

For a procedure on how to export to .csv files, see “.csv Files” on page 82.

For a procedure on how to export to HTML files, see “HTML Files” on page 81.
Chapter 4: Basic Navigation and Tools

Test Results

HTML Files

AST II allows you to save (export) the test results data for all of the results tabs in HTML format. The Chart test results can also be saved as .jpg files, and you can save the Summary and Details test results as .csv files (see “.csv Files” on page 82).

Exporting Test Results to an HTML file

To export the results of a test to an HTML file:

1 Select the tab you want.
2 Choose Results > Export to HTML. The HTML Results window appears (Figure 4-18).

Figure 4-18. HTML Results Window

3 In the HTML Results window, do the following:
   • Enter your personal information in the fields provided.
   • Enter the product and test information in the fields provided.
   • In the Frame Size and Burst Size panes, select the appropriate values for the test.
   • In the Results Format pane, select the content you want included in the final HTML file.
4 Click OK. The Save As window appears.
5 In the Save As window, enter a name for the file, select the folder where you want the HTML file saved, and click the Save button.
.csv Files

In addition to allowing you to save test results in HTML format, AST II allows you to save (export) the Summary and Details tab results in .csv format.

These .csv files can be opened using Microsoft Excel and saved as spreadsheet for your use.

Exporting Summary and Details Test Results to a .csv file

To export the results of a test to a .csv file:

1. Select the tab you want.
2. Do one of the following:
   • Choose Results > Export Summary.
   • Choose Results > Export Detailed.
3. The Save As window appears.
4. In the Save As window, enter a name for the file, select the folder where you want to .csv file saved, and click the Save button.
Chapter 5
General Test Setup

In this chapter...
This chapter covers the following topics:

• The General Test Setup Process . . . . 84
• Reserving SmartCards/Modules for the Test . . . . 85
• Configuring the SmartCard/Module Ports . . . . 88
• Setting the Test Options . . . . 94
• Setting the Frame Setup Parameters . . . . 98
• Specifying Custom Frame and Burst Sizes for a Test . . . . 104
• Using Test Configuration Files . . . . 106
The General Test Setup Process

Before you can run any of the tests, you must complete the general test setup. This setup process involves:

- Reserving SmartCards/modules
- Configuring the SmartCard/module ports
- Setting the test options (preferences)
- Setting the frame parameters

The main window provides the following tabs that you use for the general test setup:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Used for...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card Setup</td>
<td>Reserving SmartCards/modules (see “Reserving SmartCards/Modules for the Test” on page 85).</td>
</tr>
<tr>
<td>Card Setup</td>
<td>Configuring the SmartCard/module ports (see “Configuring the SmartCard/Module Ports” on page 88).</td>
</tr>
<tr>
<td>Options</td>
<td>Setting the test options (see “Setting the Test Options” on page 94).</td>
</tr>
<tr>
<td>Frame Setup</td>
<td>Setting the frame parameters (see “Setting the Frame Setup Parameters” on page 98).</td>
</tr>
</tbody>
</table>

**Note:** The main window also provides a Test Setup tab that allows you to select the type of test you want to run and set the parameters for that test. The procedures for setting these test parameters are provided in the chapters on the specific tests.
Reserving SmartCards/Modules for the Test

**Note:** This section does not apply if you are using a SmartBits 200 chassis.

If you are using a chassis that supports multiple users, you may need to reserve SmartCards/modules for the test. The chassis that support multiple users are:

- SmartBits 2000
- SmartBits 600
- SmartBits 6000B
- SmartBits 6000C

These chassis allow multiple users to be connected simultaneously and use the SmartCards/modules installed in that chassis. The different users can use a SmartCard/module for testing by reserving it for their use.

**Note:** Since AST II automatically reserves the available SmartCards/modules for your use while the test runs, you can choose not to reserve cards before you run a test. AST II also automatically releases a card (makes it available for other users) when the test is completed. However, it is highly recommended that you reserve the cards you want to use in the test. If you try to run a test using a card that has been reserved by another user after you have already configured it for the test, you cannot use it until the other user completes his/her testing and unreserves it.

The following sections show you how to:

- View the SmartCards/modules available for testing (see “Viewing the Available SmartCards/Modules” on page 86).
- Reserve and unreserve SmartCards/modules for a test (see “Reserving and Unreserving SmartCards/Modules” on page 87).
Chapter 5: General Test Setup
Reserving SmartCards/Modules for the Test

Viewing the Available SmartCards/Modules

When you connect to a chassis, the Ports pane of the main window (see below), displays only the ports of the SmartCards/modules that are available for the test.

The port display varies depending on the type of chassis. See “SmartCard/Module Port Display in the Main Window” on page 52 for information. In this example, the chassis is a SmartBits 200 and the test type selected is Forwarding with a Partially Meshed traffic distribution.

There may be SmartCards/modules installed in the chassis that do not appear. The three reasons why an installed SmartCard/module does not appear are:

- The SmartCard/module is not supported by AST II (see “Supported RFCs” on page 10 for a list of the supported SmartCards/modules).
- The SmartCard/module has old firmware. To correct this, go to the Spirent Communications’ Customer Service Center website at http://support.spirentcom.com and download the most current firmware.
- The SmartCard/module is reserved by another user.

See “Reserving and Unreserving SmartCards/Modules” on page 87 for details on how to reserve and unreserve SmartCard/modules.
Reserving and Unreserving SmartCards/Modules

To reserve and unreserve SmartCards/modules, follow these steps:

1. In the main window click on the Card Setup tab (Figure 5-1).
2. Do one of the following:
   - To **reserve** a SmartCard/module - In the *Multiuser* column, check the Reserve checkbox for each card that you want to reserve. In the example in Figure 5-1, only the cards in the chassis named “Chassis 1” have been reserved.
   - To **unreserve** a SmartCard/module - In the *Multiuser* column, uncheck the Reserve checkbox for each card you want to unreserve.

**Note:** Since SmartCards/modules are unavailable to other users if you have reserved them, it is important that you unreserve them when you do not need them.

![Figure 5-1. Card Setup Tab (Reserving and Unreserving SmartCard/Module Ports)](image)

You are now ready to configure the SmartCard/module ports for the test (see “Configuring the SmartCard/Module Ports” on page 88).
Configuring the SmartCard/Module Ports

This section provides information on setting up the SmartCard/module ports. If you want to reserve the cards to be used in a test and have not done so, do so now (see “Reserving SmartCards/Modules for the Test” on page 85).

Configuring the SmartCard/module ports involves:

- Setting the general port parameters to match the configuration of the DUT/SUT. These general port parameters include Speed, Duplex, Autonegotiation, and Flow Control.
- Enabling or disabling ports.

See “How to Configure Ports” on page 89 for information on how to set the general port parameters and enable or disable ports.

**Note:** Before you begin setting port parameters, read the section below for details on how to change the parameter values in the Card Setup tab.

### Changing Parameter Values

Since the port configuration parameters are organized in columns in the Card Setup tab, you can change a parameter setting for a single SmartCard/module, or for all the cards. The procedures below show you how to do this.

#### Changing parameter settings for a single SmartCard/module

To change the parameter settings, follow these steps:

1. Click on a cell to highlight it.
2. Left click. A pop-up menu appears showing the possible values for that parameter.
3. Select the desired value. The value is changed for the selected cell.

#### Changing parameter settings for all available SmartCard/modules

To change the parameter settings, follow these steps:

1. Click on the column heading of the parameter you want to change. The entire column for that parameter is highlighted.
2. Right click. A pop-up menu appears showing the possible values for that parameter.
3. Select the desired value. The value is changed for that parameter for all the installed cards.
How to Configure Ports

You have two options when configuring ports: you can configure all the ports at once, or individually. It is recommended that you perform the configuration for all the ports simultaneously to save time if possible.

Refer to the following sections for the procedures on port configuration.

- “Configuring All Ports Simultaneously” below.
- “Configuring Ports Individually” on page 90.

Configuring All Ports Simultaneously

This procedure shows you how to configure all of the available SmartCard/module ports simultaneously. Since all of the ports will receive the same parameter settings, all ports are enabled. The procedure on configuring the ports individually shows you how to enable / disable ports.

To configure all ports simultaneously, follow these steps:

1. In the main window, click on the Card Setup tab (Figure 5-2). Reserve any SmartCard/modules you have not yet reserved (check the Reserve checkbox).
2. Click on the Status column heading, right-mouse click, and select Enable in the pull-down menu to enable all of the cards.
3. Click in the column heading of the parameter you want to set, and right-mouse click.
4. In the pop-up menu, select the desired value. The value is changed for that parameter for all of the cards (see Table 5-1 on page 91 for definitions of the parameters).
5. Repeat Step 3 and Step 4 for all the parameters you want to change.
Configuring Ports Individually

This procedure shows you how to configure the available SmartCard/module ports individually. This procedure shows you how to enable and disable ports.

To configure ports individually, follow these steps:

1. In the main window, click on the Card Setup tab (Figure 5-3). Reserve any SmartCard/modules you have not yet reserved (check the Reserve checkbox).
2. To set the status of a port, click in the Status cell for that port and select Enable or Disable.
3. To set the Speed, Duplex, Autonegotiation, and Flow Control of a port, click in the appropriate cell for that port and select the desired value. See Table 5-1 on page 91 for definitions of the parameters.
4. To set the interface type for a port on a LAN-3320A/3321A/3324A/3325A/3327A dual-media module, click in the Interface cell for the port and select either Copper or Fiber.
5. Repeat Step 2 through Step 4 for all the ports as needed.

![Figure 5-3. Card Setup Tab (Port Configuration)]
### Configuring the SmartCard/Module Ports

**Table 5-1. Card Setup Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Speed</strong></td>
<td>Allows you to select the speed of the DUT/SUT to which this port is connected. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>10M</strong> (10 Mbps - Ethernet).</td>
</tr>
<tr>
<td></td>
<td>• <strong>100M</strong> (100 Mbps - Fast Ethernet).</td>
</tr>
<tr>
<td></td>
<td>• <strong>1G</strong> (1 Gigabit per second - Gigabit Ethernet).</td>
</tr>
<tr>
<td></td>
<td>• <strong>10G</strong> (10 Gigabit per second - Gigabit Ethernet).</td>
</tr>
<tr>
<td><strong>Duplex</strong></td>
<td>Default is <strong>Full Duplex</strong>.</td>
</tr>
<tr>
<td></td>
<td>Allows you to select the duplex mode of the DUT/SUT to which this port is connected. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Full Duplex.</strong> Allows traffic in both directions simultaneously.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Half Duplex.</strong> Allows traffic in one direction at a time. (If you select <strong>Half Duplex</strong>, the actual duration can exceed the duration specified in the test setup.)</td>
</tr>
</tbody>
</table>

**Note:** By default, AST II waits 15 seconds between each iteration of a test. This allows the transmitting ports to complete transmitting the traffic for the current iteration before starting to transmit traffic for the next iteration. If you select **Half Duplex**, the test may terminate before completion with a “Partial Transmission” error due to additional delay caused by collisions. To prevent this, you can increase the delay between iterations by increasing the wait timer value from 15 seconds to 30 seconds. To make this change, modify the **Delay After Transmit** setting on the **Options** tab (see Table 5-2, “Test Options,” on page 96).
Table 5-1. Card Setup Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autonegotiation</td>
<td>Default is <strong>Disable</strong>. When enabled, this option enables DUT/SUT interfaces (ports) to achieve their highest possible mode of operation over a link segment by providing a means for them to exchange information about their capabilities (such as speed and duplex) over the link. Depending on the speed of the port, different autonegotiation options are available as follows:</td>
</tr>
<tr>
<td></td>
<td>- For <strong>10Mbps</strong> ports, autonegotiation is ignored (Disable).</td>
</tr>
<tr>
<td></td>
<td>- For <strong>10/100Mbps</strong> ports, the options are: Disable, Registers Untouched, and Force.</td>
</tr>
<tr>
<td></td>
<td>- For <strong>1GB</strong> ports, autonegotiation is automatically set to Force (for the LAN-3300 or LAN-3301 SmartCards/modules, autonegotiation is automatically set to Disable).</td>
</tr>
<tr>
<td></td>
<td>- For <strong>10GB</strong> ports, autonegotiation is automatically set to Force.</td>
</tr>
<tr>
<td></td>
<td><strong>Disable</strong>. Allows you to disable autonegotiation and select the desired line configuration settings (speed and duplex) for your testing purposes.</td>
</tr>
<tr>
<td></td>
<td><strong>Registers Untouched</strong>. No changes are made to the speed and duplex settings of the port. If you select this option you must ensure that the Speed and Duplex settings of port are correct for your testing needs.</td>
</tr>
<tr>
<td></td>
<td><strong>Force</strong>. Forces the SmartCards/module to restart autonegotiation of line speeds and duplex prior to running the test. AST II configures the line speed and duplex according to what you select in the Speed and Duplex fields.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Flow Control</th>
<th>Default is <strong>Enable</strong>. Allows you to enable or disable flow control capability for the SmartCards/module ports.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Enable</strong>. The SmartCards/module port advertises to the DUT that it has flow control capability. The port is also able to respond to a pause frame received from the DUT by reducing its transmission rate until the DUT/SUT can handle more traffic.</td>
</tr>
<tr>
<td></td>
<td><strong>Disable</strong>. The SmartCards/module port does not advertise to the DUT that it has flow control capability. The port is also unable to respond to any pause frames received from the DUT.</td>
</tr>
</tbody>
</table>
### Table 5-1. Card Setup Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Payload</strong></td>
<td>Default is <strong>All Zeros</strong>. Allows you to specify a background pattern so that frames originating from that port will contain the background pattern. The allowable options are:</td>
</tr>
<tr>
<td>All Zeros</td>
<td>All Ones</td>
</tr>
<tr>
<td>Random</td>
<td>F0F0</td>
</tr>
<tr>
<td>00FF</td>
<td>FFFF0000</td>
</tr>
<tr>
<td>8-0s, 8-Fs</td>
<td></td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>Default is <strong>Enable</strong>. Allows you to enable (make active) or disable (make inactive) ports.</td>
</tr>
<tr>
<td>Enable</td>
<td>Disable</td>
</tr>
<tr>
<td>Interface</td>
<td>Default is <strong>Copper</strong>. Selects the interface for the LAN-3320A/3321A/3324A/3325A/3327A dual-media modules.</td>
</tr>
<tr>
<td>Copper</td>
<td>Fiber</td>
</tr>
</tbody>
</table>
Setting the Test Options

Once you have completed configuring the SmartCard/module ports, you can set the test options. If you have not yet configured the SmartCard/module ports, do so now (see “Configuring the SmartCard/Module Ports” on page 88).

Setting the AST II test options allows you to specify the following based on the type of test you want to run.

- The **units** for the *Load* and *Learning Rate* (applies only to the tests that utilize the *Load* and *Learning Rate* parameters).
- The options for address learning.
- How you want the transmitting ports to transmit traffic during the test (simultaneously or in sequence).
- The options for error handling (applies to all tests).
- If you want to be advised by email when the test is completed or is aborted due to an error (applies to all tests).

**To set the test options, follow these steps:**

1. In the main window, click on the **Options** tab (*Figure 5-4 on page 95*).
2. In the *Units* pane, select the **Load** and **Learning Rate** units using the pull-down menu based on the type of test you want to run (applies only to the tests that utilize the *Load* and *Learning Rate* parameters).
In the Learning pane, specify the following address learning options using the pull-down menu and arrows (does not apply to the Address Learning or Address Caching tests).

- **Frequency**
- **Retries**
- **Frame per Retry**
- **Rate**

If you want the transmitting ports to transmit the test traffic in sequence rather than at once, specify the amount of time (in microseconds) in the **Stagger Start** field. The amount of time you enter determines the delay between the transmissions. If you leave the value at zero (0), the transmitting ports transmit traffic at once.

To specify a time delay after transmitting traffic, enter the time delay in seconds in the **Delay After Transmit** field.
6 In the Error Handling pane, select one of the following error handling options using the pull-down menu (applies to all tests).

- Prompt
- Abort
- Retry
- Continue

7 To receive an email advising you that the test has been completed successfully or was aborted due to error, select the **Send email when test is completed** checkbox and enter your email address in the **Email address** field.

### Table 5-2. Test Options

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Units Pane</strong></td>
<td>This pane allows you to select the units you want for the <em>Load</em> and <em>Learning Rate</em> parameters for all tests (except the Address Learning test).</td>
</tr>
</tbody>
</table>
| **Load** | Default is **Percentage**.
- **Frames per second.** The amount of utilization of the medium is measured in terms of frames per second.
- **Percentage.** The amount of utilization of the medium is measured as a percentage to the total utilization. |
| **Learning Rate** | Default is **Frames per second**.
- **Frames per second.** The *learning rate* is measured in frames per second. |
| **Learning Pane** | This pane allows you to specify if you want address learning to occur, and if so, how and when you want it to take place. |
| **Frequency** | Default is **Once before test**.
- **Never Learn.** No address learning is attempted.
- **Once before test.** The learning phase of the test is performed once before the test.
- **Before each iteration.** The learning phase of the test is performed once before each iteration of the test. |
| **Retries** | Default is 3. Select the number of learning retries you want if transmission, learning verification, or link errors occur. The value must be from 1 to 100. |
### Table 5-2. Test Options (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frames per Retry</td>
<td>Default is 10. The number of frames per address for each retry. The value must be from 1 to 100.</td>
</tr>
<tr>
<td>Rate</td>
<td>Default is 100. The rate (frames per second) at which learning frames are transmitted to the DUT/SUT during the learning phase of the test. The value must be from 1 to 100.</td>
</tr>
<tr>
<td>Test Execution Pane</td>
<td>This pane allows you to customize the way the ports send traffic. The traffic can be sent all at once, with time before each transmission, or with extra time allowed after transmission.</td>
</tr>
<tr>
<td>Stagger Start (ms)</td>
<td>Default is 0. If you want the transmitting ports to transmit the test traffic in sequence rather than all at once, you can specify the amount of time (in milliseconds) in this field. The amount of time you enter determines the delay before each transmission. If you leave the value at zero (0), the transmitting ports transmit traffic all at once.</td>
</tr>
<tr>
<td>Delay after Transmit (sec)</td>
<td>Default is 15. To specify a time delay after transmitting traffic, enter the time delay in seconds. The delay after transmit is the additional amount of time the application will wait for transmission to complete in a given iteration. For example, if a port is set to transmit for 10 seconds and the wait timer set to 5 seconds, the application will calculate the amount of frames expected to be transmitted in those 10 seconds (e.g., 100,000 frames). When the ports start to transmit, the application will check to see if 100,000 frames have been transmitted and if 10 seconds are up. By the end of the 10 seconds, if all 100,000 frames have not been transmitted, the application will wait for up to an additional 5 seconds to allow all 100,000 frames to be transmitted. If all 100,000 frames are still not finished being transmitted after the additional 5 seconds, an error will be reported. The Delay After Transmit value can be set from 0 to 600 seconds.</td>
</tr>
<tr>
<td>Error Handling Pane</td>
<td>The Error Handling pane allows you to select how you want errors handled when they occur during the address learning phase.</td>
</tr>
<tr>
<td>On Error</td>
<td>Default is Abort. This option allows you to select how you want errors handled when they occur during the address learning phase.</td>
</tr>
<tr>
<td></td>
<td>• Prompt. You are prompted (alerted) when an error occurs.</td>
</tr>
<tr>
<td></td>
<td>• Abort. The test is aborted (stopped) when an error occurs.</td>
</tr>
<tr>
<td></td>
<td>• Retry. The test is started again after an error occurs.</td>
</tr>
<tr>
<td></td>
<td>• Continue. Errors are ignored.</td>
</tr>
</tbody>
</table>
Chapter 5: General Test Setup
Setting the Frame Setup Parameters

Once you have completed configuring the SmartCard/module ports and test options, you can set the frame setup parameters. If you have not yet configured the card ports and test options, do so now (see “Configuring the SmartCard/Module Ports” on page 88 and “Setting the Test Options” on page 94).

Setting the AST II frame setup parameters allows you to specify the characteristics of the test frames to match the configuration of the DUT/SUT. The frame setup parameters allow you to:

- Select the protocol format for the test frames.
- Select the protocol type for the test frames.
- Enable VLAN and set the VLAN priority and VLAN ID.
- Specify the MAC Address Port Offset and Node Offset.
- Specify the MAC Address Port Increment.

To set the frame setup parameters, follow these steps:

1. In the main window, click on the Frame Setup tab (Figure 5-5 on page 99).
2. In the Protocol pane, select the Protocol Format and Protocol Type from the pull-down menus. (See Table 5-3 on page 100 for explanations of the available options for all of the Frame Setup parameters.)
3. In the Protocol pane, enable or disable VLAN by checking or unchecking the Enable VLAN checkbox. (If you choose Enable VLAN, specify the VLAN Priority and VLAN ID).
4. In the MAC Address pane, specify Port Offset, Node Offset, and Port Increment.
5. To assign an IP header, check the Configure IP Header checkbox. This will allow you to enter values in the various IP header fields. If the Configure IP Header checkbox is not checked, then the AST II default values will apply. (Source IP Address, Destination IP Address, Time to Live, and Type of Service values will all default to 0.)

Table 5-2. Test Options (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Pane</td>
<td>This pane allows you to specify whether or not an email is sent to advise you that a test has been completed successfully or was aborted due to error.</td>
</tr>
<tr>
<td>Send email when test is completed</td>
<td>Default is disabled. To enable this option, select the Send email when test is completed checkbox and enter your email address in the Email address field. The email message contains the date and time the test was completed or aborted.</td>
</tr>
</tbody>
</table>

Setting the Frame Setup Parameters

Email Pane

This pane allows you to specify whether or not an email is sent to advise you that a test has been completed successfully or was aborted due to error.

Email Pane

Send email when test is completed

Default is disabled.

To enable this option, select the Send email when test is completed checkbox and enter your email address in the Email address field. The email message contains the date and time the test was completed or aborted.
6 Assign a **Source IP Address** and **Destination IP Address**.
7 Specify the **Time to Live**.
8 In the **Type of Service** pane, assign Precedence, Delay, Throughput, and Reliability values. (See Table 5-3 on page 100 for explanations of the available options for these fields.)

**Figure 5-5.** Frame Setup Tab
Table 5-3. Frame Setup Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol Pane</td>
<td>This pane allows you to select the protocol format and type, and allows you to enable or disable VLAN.</td>
</tr>
<tr>
<td>Protocol Format</td>
<td>Default is <strong>Ethernet II</strong>. Select the Protocol Format to match the configuration of the DUT/SUT. The options are:</td>
</tr>
<tr>
<td>Protocol Type</td>
<td>If you selected Ethernet II for the Protocol Format (see above), choose one of the available protocol types to match the configuration of the DUT/SUT.</td>
</tr>
<tr>
<td>Enable VLAN</td>
<td>Default is <strong>Disabled</strong>. Allows you to specify whether or not you want the transmitting ports in the test to transmit VLAN tagged frames. The options are:</td>
</tr>
<tr>
<td>MAC Address Pane</td>
<td>This pane allows you to specify the Port Offset, Node Offset, and Port Increment values for the MAC addresses portion of the test frames.</td>
</tr>
</tbody>
</table>
**Chapter 5: General Test Setup**

**Setting the Frame Setup Parameters**

**Table 5-3. Frame Setup Parameters (continued)**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Port Offset**   | Default is 2.  
The bytes of the port address portion of the MAC address you want incremented for the receiving ports in the test. The part of the port address that does not increment is determined by the values you enter. The amount the port address increments is determined by your Port Increment setting. The port address portion of the MAC address is always two (2) bytes. The value must be from 0 to 4.  
See “The Port and Node Offset” on page 102 for an example. |
| **Node Offset**   | The byte of the node address portion of the MAC address you want incremented. The amount of the increment is determined by the number of addresses you specify per port in the Addresses Per Port field in the Test Setup tab. The node address portion of the MAC address is always one (1) byte.  
For the Address Learning and Address Caching tests the values must be from 0 to 3.  
For all other tests the values must be from 0 to 5.  
The values stored in the field can range from 0 to **255 in hex a decimal**.  
See “The Port and Node Offset” on page 102 for an example. |
| **Port Increment**| The amount by which the port information in the MAC address is incremented.  
For example:  
• If you enter a value of 1, the resulting port numbering is 1, 2, 3, 4...  
• If you enter a value of 3 the resulting port numbering is 1, 4, 7, 10, 13... |
| **IP Header Pane**| This pane contains fields for defining the IP header in frames. |
| **Configure IP Header** | Default is **unchecked**. If the Configure IP Header checkbox is not checked, then the AST II default values will apply. (Source IP Address, Destination IP Address, Time to Live, and Type of Service values will all default to 0.) Check this checkbox to allow you to enter values in the IP Header fields. |
| **Source IP Address** | The IP address of the module port. This address should be different from the IP addresses of the other ports and from the destination IP address of the same port. When no IP Header is set, the application will transmit frames with all zeros beyond the Ethernet header. |
| **Destination IP Address** | The IP address used as a target for generated ARP/Ping requests. |
| **Time to Live** | Default is **64**.  
Time to Live (TTL) refers to how long the frame should exist, or the number of hops that should remain, until the router discards the frame. Enter a value of **0 to 255**. |
Chapter 5: General Test Setup
Setting the Frame Setup Parameters

Table 5-3. Frame Setup Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type of Service Pane</strong></td>
<td>Type-of-service (TOS) consists of a three-bit <em>Precedence</em> field and three TOS bits (<em>Delay</em>, <em>Throughput</em>, and <em>Reliability</em>). The three TOS bits are used to specify the relative weight of factors that affect data delivery.</td>
</tr>
<tr>
<td><strong>Precedence</strong></td>
<td>Default is <strong>0 - Routine</strong>. The three-bit Precedence field sets a value of 0 to 7 that provides network control to prioritize routing (the higher the value, the more important the datagram).</td>
</tr>
<tr>
<td><strong>Delay</strong></td>
<td>Default is <strong>0 - Normal</strong>. Set as either <strong>0 - Normal</strong> or <strong>1 - Low</strong>. Setting this value as <strong>1 - Low</strong> minimizes delay (places higher importance on minimal delay).</td>
</tr>
<tr>
<td><strong>Throughput</strong></td>
<td>Default is <strong>0 - Normal</strong>. Set as either <strong>0 - Normal</strong> or <strong>1 - High</strong>. Setting this value as <strong>1 - High</strong> maximizes throughput (places higher importance on maximum throughput).</td>
</tr>
<tr>
<td><strong>Reliability</strong></td>
<td>Default is <strong>0 - Normal</strong>. Set as either <strong>0 - Normal</strong> or <strong>1 - High</strong>. Setting this value as <strong>1 - High</strong> maximizes reliability (places higher importance on maximum reliability).</td>
</tr>
</tbody>
</table>

The Port and Node Offset

The MAC Address consists of two parts: the port address and the node address. The port address is used to identify frames for the hardware ports configured in the test. The port address portion of the MAC address is determined by the following:

- The values you enter for the modifiable bytes in that part of the MAC address.
- The *Port Increment* value you specify.

The Node address portion of the MAC address is determined by what you set in the modifiable byte(s) in the that part off the MAC address and how many software addresses you set in the *Test Setup* tab.

For an example of Port and Node Offset settings and the resulting MAC addresses (both source and destination), see “Example”.

Example

The example below shows one possible set of values for a test with two receiving ports. In the example, the first byte of the port address portion of the MAC address is **11**, and the second byte is **22**. The two bytes of the port address portion of the MAC address that is set to increment is the second byte (determined by the *Port Offset* value). Since there were two ports configured to receive frames in the test and the *Port Increment* value is **5**, the resulting port addresses are **1122 00 06** and **11 22 00 0b**.
The first byte of the node address portion of the MAC address is 33. The byte of the node address portion of the MAC address that is set to increment is the fifth byte (determined by the Node Offset value). Since there were 5 software address per port specified (determined by the Addresses Per Port value in the Test Setup tab), the resulting node addresses range from 33 00 to 33 04 for each port.

### Destination MAC Addresses | Source MAC Addresses

<table>
<thead>
<tr>
<th>Port</th>
<th>Node</th>
<th>Source MAC Addresses</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 22 00 06</td>
<td>33 00</td>
<td>11 22 00 01 33 00</td>
</tr>
<tr>
<td>11 22 00 06</td>
<td>33 01</td>
<td>11 22 00 01 33 01</td>
</tr>
<tr>
<td>11 22 00 06</td>
<td>33 02</td>
<td>11 22 00 01 33 02</td>
</tr>
<tr>
<td>11 22 00 06</td>
<td>33 03</td>
<td>11 22 00 01 33 03</td>
</tr>
<tr>
<td>11 22 00 06</td>
<td>33 04</td>
<td>11 22 00 01 33 03</td>
</tr>
</tbody>
</table>
Specifying Custom Frame and Burst Sizes for a Test

In case the default frame and burst size options do not meet your testing needs, AST II allows you to specify custom frame and burst sizes. This section provides procedures for setting custom frame and burst sizes.

You normally specify the frame and burst sizes for the test when setting the test parameters for the test you want to run.

- For the procedure for setting custom frame sizes, see “Using Custom Frame Sizes for the Test” below.
- For the procedure for setting custom burst sizes, see “Using Custom Burst Sizes for the Test” on page 105.

Using Custom Frame Sizes for the Test

Some tests allow you to specify custom frame sizes for the test. When using custom frame sizes, AST II allows a maximum of 2048 different sizes. The defaults custom sizes are the recommended values specified in RFC-2285 (64, 128, 256, 512, 1024, 1280, 1518).

To specify custom frame sizes, follow these steps:

1. In the main window, click on the Test Setup tab.
2. In the Frame Size pane, select the Custom box and click on the Edit button (the button is disabled until you select the Custom box). The Custom Frame Sizes window appears (see Figure 5-6 on page 104).

![Custom Frame Sizes window](image)

**Figure 5-6.** Custom Frame Sizes window.
3 Using the **Move Up**, **Move Down**, **Ascending**, and **Descending** buttons, arrange the frame sizes in the order you want for the test. Since AST II reads the frame sizes from the top down, the order of the frame sizes in the window dictates the order of the frame sizes for the test.

For example, if frame sizes listed from the top down are 128, 64, 255, the frame sizes for the test are 128, then 64, and then 255.

**Note:** If you do not see a frame size you want to use, enter it in the **Add Frame Size** text entry field and click the **Add** button. The new frame size appears in the list.

4 Click **Close**.

**Using Custom Burst Sizes for the Test**

Some tests allow you to specify custom burst sizes for the test. When using custom burst sizes, AST II allows a maximum of 1024 different sizes. The defaults custom sizes are 1, 24, and 144.

To specify custom burst sizes, follow these steps:

1 In the main window, click on the **Test Setup** tab.
2 In the **Burst Size** pane, select the **Custom** box and click on the **Edit** button (the button is disabled until you select the **Custom** box). The **Custom Burst Sizes** window appears (**Figure 5-7**).

![Custom Burst Sizes window](image)

**Figure 5-7.** Custom Burst Sizes window.
Using Test Configuration Files

This section provides information on using configuration files. AST II allows you to save your test configurations to .ast files. When you want to use these settings again for a test, you can load the .ast file rather than resetting all of the test parameters and preferences. You can also edit these files and save the edited version under a new name.

**Note:** If you save the file before you run the test, only the configuration information is saved in the .ast file. If you save the .ast file after you run a test, both the configuration information and test results are saved to the same .ast file. See “Test Results” on page 80 for information on test results.

When you save your test configuration to a file, the following settings are saved:

- Card setup (see “Configuring the SmartCard/Module Ports” on page 88)
- Test options (see “Setting the Test Options” on page 94)
- Frame Setup (see “Setting the Frame Setup Parameters” on page 98)
- Test parameters (see each test-specific chapter for instructions on how to set test-specific parameters)

For procedures on saving your test configuration to a file, loading a previously-saved file, and editing a file, see the following sections:

- “Saving Your Test Configuration to a File” on page 107
- “Loading a Previously-Saved Configuration File” on page 108
- “Editing a Previously-Saved Configuration File” on page 109
Saving Your Test Configuration to a File

Once you have defined the test setup, frame setup, test options, and card setup parameters, you can save your test configuration to an `.ast` file. The procedure below explains this process.

To save your test configuration to a file, follow these steps:

1. In the main window, choose **File > Save As**. The **Save As** window appears (**Figure 5-8**).
2. In the **File name** field, enter the name you want for the configuration (.ast) file.
3. Click the **Save** button. The file is saved to the folder where AST II has been installed.

---

**Figure 5-8.** Save As Window
Loading a Previously-Saved Configuration File

Instead of resetting all of the card setup parameters, test options, frame setup parameters, and test parameters each time you run a test, you can load a previously-saved configuration (.ast) file. You can load the file by opening it directly using the Open window (see below).

To load a previously-saved configuration file, follow these steps:

1. In the main window, choose File > Open. The Open window appears (Figure 5-9) showing the previously-saved configuration (.ast) files.

2. Do one of the following:
   - Double-click on the file you want to load.
   - Select the configuration file you want to load, and click the Open button.

The card setup, test options, frame setup, and test parameter settings are loaded for the test.

Figure 5-9. Open Window
Editing a Previously-Saved Configuration File

You can edit a previously-saved configuration file and save it under another name. This allows you to revise an existing configuration file, or create a new configuration file by editing an existing one.

The procedure below explains how to do this.

To edit a previously-saved configuration file, follow these steps:

1. In the main window, choose File > Open. The Open window appears (Figure 5-10) showing the previously-saved configuration (.ast) files.
2. Select the configuration file you want to edit.
3. Click the Open button.

![Figure 5-10. Open Window](image)

4. In the main window, click on the Options tab. Reset the test options as needed (see “Setting the Test Options” on page 94 for details).
5. Click on the Frame Setup tab. Reset the frame setup parameters as needed (see “Setting the Frame Setup Parameters” on page 98 for details).
6. In the main window, choose File > Save As. The Save As window appears.
7. In the Save As window, do one of the following:
   - To create a new configuration file, enter the name you want for the new file in the File name field. Click the Save button. The new file is saved to the folder where AST II has been installed, leaving the original file intact.
   - Click the Save button. The configuration file is saved to the folder where AST II has been installed with the changes (the original file is overwritten).
Chapter 6
Forwarding Test

This chapter describes the AST II Forwarding test.

In this chapter...
This chapter covers the following topics:

• About the Forwarding Test . . . . 112
• Test Overview . . . . 113
• Test Methodology . . . . 118
• Selecting the Ports for the Test . . . . 119
• Configuring Test Parameters . . . . 121
• Running the Test . . . . 126
• Viewing Test Results . . . . 127
About the Forwarding Test

In traditional LAN switch testing, a number of forwarding tests are used to measure the throughput and frame loss of the DUT/SUT using various traffic distributions including fully meshed, partially meshed, and non-meshed. In AST II, these traditional individual forwarding tests have been combined into a single test.

The following sections provide information about this test, including:

- What this test allows you to measure (see below)
- What this test allows you to determine (see page 113)
- A diagram of the available traffic distribution patterns (see page 114)
- The methodology of the Forwarding test (see page 118)
- How to configure test parameters (see page 121)
- How to run the test (see page 126)
- How to view test results (see page 127)

What this Test Allows You to Measure

\[\text{Table 6-1}\] below lists the key measurements for the Forwarding test based on the test mode you select (Profile or Search).

\[\text{Table 6-1. Forwording Test Measurements}\]

<table>
<thead>
<tr>
<th>Test Mode</th>
<th>Measurements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile</strong></td>
<td><strong>Frame Loss.</strong> The amount of lost (dropped) frames at a given \text{Load}.</td>
</tr>
<tr>
<td><strong>Search</strong></td>
<td><strong>Throughput</strong>. The maximum rate at which the DUT/SUT can forward traffic with no frame loss, or at the specified \text{Acceptable Frame Loss}.</td>
</tr>
<tr>
<td></td>
<td><strong>Frame Loss.</strong> The amount of lost (dropped) frames at a given \text{Load}.</td>
</tr>
</tbody>
</table>

\[\text{Note:}\] For information on test results, see “\text{Viewing Test Results}” on page 127.
What this Test Allows You to Determine

By allowing you to vary the Load, Frame Size, and Burst Size independently, as well as select the desired test mode (Profile or Search), the Forwarding test can help you determine the following for all three traffic distributions (fully meshed, partially meshed, and non-meshed).

- How increases in Load affects the DUT/SUT’s frame loss at a given Frame Size and Burst Size combination.
- How increases in Burst Size affects the DUT/SUT’s frame loss at a given Frame Size.
- The DUT/SUT’s throughput (see Table 6-1 on page 112).

Test Overview

This section provides information on the basic configuration of the Forwarding test including:

- The supported traffic distribution patterns (see “Supported Traffic Distributions”).
- Basic traffic flow (see “Traffic Flow” on page 117).

For information on the test methodology, see “Test Methodology” on page 118.

Supported Traffic Distributions

Figure 6-1 through Figure 6-3 show the supported traffic distribution patterns for this test. Select the desired traffic distribution using traffic distribution and traffic direction options in the Test Setup tab.
Chapter 6: Forwarding Test

Test Overview

Figure 6-1. Supported Traffic Distributions

### Fully Meshed

- Port 1
- Port 2
- Port 3
- Port 4

### Partially Meshed

**Option 1: Many-to-one, bidirectional**

- Port 1
- Port 2
- Port 3
- Port 4

**Option 2: Many-to-one, unidirectional**

- Port 1
- Port 2
- Port 3
- Port 4
Partially Meshed (continued)

**Option 3: One-to-many, bidirectional**

**Option 4: One-to-many, unidirectional**

**Option 5: Many-to-many, bidirectional (m-to-n)**

For this option, the number of (m) ports and (n) ports does not have to be equal.

**Option 6: Many-to-many, unidirectional (m-to-n)**

For this option, the number of (m) ports and (n) ports does not have to be equal.

Non-Meshed

**Option 1: Bidirectional A to B and B to A.**

Figure 6-2. Supported Traffic Distributions (continued)
Non-Meshed (continued)

Option 2: Unidirectional A to B.

<table>
<thead>
<tr>
<th>Single port-pair</th>
<th>Multiple port-pairs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port 1 A → B</td>
<td>Port 1 A → B</td>
</tr>
<tr>
<td>Port 2</td>
<td>Port 2</td>
</tr>
<tr>
<td>Port 3 A → B</td>
<td>Port 4</td>
</tr>
</tbody>
</table>

Option 3: Unidirectional B to A.

<table>
<thead>
<tr>
<th>Single port-pair</th>
<th>Multiple port-pairs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port 1 A → B</td>
<td>Port 1 A → B</td>
</tr>
<tr>
<td>Port 2</td>
<td>Port 2</td>
</tr>
<tr>
<td>Port 3 A → B</td>
<td>Port 4</td>
</tr>
</tbody>
</table>

Figure 6-3. Supported Traffic Distributions (continued)
Traffic Flow

Depending on the traffic distribution option you select, the way that traffic is transmitted varies slightly. This section describes how traffic is transmitted based on your traffic distribution selection.

- **Fully meshed**: The traffic is transmitted in a round robin fashion starting with the first transmitting port. There is an equal distribution of destination addresses (one for each port) to keep the test balanced. All ports are equally and fully loaded during the test, and no one port is overloaded. This table shows the order of transmission for a test with four ports.

<table>
<thead>
<tr>
<th>Source Port</th>
<th>Destination Ports (in order of transmission)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port #1</td>
<td>234234 …</td>
</tr>
<tr>
<td>Port #2</td>
<td>341341 …</td>
</tr>
<tr>
<td>Port #3</td>
<td>412124 …</td>
</tr>
<tr>
<td>Port #4</td>
<td>123123 …</td>
</tr>
</tbody>
</table>

- **Partially meshed**: Each transmitting port begins transmitting traffic at the same time. Each transmitting port transmits traffic to its destination port(s) in a round robin fashion based on the destination port addresses.

- **Non-meshed**: Each transmitting port begins transmitting traffic at the same time. Each transmitting port transmits traffic to its paired destination port.
Chapter 6: Forwarding Test
Test Methodology

The steps below describe what occurs during each iteration of the Forwarding test in both Profile and Search mode.

For information on:

• How the test progresses from iteration to iteration in Profile mode, see “Profile Mode (Duration set to Seconds)” on page 25 and “Profile Mode (Duration set to Continuous)” on page 27.

• How the test progresses from iteration to iteration in Search mode, see “Search” on page 18.

• The algorithms used to determine throughput in Search mode, see Appendix A, “Search Algorithms.”

During each iteration of the Forwarding test, the following steps are executed.

1. VFDs are set for all ports based on port addresses.
2. Trigger 1 is set to match frames with correct destination address.
3. For the specified Frame Size, the following are set:
   • Frame data length.
   • Background pattern including unique signature.
   • Trigger 2 based on signature location.
4. The Burst Size is set to the specified value.
5. The IBG (interburst gap) is calculated for the intended load (the specified Load value). See “Calculating the InterBurst Gap (IBG)” on page 252 for details on how the IBG is calculated.
6. Load is set to specified Load.
7. Timed transmission is started on all transmitting ports at the specified Start values for Load, Burst Size, and Frame Size. See “Calculating the Transmit Time” on page 253 for the formula used to calculate the transmission time.
8. Wait for the specified Duration (the Duration defines the length of each iteration). The port counters are updated continually during each iteration.

   **Note:** If you set the Duration option to Continuous, the test continues until you manually stop it.

9. When the receive trigger rate on receiving port(s) becomes 0, the elapsed time is determined from the chassis.
10. Port counters are gathered.
11. Frame loss and or final throughput is determined.
12. Results are displayed.
Selecting the Ports for the Test

This section explains how to select the ports for the Forwarding test. Before you begin this procedure make sure you have already set up the SmartCards/modules and have defined the frame setup and any optional settings (see Chapter 5, “General Test Setup”).

To select the ports for the Forwarding test, follow these steps:

1. In the main window, click on the Test Setup tab.
2. Using the Test Type pull-down menu, select Forwarding (Figure 6-4).

![Choose Forwarding here.](image)

Figure 6-4. Test Setup Tab (Forwarding Test)

3. In the lower section of the window (Figure 6-5), use the Traffic Distribution pull-down menu to select one of the following traffic distribution pattern options:
   - **Fully Meshed**: All ports in the test transmit to every other port in the test and receive traffic from all other ports in the test simultaneously. If you select this option, Select All and Clear All buttons appear at the bottom of the window you can use to select all of the ports or clear (deselect) them.
   - **Partially Meshed**: There are three basic options: one-to-many, many-to-one, and many-to-many.
   - **Non-Meshed**: All of the non-meshed traffic distribution patterns are port pairs. You can choose to have a single port-pair, or multiple port-pairs.

**Note**: See “Supported Traffic Distributions” on page 113 for details on these options.
Chapter 6: Forwarding Test
Selecting the Ports for the Test

4 Based on your traffic distribution selection (Step 3), select the ports by clicking the checkbox for each port you want included in the test. If you selected Fully Meshed for the Traffic Distribution, click the Select All button to select all of the ports.

5 (Optional) Set up a monitor port if you want to monitor the traffic from the DUT/SUT. See Table 2-1 on page 14 for a description of monitor ports. Also, make sure you have configured the DUT/SUT so that it copies all the frames it transmits to the monitor port.

6 Using the Direction pull-down menu, select one of the following traffic direction options (this step is not necessary if you selected Fully Meshed in Step 3).

- **Bidirectional M <-> N**: Traffic flows in both directions between the M and N ports simultaneously. If you choose this option, make sure that the SmartCard/ modules for the ports you selected are set to full-duplex (see “Configuring the SmartCard/Module Ports” on page 88).
- **Unidirectional M -> N**: Traffic flows from the M ports to the N ports.
- **Unidirectional N -> M**: Traffic flows from the N ports to the M ports.

**Note:** See “Traffic Flow” on page 117 for details on how the traffic is transmitted.
Configuring Test Parameters

This section explains how to configure the test parameters for the Forwarding test. Before you begin this procedure, make sure you have already completed the general test setup, including port selection (see “Selecting the Ports for the Test” on page 119).

See Table 6-2 on page 122 for descriptions of the test parameters.

Note: If you already have a configuration file for this test, you can open it to quickly configure the test (includes card setup, test options, frame setup, and test parameters).

To configure the Forwarding test parameters, follow these steps:

1. In the main window, make sure the Test Setup tab is selected. The selected Test Type should be Forwarding, as shown in Figure 6-6.

2. In the Test pane, click on one of the following radio buttons to select the desired Duration option (see Table 6-2 on page 122 for explanations of these and other options on the Test Setup tab for the Forwarding test):
   - Seconds (enter the number of seconds you want each iteration to run).
   - Continuous (the test runs continuously until you manually stop it (to stop the test, click the Stop button, or choose Test > Stop)).

3. In the Number of Trials field, enter the number of trials you want for the test.
4 In the Addresses pane, do one of the following:
   - Check the Random checkbox to randomly assign addresses to each port.
   - Use the Addresses Per Port arrows to specify the number of address you want assigned to each port.

5 In the Measurement pane, do one of the following:
   - Select Profile to run the test in Profile mode.
   - Select Search to run the test in Search mode.

6 In the Frame Size pane, select the desired Frame Size values for the test.

7 In the Burst Size pane, select the desired Burst Size values for the test.

8 In the Load pane, select the desired Load values for the test (the options are different depending on test mode you selected).

You are now ready to run the test. If you did not use an existing configuration file to configure the test parameters, you can save the current configuration to a file by choosing File > Save As option. This allows you to use the file to quickly configure the test at a later time.

See “Running the Test” on page 126 for information on running the test and “Recommended Testing Method” on page 127 for a recommended testing procedure.

Table 6-2. Forwarding Test Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Duration</strong></td>
<td>Default is 10 Seconds. Allows you to specify whether you want to the iterations of the test to run for a specified amount of time, or if you want the test to run continuously until you manually stop it. The options are:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Profile and Search</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Continuous. The test runs continuously until you manually stop it (to stop the test, click the Stop button or choose Test &gt; Stop). This option is not available when the test mode is set to Search. The Frame Size, Burst Size, and Load parameter values do not vary during the test (the values used are the specified Start values which remain constant throughout the test). This option is useful if you want to test how the DUT/SUT handles traffic when the Frame Size, Burst Size, and Load are constant.</td>
</tr>
<tr>
<td><strong>Number of Trials</strong></td>
<td>Default is 1. Allows you to specify the number of trials for the test. For a definition of trial, see Table 2-1 on page 14.</td>
<td>Profile and Search</td>
</tr>
</tbody>
</table>
## Table 6-2. Forwarding Test Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
<th>Availability</th>
</tr>
</thead>
</table>
| **Addresses** | Default is **Addresses per port** with a value of **1**. Allows you to specify the number of addresses you want to assign to each transmitting port in the test. The options are:  
  - **Random.** Addresses are assigned to the ports in the test randomly.  
  - **Addresses per port.** Each port is assigned the same number of addresses. Enter the number of addresses you want. | Profile and Search |
| **Measurements** | Default is **Profile.** Allows you to specify the test mode you want to use. The options are:  
  - **Profile.** Provides an overall view of the DUT/SUT’s forwarding performance. Frame loss is measured.  
  - **Search.** Provides a more detailed analysis of the DUT/SUT’s forwarding performance than **Profile** mode. A binary algorithm is used to determine throughput and frame loss. | N/A |
| **Frame Size** | Default is 64 **bytes** for **Start** and **Step**, and 1518 for **Stop.** Allows you to set the **Frames sizes** throughout the test for both **Profile** and **Search** mode. The options are:  
  - **Start.** The **Frame size** at the beginning of the test.  
  - **Step.** The amount the **Frame size** increments from iteration to iteration.  
  - **Stop.** The largest **Frame size** for the test.  
  - **Custom.** Allows you to specify custom frame sizes for the test. See “Using Custom Frame Sizes for the Test” on page 104 for details. | Profile and Search |
| **Burst Size** | Default is **1.** Allows you to set the **Burst sizes** throughout the test for both **Profile** and **Search** mode. The options are:  
  - **Start.** The **Burst size** at the beginning of the test.  
  - **Step.** The amount the **Burst size** increments from iteration to iteration.  
  - **Stop.** The largest **Burst size** for the test.  
  - **Custom.** Allows you to specify custom burst sizes for the test. See “Using Custom Burst Sizes for the Test” on page 105 for details. | Profile and Search |
**Table 6-2.**  Forwarding Test Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
<th>Availability</th>
</tr>
</thead>
</table>
| **Load**  | Allows you to set the *Load levels for the duration of the test*. *Load* is the amount of utilization of the medium. The options vary depending on the test mode you select (*Profile* or *Search*). The default values depend on your *Units* setting for *Load* in the *Options* tab. The *Load* default values are:  
*Profile:* **Start** 10 (*Units = Percentage), **1000** (*Units = Frames/Sec). **Step** 10 (*Units = Percentage), **1000** (*Units = Frames/Sec). **Stop** 100 (*Units = Percentage), **8,000** (*Units = Frames/Sec).  
*Search:* **Initial** 10 (*Units = Percentage), **1000** (*Units = Frames/Sec). **Min** 10 (*Units = Percentage), **1000** (*Units = Frames/Sec). **Max** 100 (*Units = Percentage), **8,000** (*Units = Frames/Sec).  
*Profile*:
The options are:  
- **Start.** The *Load* at the beginning of the test.  
- **Step.** The amount the *Load* increments from iteration to iteration.  
- **Stop.** The largest *Load* for the test.  
*Search*:
The options are:  
- **Initial.** The *Load* at the beginning of the test.  
- **Min.** The minimum allowable *Load* value for the test. If this value is reached, the test stops.  
- **Max.** The maximum allowable *Load* value for the test. If this value is reached, the test stops.  
- **Resolution.** Default is 1 (*Units = Percentage), 100 (*Units = Frames/Sec). The finest adjustment possible for the *Load* from iteration to iteration. If the required adjustment to the current *Load* for the next iteration is less than the *Resolution*, the trial stops. See “Resolution” on page 18 for details and an example.  
- **Backoff Rate.** Default is 0.5.  
The rate the *Load* decreases after the DUT fails (frame loss exceeds the specified *Acceptable Frame Loss* value) at the current *Load*. Enter an integer or decimal value. The minimum value you can enter is 0.01. See “Backoff Rate” on page 14 for the formula used to calculate the actual amount of the decrease in *Load*.  
- **Acceptable Frame Loss.** Default is 1000.  
The number of frames that can be lost without frame loss being declared. |
Table 6-2. Forwarding Test Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
<th>Availability</th>
</tr>
</thead>
</table>
| **Traffic Distribution**| Default is **Fully Meshed**. Allows you to select the traffic distribution you want for the test. The options are:  
  - **Fully Meshed.** All ports in the test transmit to every other port in the test and receive traffic from all other ports in the test simultaneously.  
  - **Partially Meshed.** Allows either one-to-many, many-to-one, or many-to-many traffic patterns. Each of these options supports bidirectional and unidirectional traffic direction (see “**Direction**” below).  
  - **Non-Meshed.** All of these traffic distribution pattern options are port pairs. You can set up the test to have a single port-pair, or multiple port-pairs. Each of these options supports bidirectional and unidirectional traffic direction (see “**Direction**” below).  
  
  See “**Supported Traffic Distributions**” on page 113 for details on these options. Once you select the desired traffic distribution, you must select the desired traffic direction (see “**Direction**” below). |
| **Direction**           | Default is **Bidirectional**. Allows you to select the traffic direction based on your traffic distribution selection (see “**Traffic Distribution**” above).  
  
  This option does not apply if you selected **Fully Meshed** for the **Traffic Distribution**. The options are:  
  - **Partially Meshed**  
    - Bidirectional M <-> N  
    - Unidirectional M -> N  
    - Unidirectional N -> M  
  - **Non-Meshed**  
    - Bidirectional A <-> B  
    - Unidirectional A -> B  
    - Unidirectional B -> A |
|                         | **Profile and Search**                                                      |              |
Running the Test

This section shows you how to start, stop, and pause (temporarily stop) the test, including a recommended testing method (see page 127). Normally, you stop the test if you set Duration to Continuous (the test runs until you manually stop it). Pausing the test allows you to view the real-time data for the current iteration of the test using the Counters tab.

Starting The Test

Once you have completed the general test setup and configured the Forwarding test parameters, you can start the test by doing one of the following:

- Click on the Forwarding test button in the Shortcut bar.
- Click on the Run Current Test button in the toolbar.
- Choose Test > Run Current, or Test > Run > Forwarding.

Once you start the test, the display of the main window changes to the Results display.

Stopping The Test

If you want to stop the test, do one of the following:

- Click on the Stop Test button in the toolbar.
- Choose Test > Stop.

Pausing The Test

If you want to pause (temporarily stop) the test, do one of the following:

- Click on the Pause Test button in the toolbar.
- Choose Test > Pause.

Note: To resume (restart) the test, choose Test > Resume or click on the Resume button.
Recommended Testing Method

This testing method shows you how to quickly determine roughly where the DUT/SUT begins to drop frames using the Profile test mode and progressively refine the test for more accurate measurements.

1. In Profile mode, set the Initial Load to 10, and use a relatively large Step Load value to get a rough idea where frame loss begins to occur (for example 30).

2. Keep the range of frame sizes to a minimum as well as the Number of Trials and set the Duration to a minimum. This will shorten the test.

3. View the results using the Chart tab or Summary tab first to quickly spot the point at which frame loss begins.

4. Adjust the test parameters and rerun the test at a finer level, focusing in on the area where frame loss started occurring. Using the Load parameters, narrow the Load to range from just below and just above that point.

5. View the results using the Details tab to see exactly where frame loss started to occur.

   Compare Test Frames Transmitted to the Test Frames Expected fields. Look for where the number of frames in each field first become unequal.

   If needed, reset the test parameters to a more focused range and rerun the test.

   **Note:** For more information on test results, see “Viewing Test Results”.

Viewing Test Results

This section provides information on the test results data that is available for this test.

As soon as you start the test, the main window changes from the Setup & Run display to the Results display. This display includes four tabs that you can use to select the test results information you want to view.

For information on the test results data for a specific tab, see the following sections:

- **Chart** tab, see “Chart Tab” on page 128.
- **Summary** tab, see “Summary Tab” on page 129.
- **Details** tab, see “Details Tab” on page 130.
- **Counters** tab, see Appendix D, “Test Results Counters” for information and field descriptions. This tab is the same for all fields.
Chart Tab

The Chart tab (Figure 6-7) displays results for selected ports and selected Frame Size and Burst Size values. You can select the ports you want to view by using the Chart Wizard (see “Using the Chart Wizard” on page 75). You can select the Frame Size and Burst Size values you want to view by using the Frame Size and Burst Size pull-down menus. Results for all iterations of the test are displayed.

The charts can also be exported as .jpg files or HTML files using the Results menu (see “Results Menu” on page 65).

Figure 6-7 shows an example of the Chart tab. In this example, the selected test parameter values are 512 for Frame Size and 50 for Burst Size.

**Figure 6-7.** Chart Tab (Forwarding Test)
Summary Tab

The Summary tab (Figure 6-8) displays the exact same information as the Chart tab but in tabular format. Like the Chart tab, the Summary tab allows you to select the Frame Size and Burst Size values that you want to view by using the Frame Size and Burst Size pull-down menus. The results are organized as follows:

- The different Load values of the test are displayed with each Load value in its own column.
- Each port is displayed in its own row.

The summary results can also be exported as .csv or HTML files using the Results menu (see “Results Menu” on page 65).

Figure 6-8 shows an example of the Summary tab. In this example, the selected test parameter values are 512 for Frame Size, and one hundred (50) for Burst Size.

![Figure 6-8. Summary Tab (Forwarding Test)](image-url)
Details Tab

The Details tab (Figure 6-9) displays detailed test for all ports for a single iteration in tabular format. You can select the Frame Size, Burst Size, and Load values for the iteration you want to view by using the Frame Size, Burst Size, and Load pull-down menus. If you set up a monitor port for the test, this tab displays test results for that port.

The detailed results can also be exported as .csv or HTML files using the Results menu (see “Results Menu” on page 65).

Figure 6-9 shows an example of the Details tab. In this example, the selected test Load value is 10%, Frame Size is 512, and Burst Size is 50.

See Table 6-2 on page 122 for descriptions of the Details tab fields.
Counters Tab

The Counters tab displays the same test results data for all AST II tests. For a list and descriptions of the various counters, see Appendix D, “Test Results Counters.”
Chapter 7
Congestion Control Test

This chapter describes the AST II Congestion Control test.

In this chapter...
This chapter covers the following topics:

• About the Congestion Control Test . . . . 134
• Test Overview . . . . 135
• Test Methodology . . . . 136
• Selecting the Ports for the Test . . . . 137
• Configuring Test Parameters . . . . 139
• Running the Test . . . . 142
• Viewing Test Results . . . . 143
About the Congestion Control Test

The Congestion Control test allows you to determine how the DUT/SUT handles congestion. Specifically, this test allows you to determine if head of line blocking exists when the receive ports of the DUT/SUT become congested. Head of line blocking occurs when the DUT/SUT restricts the flow of traffic from an external source in an attempt to reduce or minimize frame loss when under congested conditions.

The Congestion Control test enables you to simulate congestion on specific receiving ports of the DUT/SUT to determine if head of line blocking occurs. Head of line blocking is indicated when uncongested ports exhibit frame loss.

Note: This test utilizes a four-port test configuration with two transmitting ports and two receiving ports. One of the two receiving ports receives a normal amount of traffic; the other is intentionally overloaded to simulate congestion. See “Test Overview” on page 135 for more information on the test configuration.

The following sections provide information about this test, including:

- What this test allows you to measure (see below)
- What this test allows you to determine (see below)
- A diagram of the available traffic distribution patterns (see page 135)
- The methodology of the Congestion Control test (see page 136)
- How to configure test parameters (see page 139)
- How to run the test (see page 142)
- How to view test results (see page 143)

What this Test Allows You to Measure

The Congestion Control test measures the amount of lost (dropped) frames at a given Load and Frame Size and Burst Size combination for the receiving ports. This test runs in Profile mode (you do not need to select the mode).

What this Test Allows You to Determine

By allowing you to vary the Frame Size, Burst Size, and Load from the transmitting ports independently, the Congestion Control test can help you determine the following:

- If head of line blocking occurs (indicated if frame loss occurs on the uncongested receiving port).
- The Load at which head of line blocking starts to occur on the uncongested port for a given Frame Size and Burst Size combination.
- How increases in Load affect the frame loss of the uncongested receiving port.
• How increases in \textit{Burst Size} affect the frame loss of the uncongested receiving port.
• How increases in \textit{Frame Size} affect the frame loss of the uncongested receiving port.

Test Overview

This section provides information on the basic configuration of the Congestion Control test including:

• The supported traffic distribution patterns (see “Supported Traffic Distributions”).
• Basic traffic flow (see “Traffic Flow”).

For information on the test methodology, see “Test Methodology” on page 136.

Supported Traffic Distributions

\textit{Figure 7-1} shows the supported traffic distribution pattern for this test (a combination of a partially meshed one-to-many unidirectional pattern, and a unidirectional port pair). As you can see, there are four ports, two transmitting ports, and two receiving ports.

![Figure 7-1. Supported Traffic Distributions]

\textbf{Note:} Unlike some tests (like the Forwarding test), you do not select the traffic distribution using a pull-down menu. When you select the first transmitting port in the \textit{Transmitter 1} pane of the main window (Port 1 in \textit{Figure 7-1}), the remaining three ports are automatically assigned based on the order of the ports in the chassis (see “Selecting the Ports for the Test” on page 137 for details). All of the ports appear in the \textit{Sets} pane of the main window.

Traffic Flow

Both transmitting ports transmit traffic at the same time. The first transmitting port (Port 1) transmits to both receiving ports based on the destination (receiving) port addresses. The second transmitting port transmits only to the second receiving port (Port 4). The following table shows how the transmitting ports transmit frames to the receiving ports using the configuration shown in \textit{Figure 7-1}.
The receiving port that receives traffic from both transmitting ports is the congested port (Port 4). The receiving port that receives traffic from only one of the transmitting ports (Port 3) is the uncongested port (the port being tested to see if head of line blocking occurs when Port 4 is congested).

## Test Methodology

The steps below describe what occurs during each iteration of the Congestion Control test. This test is run automatically in Profile mode (you do not need to select the mode).

For information on how the test progresses from iteration to iteration in Profile mode, see “Profile Mode (Duration set to Seconds)” on page 25 and “Profile Mode (Duration set to Continuous)” on page 27.

**During each iteration of the Congestion Control test, the following steps are executed:**

1. VFDs are set for all ports based on port addresses.
2. Trigger 1 is set to match frames with correct destination address.
3. For the specified Frame Size, the following are set:
   - Frame data length.
   - Background pattern including unique signature.
   - Trigger 2 based on signature location.
4. The Burst Size is set to the specified value.
5. The IBG (interburst gap) is calculated for the intended load (the specified Load value). See “Calculating the InterBurst Gap (IBG)” on page 252 for details on how the IBG is calculated.
6. Load is set to specified Load.
7. Timed transmission is started on all transmitting ports at the specified Start values for Load, Burst Size, and Frame Size. See “Calculating the Transmit Time” on page 253 for the formula used to calculate the transmission time.
8. Wait for the specified Duration (the Duration defines the length of each iteration). The port counters are updated continually during each iteration.
Note: If you set the Duration option to Continuous, the test continues until you manually stop it.

9. When the receive trigger rate on receiving port(s) becomes 0, the elapsed time is determined from the chassis.
10. Port counters are gathered.
11. Frame loss is determined.
12. Results are displayed.

Selecting the Ports for the Test

This section explains how to select the ports for the Congestion Control test. Before you begin this procedure, make sure you have already set up the SmartCards/modules and have defined the frame setup and any optional settings (see Chapter 5, “General Test Setup”).

To select the ports for the Congestion Control test, follow these steps:

1. In the main window, click on the Test Setup tab.
2. Using the Test Type pull-down menu, select Congestion Control.
3. In the Traffic Distribution pane (see Figure 7-2 on page 138), select the two transmitting ports and the two receiving ports you want for the test in the appropriate sections. AST II automatically highlights the ports (in gray) to make it easier for you to identify the ports that are available. You do not have to select the highlighted ports.
4. Click the right arrow to move the set of ports to the Sets pane.

Note: If this arrow is not available, it means the selection of ports is not valid. Check your selections and reselect the ports.
Once you select all the ports you want, click on this arrow. The set of ports (all ports) appears in the Sets pane. If this arrow is not available, it means the selection of ports is not valid. Check your selections and reselect the ports.

**Figure 7-2.** Traffic Distribution Pane (Congestion Control Test)
Configuring Test Parameters

This section explains how to configure the test parameters for the Congestion Control test. Before you begin this procedure make sure you have already completed the general test setup including selecting the ports (see “Selecting the Ports for the Test” on page 137).

See Table 7-1 on page 140 for descriptions of the test parameters.

**Note:** If you already have a configuration file for this test, you can open it to quickly configure the test (includes card setup, test options, frame setup, and test parameters).

**To configure the Congestion Control test parameters, follow these steps:**

1. In the main window, make sure that the Test Setup tab is selected. The selected Test Type should be Congestion Control, as shown in Figure 7-3.

2. In the Test pane, click on one of the following radio buttons to select the desired Duration option (see Table 7-1 on page 140 for explanations of these and other options on the Test Setup tab for the Congestion Control test):
   - **Seconds** (enter the number of seconds you want each iteration to run).
   - **Continuous** (the test runs continuously until you stop it by clicking on the Stop button or choosing Test > Stop).

3. In the Number of Trials field, enter the number of trials you want for the test.
4  In the Addresses pane, do one of the following:
   • Check the Random checkbox to randomly assign addresses to each port.
   • Use the Addresses Per Port arrows to specify the number of addresses you want assigned to each port.

5  In the Frame Size pane, select the desired Frame Size values for the test.

6  In the Burst Size pane, select the desired Burst Size values for the test.

7  In the Load pane, select the desired Load values for the test.

You are now ready to run the test. If you did not use an existing configuration file to configure the test parameters, you can save the current configuration to a file by choosing the File > Save As option. This allows you to use the file to quickly configure the test at a later time.

See “Running the Test” on page 142 for information on running the test.

Table 7-1. Congestion Control Rate Test Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration</td>
<td>Default is 10 Seconds. Allows you to specify whether you want the iterations of the test to run for a specified amount of time, or if you want the test to run continuously until you manually stop it. The options are:</td>
</tr>
<tr>
<td></td>
<td>• Seconds. The iterations of the test run for the amount of time you specify. Enter the desired amount of time (in seconds).</td>
</tr>
<tr>
<td></td>
<td>• Continuous. The test runs continuously until you manually stop it (to stop the test, click the Stop button or choose Test &gt; Stop). This option is not available when the test mode is set to Search. The Frame Size, Burst Size, and Load parameter values do not vary during the test (the values used are the specified Start values which remain constant throughout the test). This option is useful if you want to test how the DUT/SUT handles traffic when the Frame Size, Burst Size, and Load are constant.</td>
</tr>
<tr>
<td>Number of Trials</td>
<td>Default is 1. Allows you to specify the number of trials for the test. For a definition of trial, see Table 2-1 on page 14.</td>
</tr>
<tr>
<td>Addresses</td>
<td>Default is Addresses per port with a value of 1. Allows you to specify the number of addresses you want to assign to each transmitting port in the test. The options are:</td>
</tr>
<tr>
<td></td>
<td>• Random. Addresses are assigned to the ports in the test randomly.</td>
</tr>
<tr>
<td></td>
<td>• Addresses per port. Each port is assigned the same number of addresses. Enter the number of addresses you want.</td>
</tr>
</tbody>
</table>
Chapter 7: Congestion Control Test
Configuring Test Parameters

Table 7-1. Congestion Control Rate Test Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Frame Size</strong></td>
<td>Default is <strong>64 bytes</strong> for <strong>Start</strong> and <strong>Step</strong>, and <strong>1518</strong> for <strong>Stop</strong>. Allows you to set the Frames sizes throughout the test. The options are:</td>
</tr>
<tr>
<td><strong>Start</strong></td>
<td>The Frame size at the beginning of the test.</td>
</tr>
<tr>
<td><strong>Step</strong></td>
<td>The amount the Frame size increments from iteration to iteration.</td>
</tr>
<tr>
<td><strong>Stop</strong></td>
<td>The largest Frame size for the test.</td>
</tr>
<tr>
<td><strong>Custom</strong></td>
<td>Allows you to specify custom frame sizes for the test. See “Using Custom Frame Sizes for the Test” on page 104 for details.</td>
</tr>
<tr>
<td><strong>Burst Size</strong></td>
<td>Default is <strong>1</strong>. Allows you to set the Burst sizes throughout the test for both Profile and Search mode. The options are:</td>
</tr>
<tr>
<td><strong>Start</strong></td>
<td>The Burst size at the beginning of the test.</td>
</tr>
<tr>
<td><strong>Step</strong></td>
<td>The amount the Burst size increments from iteration to iteration.</td>
</tr>
<tr>
<td><strong>Stop</strong></td>
<td>The largest Burst size for the test.</td>
</tr>
<tr>
<td><strong>Custom</strong></td>
<td>Allows you to specify custom burst sizes for the test. See “Using Custom Burst Sizes for the Test” on page 105 for details.</td>
</tr>
<tr>
<td><strong>Load</strong></td>
<td>Allows you to set the Load levels for the duration of the test. Load is the amount of utilization of the medium. The default values depend on your Units setting for Load in the Options tab. The Load default values are:</td>
</tr>
<tr>
<td><strong>Start 10</strong> (Units = Percentage), <strong>1000</strong> (Units = Frames/Sec).</td>
<td></td>
</tr>
<tr>
<td><strong>Step 10</strong> (Units = Percentage), <strong>1000</strong> (Units = Frames/Sec).</td>
<td></td>
</tr>
<tr>
<td><strong>Stop 100</strong> (Units = Percentage), <strong>8,000</strong> (Units = Frames/Sec).</td>
<td></td>
</tr>
<tr>
<td>The options are:</td>
<td></td>
</tr>
<tr>
<td><strong>Start</strong></td>
<td>The Load at the beginning of the test.</td>
</tr>
<tr>
<td><strong>Step</strong></td>
<td>The amount the Load increments from iteration to iteration.</td>
</tr>
<tr>
<td><strong>Stop</strong></td>
<td>The largest Load for the test.</td>
</tr>
</tbody>
</table>
Running the Test

This section shows you how to start, stop, and pause (temporarily stop) the test. Normally, you stop the test if you set Duration to Continuous (the test runs until you manually stop it). Pausing the test allows you to view the real-time data for the current iteration of the test using the Counters tab.

Starting The Test

Once you have completed the general test setup and configured the Congestion Control test parameters, you can start the test by doing one of the following:

- Click on the Congestion Control test button in the Shortcut bar.

- Click on the Run Current Test button in the toolbar.

- Choose Test > Run Current, or Test > Run > Congestion Control.

Once you start the test, the display of the main window changes to the Results display.

Stopping The Test

If you want to stop the test, do one of the following:

- Click on the Stop Test button in the toolbar.

- Choose Test > Stop.

Pausing The Test

If you want to pause (temporarily stop) the test, do one of the following:

- Click on the Pause Test button in the toolbar.

- Choose Test > Pause.

Note: To resume (restart) the test, choose Test > Resume or click on the Resume button.
Viewing Test Results

This section provides information on the test results data that is available for this test.

As soon as you start the test, the main window changes from the Setup & Run display to the Results display. This display includes four tabs that you can use to select the test results information you want to view.

For information on the test results data for a specific tab, see the following sections:

- **Chart** tab, see “Chart Tab” on page 144.
- **Summary** tab, see “Summary Tab” on page 145.
- **Details** tab, see “Details Tab” on page 146.
- **Counters** tab, see Appendix D, “Test Results Counters” for information and field descriptions. This tab is the same for all tests.
Chart Tab

The Chart tab (Figure 7-4) displays Frame Loss Rate results for selected ports, and selected Frame Size and Burst Size values. Select the ports you want to view using the Chart Wizard (see “Using the Chart Wizard” on page 75). Select the Frame Size and Burst Size values that you want to view by using the Frame Size and Burst Size pull-down menus. Results for all iterations of the test are displayed.

The charts can also be exported as .jpg files or HTML files using the Results menu (see “Results Menu” on page 65).

Figure 7-4 shows an example of the Chart tab. In this example, the selected test parameter values are 128 for Frame Size, and 50 for Burst Size.

Figure 7-4. Chart Tab (Congestion Control Test)
Summary Tab

The Summary tab (Figure 7-5) displays the exact same information as the Chart tab but in tabular format. Like the Chart tab, the Summary tab allows you to select the frame size and burst size values that you want to view by using the Frame Size and Burst Size pull-down menus. The results are organized as follows:

- The different Load values of the test are displayed with each Load value in its own column.
- Each port is displayed in its own row.

The summary results can also be exported as .csv or HTML files using the Results menu (see “Results Menu” on page 65).

Figure 7-5 shows an example of the Summary tab. In this example, the selected test parameter values are 128 for Frame Size and 50 for Burst Size.
Details Tab

The Details tab (Figure 7-6) displays detailed results for the congested and uncongested receiving ports for a single iteration in tabular format. You can select the Frame Size, Burst Size, and Load values for the iteration that you want to view by using the Frame Size, Burst Size, and Load% pull-down menus.

The detailed results can also be exported as .csv or HTML files using the Results menu (see “Results Menu” on page 65).

Figure 7-6 shows an example of the Details tab. In this example, the selected Load value is 10%, Frame Size is 128, and Burst Size is 50.

See Table 7-2 for descriptions of the Details tab fields.

![Figure 7-6. Details Tab (Congestion Control Test)](image)

Table 7-2. Details Tab Field Descriptions

<table>
<thead>
<tr>
<th>Field (Uncongested Port)</th>
<th>Description (Uncongested Port)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uncongested Port</td>
<td>The name of the uncongested port (this port receives 50% of the load).</td>
</tr>
<tr>
<td>Uncongested Test Frames Expected</td>
<td>The number of test frames the uncongested port expects to receive. This number is calculated by totaling all of the test frames that are destined for this port.</td>
</tr>
<tr>
<td>Uncongested Test Frames Received</td>
<td>The number of test frames received by the uncongested port. If any test frames were dropped, this total will be less than the Uncongested Test Frames Expected.</td>
</tr>
</tbody>
</table>
Table 7-2. Details Tab Field Descriptions (continued)

<table>
<thead>
<tr>
<th>Field (Uncongested Port)</th>
<th>Description (Uncongested Port)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uncongested Test Frames Lost</td>
<td>The number of test frames destined for the uncongested port that were not received. This is the difference between the Uncongested Test Frames Expected and Uncongested Test Frames Received.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field (Congested Port)</th>
<th>Description (Congested Port)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HOLB Exists?</td>
<td>Indicates of head of line blocking exists (indicated of the uncongested port drops frames).</td>
</tr>
<tr>
<td>Congested Port</td>
<td>The congested port (this port receives 150% of the load).</td>
</tr>
<tr>
<td>Congested Test Frames Expected</td>
<td>The number of test frames the congested port expects to receive. This number is calculated by totaling all of the test frames that are destined for this port.</td>
</tr>
<tr>
<td>Congested Test Frames Received</td>
<td>The number of test frames received by the congested port. If any test frames were dropped, this total will be less than the Congested Test Frames Expected.</td>
</tr>
<tr>
<td>Congested Test Frames Lost</td>
<td>The number of test frames destined for the congested port that were not received. This is the difference between the Congested Test Frames Expected and Congested Test Frames Received.</td>
</tr>
</tbody>
</table>

Counters Tab

**Note:** The Counters tab displays the same test results data for all AST II tests. For a list and descriptions of the various counters, see Appendix D, “Test Results Counters.”
Chapter 8
Address Learning Test

This chapter describes the AST II Address Learning test.

In this chapter...

This chapter covers the following topics:

• About the Address Learning Test . . . . 150
• Test Overview . . . . 151
• Test Methodology . . . . 153
• Selecting the Ports for the Test . . . . 154
• Configuring Test Parameters . . . . 155
• Running the Test . . . . 158
• Viewing Test Results . . . . 159
About the Address Learning Test

The Address Learning test allows you to determine the optimal address learning rate of the DUT/SUT. The address learning rate is the maximum rate at which the DUT/SUT can learn new MAC addresses without flooding or dropping frames. The test is run using a binary search algorithm to determine the optimal address learning rate. This test uses port pairs that consist of learn ports and test ports.

Note: For this test, you must set up a monitor port. This allows you to determine if the DUT/SUT flooded frames during the test.

The following sections provide information about this test, including:

- What this test allows you to measure (see below).
- What this test allows you to determine (see below).
- A diagram of the available traffic distribution patterns (see page 151).
- The methodology of the Address Learning test (see page 153).
- How to configure test parameters (see page 155).
- How to run the test (see page 158).
- How to view test results (see page 159).

What this Test Allows You to Measure

The key measurement for this test is the address learning rate of the DUT/SUT ports on a port-by-port basis. The address learning rate is expressed in the test results as the maximum rate (in frames per second) at which the DUT/SUT is able to learn MAC addresses.

What this Test Allows You to Determine

By allowing you to specify the number of addresses per port, Learning Rate, and Frame Size, the Address Learning test can help you determine the following:

- How increases in the number of addresses per port affects the DUT/SUT's address learning rate.
- How increases in the Frame Size affects the DUT/SUT's address learning rate.
Test Overview

This section provides information on the basic configuration of the Address Learning test including:

- The supported traffic distribution patterns (see “Supported Traffic Distributions” below).
- Basic traffic flow (see “Traffic Flow” on page 152).

For information on the test methodology, see “Test Methodology” on page 153.

Supported Traffic Distributions

The traffic distribution pattern for this test is port pairs with a learn port and a test port in each pair, and a single monitor port (see Figure 8-1).

![Figure 8-1. Supported Traffic Distributions](image)

**Note:** Unlike some tests (like the Forwarding test), you do not select the traffic distribution using a pull-down menu. When you select the ports, you need to specify the transmitting port and receiving port of each port pair (see “Selecting the Ports for the Test” on page 154 for details).
Traffic Flow

During the test, traffic is sent between the learning and test ports corresponding to the three phases of the test as follows:

1 **First Phase**: The test port transmits learning frames to the DUT/SUT and the DUT/SUT “learns” the MAC addresses. The learning frames are then forwarded by the DUT/SUT to the learn port. The frames transmitted during this phase do not include VFDs.

2 **Second Phase**: The learn port transmits learning frames to the DUT/SUT which forwards them to the test port. The frames transmitted during this phase have varying source addresses and a fixed destination address corresponding to the test (destination) port.

3 **Third Phase**: During this last phase, the test port transmits learning frames to the DUT/SUT, which then forwards them to the learn port. The frames transmitted during this phase have the following triggers:
   - Trigger 1 set to match the correct destination port ID.
   - Trigger 2 is set to match the unique signature field (this trigger identifies the frame as a test frame).
Test Methodology

The steps below describe what occurs during each iteration of the Address Learning test. This test is automatically run in Search mode (you do not need to select the mode). For information on the algorithms used to determine the Learning Rate from iteration to iteration, see Appendix A, “Search Algorithms.”

During the Address Learning test, the following steps are executed:

1. The Learning Rate is set to the specified Initial value.
2. The Number of Addresses is set to the specified value.
3. The Burst Size is set to 1.
4. Pause for the specified Aging Time.

Phase 1

5. Broadcast learning frames are transmitted from the test port to the learn port using the default value of 10 learning frames per retry (these frames do not contain VFDs).

Phase 2

6. Frames are transmitted from the learn port to the test port (these frames have varying source addresses and a fixed destination address corresponding to the test port).

Phase 3

7. Frames are transmitted from the test port to the learn port. In these frames, Trigger 1 and Trigger 2 are set to help identify them and to determine exactly which frames were correctly forwarded by the DUT/SUT.
   • Frames received by the learn port that match both triggers are considered as correctly forwarded by the DUT/SUT.
   • The number of frames received by the learn port that exceeds the number of frames transmitted by the test port is the number of flooded frames.
8. The monitor port is examined to see if flooding occurred (frames received by the monitor port that contain Trigger 1 are considered flooded frames).
9. Based on whether or not flooding occurred on the monitor port, one of the following occurs:
   • If flooding occurred, the Learning Rate is decreased from its Initial value for the next iteration and the test continues.
   • If flooding did not occur, the Learning Rate is increased from its Initial value for the next iteration and the test continues.

This test continues until one of the following occurs:

- The threshold Learning Rate is reached.
- The specified Minimum Learning Rate is reached (the test automatically stops).
- The specified Maximum Learning Rate is reached (the test automatically stops).
Selecting the Ports for the Test

This section explains how to select the ports for the Address Learning test. Before you begin this procedure, make sure you have already set up the SmartCards/modules and have defined the frame setup and any optional settings (see Chapter 5, “General Test Setup”).

To select the ports for the Address Learning test, follow these steps:

1. In the main window, click on the Test Setup tab.
2. Using the Test Type pull-down menu, select Address Learning.
3. In the Traffic Distribution pane (see Figure 8-2), set up a port pair by selecting one learn and one test port. AST II automatically highlights the ports (in gray) to make it easier for you to identify the ports that are available. You do not have to select the highlighted ports.
4. Click the right arrow to move the port pair to the Port Groups pane.

   **Note:** If this arrow is not available, it means the selection of ports is not valid. Check your selections and reselect the ports.
5. *(Optional)* Repeat Step 3 and Step 4 to set up additional port pairs.
6. Using the Monitor pull-down menu, select the monitor port for the test. This test requires a monitor port. If you do not select one, the test will not run properly.

![Figure 8-2. Test Setup Tab (Address Learning Test)](image-url)
Chapter 8: Address Learning Test

Configuring Test Parameters

This section gives a procedure for configuring the test parameters for the Address Learning test. Before you begin this procedure make sure you have already completed the general test setup including selecting the ports (see “Selecting the Ports for the Test” on page 154).

Since the Address Learning test determines the rate at which a DUT can populate its address table without flooding or dropping frames, there are two parameters that are especially important in the test setup: Aging Time and Number of Addresses. Be sure to follow the configuration instructions for these fields very carefully.

See Table 8-1 on page 156 for descriptions of the test parameters.

Note: If you already have a configuration file for this test, you can open it to quickly configure the test (includes card setup, test options, frame setup, and test parameters).

To configure the Address Learning test parameters, follow these steps:

1. In the main window, make sure that the Test Setup tab is selected and the Test Type selected is Address Learning as shown in Figure 8-3.

![Figure 8-3. Test Setup Tab (Address Learning Test)](image)

2. In the Test pane, do the following:
   - In the Number of Trials field, enter the number of trials for the test.
   - In the Aging Time field, enter the Aging Time (in seconds) for the test. This field must be set to a value greater than the value of the address aging timer on the DUT. Also, the address aging timer on the DUT must be set greater than the time it takes the Minimum learning rate (frames/second) to transmit the Number of Addresses defined.
Chapter 8: Address Learning Test
Configuring Test Parameters

Configuration Example

This example will help illustrate how to configure the Aging Time and Number of Addresses fields in relationship with the Minimum learning rate setting in AST II. If the Minimum learning rate is left at the default value of 1488 and you set the Number of Addresses to 16,000 addresses, then the absolute minimum of the DUT address Aging Time should be 16,000/1488 = 10.75 or 11 seconds. To be conservative, we recommend that you add 10 seconds of AST II overhead and set the AST II Aging Time to 32 seconds. The reason this is so important is that the DUT’s address table must be cleared before another iteration of the Address Learning test is started; otherwise, results will be invalid.

3 In the Number of Addresses field, enter the number of addresses for each port in the test. This field must be set to a lower number than the actual size of the address table for the tested DUT port or else test results will be invalid. Be very careful, as a DUT specification may be defined to have 64K of address table space, but the address space defined per VLAN or group of ports may be much less (8 or 16K). If this is the case, you will always have flooded frames and your tests will always fail.

4 In the Learning Rate pane, do the following:
   • In the Initial field, enter the learning rate for the start of the test.
   • In the Minimum field, enter the minimum learning rate for the test.
   • In the Maximum field, enter the maximum learning rate for the test.

5 In the Frame Size field, select the frame size for the test.

Note: The Burst Size is forced to 1 (you cannot change the value in the Burst Size field).

You are now ready to run the test. If you did not use an existing configuration file to configure the test parameters, you can save the current configuration to a file by choosing File > Save As option. This allows you to use the file to quickly configure the test at a later time. See “Running the Test” on page 158 for information on running the test.

Table 8-1. Address Learning Test Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Trials</td>
<td>Default is 1.</td>
</tr>
<tr>
<td></td>
<td>Allows you to specify the number of trials for the test. For a definition of trial, see Table 2-1 on page 14.</td>
</tr>
</tbody>
</table>
Chapter 8: Address Learning Test
Configuring Test Parameters

Table 8-1. Address Learning Test Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aging Time</td>
<td>Default is <strong>15 seconds</strong>. Allows you to specify the amount of the Aging Time for the DUT/SUT for the test. AST II automatically verifies that the values for the aging timers for the Address Learning and Address Caching tests are large enough for the tests to be completed. Based in-part on the initial addresses and minimum learning rate values, the application will provide a warning message if the aging timer is too small to finish the test.</td>
</tr>
<tr>
<td>Number of Addresses</td>
<td>Default is <strong>65536 per port</strong>. Allows you to specify the number of MAC addresses per port for the test.</td>
</tr>
</tbody>
</table>
| Learning Rate   | Allows you to set the learning rate for the duration of the test (the number of learning frames per second that are transmitted).  
• Initial. (Default is **10000**) The learning rate at the start of the test.  
• Minimum. (Default is **1488**) The lowest allowable learning rate for the test. If this rate is reached, the test stops.  
• Maximum. (Default is **14880**) The highest allowable learning rate for the test. If this rate is reached, the test stops. |
| Frame Size      | Default is **64 bytes**. Allows you to set the frame size for the duration of the test.                                                   |
| Burst Size      | The burst size is forced to **1** (you cannot change the value in the Burst Size field).                                                 |
Running the Test

This section shows you how to start, stop, and pause (temporarily stop) the test. Pausing the test allows you to view the real-time data for the current iteration of the test using the Counters tab.

Starting The Test

Once you have completed the general test setup and configured the Address Learning test parameters, you can start the test by doing one of the following:

- Click on the Address Learning test button in the Shortcut bar.

- Click on the Run Current Test button in the toolbar.

- Choose Test > Run Current, or Test > Run > Address Learning.

Once you start the test, the display of the main window changes to the Results display.

Stopping The Test

If you want to stop the test, do one of the following:

- Click on the Stop Test button in the toolbar.

- Choose Test > Stop.

Pausing The Test

If you want to pause (temporarily stop) the test, do one of the following:

- Click on the Pause Test button in the toolbar.

- Choose Test > Pause.

Note: To resume (restart) the test, choose Test > Resume or click on the Resume button.
Viewing Test Results

This section provides information on the test results data that is available for this test. As soon as you start the test, the main window changes from the Setup & Run display to the Results display. This display includes four tabs that you can use to select the test results information you want to view.

For information on the test results data for a specific tab, see the following sections:

- Chart tab, see “Chart Tab” on page 160.
- Summary tab, see “Summary Tab” on page 161.
- Details tab, see “Details Tab” on page 162.
- Counters tab, see Appendix D, “Test Results Counters” for information and field descriptions. This tab is the same for all tests.
Chart Tab

The Chart tab (Figure 8-4) displays the Learning Rate results for selected ports. Select the ports that you want to view by using the Chart Wizard (see “Using the Chart Wizard” on page 75). The Frame Size and Burst Size for the test appear at the top of the chart.

The charts can also be exported as .jpg files or HTML files using the Results menu (see “Results Menu” on page 65).

Figure 8-4 shows an example of the Chart tab. In this example, the test parameter values are 64 for Frame Size, and one (1) for Burst Size.

![Chart Tab (Address Learning Test)](chart.png)
Summary Tab

The Summary tab (Figure 8-5) displays the exact same information as the Chart tab but in tabular format. The Frame Size and Burst Size values for test appear near the top of the tab. The results are organized as follows:

- Each iteration is displayed in a separate column showing the Learning Rate (in frames per second) for that iteration.
- Each port is displayed in its own row.

The summary results can also be exported as .csv or HTML files using the Results menu (see “Results Menu” on page 65).

Figure 8-5 shows an example of the Summary tab. In this example, the test parameter values are 64 for Frame Size, and one (1) for Burst Size.

![Figure 8-5. Summary Tab (Address Learning Test)](image)
## Details Tab

The Details tab (Figure 8-6) displays detailed test results for a selected port pair and the monitor port, for all iterations of the test, in tabular format. You can select the port pair that you want to view by using the Port Pairs pull-down menu. The Frame Size for the test appears near the top of the tab.

The detailed results can also be exported as .csv or HTML files using the Results menu (see “Results Menu” on page 65).

*Figure 8-6* shows an example of the Details tab. In this example, the Frame Size is 64.

See Table 8-2 on page 163 for descriptions of the Details tab fields.

![Figure 8-6. Details Tab (Address Learning Test)](image)

<table>
<thead>
<tr>
<th>Learning Rate</th>
<th>Learning Port</th>
<th>Correct Frames on Learning Port</th>
<th>Other Frames on Learning Port</th>
<th>Test Port</th>
<th>Flood Count on Test Port</th>
<th>Other Frames on Test Port</th>
<th>Monitor Port</th>
<th>Flood Count on Monitor Port</th>
<th>Total Frames Received on Monitor Port</th>
<th>Test Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>1003</td>
<td>MIne 2-1</td>
<td>65536</td>
<td>0</td>
<td>Mne 2-2</td>
<td>0</td>
<td>0</td>
<td>Mne 2-9</td>
<td>65536</td>
<td>65536</td>
<td>FAIL</td>
</tr>
<tr>
<td>1007</td>
<td>MIne 2-1</td>
<td>65536</td>
<td>0</td>
<td>Mne 2-2</td>
<td>0</td>
<td>0</td>
<td>Mne 2-9</td>
<td>65536</td>
<td>65536</td>
<td>FAIL</td>
</tr>
<tr>
<td>1015</td>
<td>MIne 2-1</td>
<td>65536</td>
<td>0</td>
<td>Mne 2-2</td>
<td>0</td>
<td>0</td>
<td>Mne 2-9</td>
<td>65536</td>
<td>65536</td>
<td>FAIL</td>
</tr>
<tr>
<td>1051</td>
<td>MIne 2-1</td>
<td>65536</td>
<td>0</td>
<td>Mne 2-2</td>
<td>0</td>
<td>0</td>
<td>Mne 2-9</td>
<td>65536</td>
<td>65536</td>
<td>FAIL</td>
</tr>
<tr>
<td>1102</td>
<td>MIne 2-1</td>
<td>65536</td>
<td>0</td>
<td>Mne 2-2</td>
<td>0</td>
<td>0</td>
<td>Mne 2-9</td>
<td>65536</td>
<td>65536</td>
<td>FAIL</td>
</tr>
<tr>
<td>1153</td>
<td>MIne 2-1</td>
<td>65536</td>
<td>0</td>
<td>Mne 2-2</td>
<td>0</td>
<td>0</td>
<td>Mne 2-9</td>
<td>65536</td>
<td>65536</td>
<td>FAIL</td>
</tr>
<tr>
<td>1204</td>
<td>MIne 2-1</td>
<td>65536</td>
<td>0</td>
<td>Mne 2-2</td>
<td>0</td>
<td>0</td>
<td>Mne 2-9</td>
<td>65536</td>
<td>65536</td>
<td>FAIL</td>
</tr>
<tr>
<td>1255</td>
<td>MIne 2-1</td>
<td>65536</td>
<td>0</td>
<td>Mne 2-2</td>
<td>0</td>
<td>0</td>
<td>Mne 2-9</td>
<td>65536</td>
<td>65536</td>
<td>FAIL</td>
</tr>
<tr>
<td>1306</td>
<td>MIne 2-1</td>
<td>65536</td>
<td>0</td>
<td>Mne 2-2</td>
<td>0</td>
<td>0</td>
<td>Mne 2-9</td>
<td>65536</td>
<td>65536</td>
<td>FAIL</td>
</tr>
<tr>
<td>1357</td>
<td>MIne 2-1</td>
<td>65536</td>
<td>0</td>
<td>Mne 2-2</td>
<td>0</td>
<td>0</td>
<td>Mne 2-9</td>
<td>65536</td>
<td>65536</td>
<td>FAIL</td>
</tr>
</tbody>
</table>

Tests results for the monitor port appear here. In this example, flooding occurred in every iteration of the test.
Table 8-2. Details Tab Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correct Frames on Learning Port</td>
<td>Test frames (generated by SmartBits chassis) received on this learning port.</td>
</tr>
<tr>
<td>Other Frames on Learning Port</td>
<td>Non-test frames (not generated by SmartBits chassis) received on this learning port.</td>
</tr>
<tr>
<td>Flood Count on Test Port</td>
<td>Number of flooded frames received by the test port.</td>
</tr>
<tr>
<td>Other Frames on Test Port</td>
<td>Non-test frames (not generated by SmartBits chassis) received on this test port.</td>
</tr>
<tr>
<td>Flood Count on Monitor Port</td>
<td>Flooded frames received by the monitor port.</td>
</tr>
<tr>
<td>Other Total Frames Received on Monitor Port</td>
<td>Non-test frames (not generated by SmartBits chassis) received on this test port.</td>
</tr>
<tr>
<td>Test Status</td>
<td>Indicates whether the port passed or failed.</td>
</tr>
</tbody>
</table>

Counters Tab

The Counters tab displays the same test results data for all AST II tests. For a description of the various counters, see Appendix D, “Test Results Counters.”
Chapter 9

Address Caching Test

This chapter describes the AST II Address Caching test.

In this chapter...

This chapter covers the following topics:

- About the Address Caching Test . . . . 166
- Test Overview . . . . 167
- Test Methodology . . . . 168
- Selecting the Ports for the Test . . . . 170
- Configuring Test Parameters . . . . 171
- Running the Test . . . . 174
- Viewing Test Results . . . . 175
About the Address Caching Test

The Address Caching test allows you to determine the address caching capacity of the DUT/SUT. The address caching capacity is the maximum number of MAC addresses that a DUT/SUT can cache (store) and successfully forward frames to without flooding or dropping frames. The test is run using a binary search algorithm to determine the address caching capacity. This test uses port pairs consisting of learn ports and test ports.

Note: For this test, you must set up a monitor port. This allows you to determine if the DUT/SUT flooded frames during the test.

The following sections provide information about this test, including:

- What this test allows you to measure (see below).
- What this test allows you to determine (see below).
- A diagram of the available traffic distribution patterns (see page 167).
- The methodology of the Address Caching test (see page 168).
- How to configure test parameters (see page 171).
- How to run the test (see page 174).
- How to view test results (see page 175).

What this Test Allows You to Measure

The key measurement for this test is the address caching capacity of the DUT/SUT ports on a port-by-port basis. The address caching capacity is expressed in the test results as the maximum rate (in frames per second) at which the DUT/SUT is able to cache MAC addresses and forward frames successfully.

What this Test Allows You to Determine

By allowing you to specify the Learning Rate and Frame Size, the Address Caching test can help you determine the following:

- How increases in the Learning Rate affect the DUT/SUT’s address caching capacity.
- How increases in the Frame Size affect the DUT/SUT’s address caching capacity.
Test Overview

This section provides information on the basic configuration of the Address Caching test, including:

- The supported traffic distribution patterns (see “Supported Traffic Distributions”).
- Basic traffic flow (see “Traffic Flow” on page 168).

For information on the test methodology, see “Test Methodology” on page 168.

Supported Traffic Distributions

The traffic distribution pattern for this test consists of port pairs with a learn port and a test port in each pair, plus a single monitor port (Figure 9-1).

![Supported Traffic Distributions Diagram]

**Note:** Unlike some tests (like the Forwarding test), you do not select the traffic distribution by using a pull-down menu. When you select the ports, specify the transmitting port and receiving port of each port pair (see “Selecting the Ports for the Test” on page 170 for details).
Traffic Flow

During the test, traffic is sent between the learn and test ports in accordance with the three phases of the test as follows:

1. **First Phase**: The test port transmits learning frames to the DUT/SUT and the DUT/SUT “learns” the MAC addresses. The learning frames are then forwarded by the DUT/SUT to the learn port. The frames transmitted during this phase do not include VFDs.

2. **Second Phase**: The learn port transmits learning frames to the DUT/SUT, which forwards them to the test port. The frames transmitted during this phase have varying source addresses and a fixed destination address corresponding to the test (destination) port.

3. **Third Phase**: During this last phase, the test port transmits learning frames to the DUT/SUT, which then forwards them to the learn port. The frames transmitted during this phase have the following triggers:
   - Trigger 1 is set to match the correct destination port ID.
   - Trigger 2 is set to match the unique signature field (this trigger identifies the frame as a test frame).

Test Methodology

The steps below describe what occurs during each iteration of the Address Caching test. This test is automatically run in Search mode (you do not need to select the mode). For information on the algorithms used to determine the number of addresses from iteration to iteration, see Appendix A, “Search Algorithms.”

During the Address Caching test, the following steps are executed:

1. The **Number of Addresses** is set to the specified Initial value.
2. The **Burst Size** is set to 1.
3. Pause for the specified Aging Time.

**Phase 1**

4. Broadcast learning frames are transmitted from the test port to the learn port using the default value of 10 learning frames per retry (these frames do not contain VFDs).

**Phase 2**

5. Frames are transmitted from the learn port to the test port (these frames have varying source addresses and a fixed destination address that corresponds to the test port).
Phase 3

6 Frames are transmitted from the test port to the learn port. In these frames, Trigger 1 and Trigger 2 are set to help identify them and to determine exactly which frames were correctly forwarded by the DUT/SUT as follows:
   • Frames received by the learn port that match both triggers are considered as correctly forwarded by the DUT/SUT.
   • The number of frames received by the learn port that exceeds the number of frames transmitted by the test port is the number of flooded frames.

7 The monitor port is examined to see if flooding occurred (frames received by the monitor port that contain Trigger 1 are considered flooded frames).

8 Based on whether or not flooding occurred on the monitor port, one of the following occurs:
   • If flooding occurred, the Number of Addresses is decreased from its Initial value for the next iteration and the test continues.
   • If flooding did not occur, the Number of Addresses is increased from its Initial value for the next iteration and the test continues.

This test continues until one of the following occurs:
   • The threshold Number of Addresses is reached.
   • The specified Minimum Number of Addresses is reached (the test automatically stops).
   • The specified Maximum Number of Addresses is reached (the test automatically stops).
Selecting the Ports for the Test

This section explains how to select the ports for the Address Caching test. Before you begin this procedure, make sure you have already set up the SmartCards/modules and have defined the frame setup and any optional settings (see Chapter 5, “General Test Setup”).

To select the ports for the Address Caching test, follow these steps:

1. In the main window, click on the Test Setup tab.
2. Using the Test Type pull-down menu, select Address Caching.
3. In the Traffic Distribution pane (see Figure 9-2), set up a port pair by selecting one learn and one test port. AST II automatically highlights the ports (in gray) to make it easier for you to identify the ports that are available. You do not have to select the highlighted ports.
4. Click the right arrow to move the port pair to the Port Groups pane.

   Note: If this arrow is not available, it means the selection of ports is not valid. Check your selections and reselect the ports.
5. (Optional) Repeat Step 3 and Step 4 to set up additional port pairs.
6. Using the Monitor pull-down menu, select the monitor port for the test. This test requires a monitor port. If you do not select one, the test will not run properly.

Figure 9-2. Test Setup Tab (Address Caching Test)
Configuring Test Parameters

This section explains how to configure the test parameters for the Address Caching test. Before you begin this procedure, make sure you have already completed the general test setup, including selecting the ports (see “Selecting the Ports for the Test” on page 170).

Since the Address Caching test determines the size of a DUT’s address table per VLAN or group of ports, there are two parameters that are especially important in the test setup: Aging Time and Number of Addresses. Be sure to follow the configuration instructions for these fields very carefully.

See Table 9-1 on page 172 for descriptions of the test parameters.

Note: If you already have a configuration file for this test, you can open it to quickly configure the test (includes card setup, test options, frame setup, and test parameters).

To configure the Address Caching test parameters, follow these steps:

1. In the main window, make sure that the Test Setup tab is selected and the Test Type selected is Address Caching as shown in Figure 9-3.

![Figure 9-3. Test Setup Tab (Address Caching Test)](image)

2. In the Test pane, do the following:
   - In the Number of Trials field, enter the number of trials for the test.
   - In the Aging Time field, enter the aging time (in seconds) for the test.
   - In the Learning Rate field, enter the learning rate (frames per second) for the test. This field must be set to a value greater than the value of the address aging timer on the DUT. Also, the address aging timer on the DUT must be set to a value greater than the time it takes the learning rate to transmit the Maximum number of addresses defined.
Chapter 9: Address Caching Test
Configuring Test Parameters

**Configuration Example**

This example will help illustrate how to configure the Aging Time and Number of Addresses fields in relationship with the Learning Rate setting in AST II. Take the learning rate determined from the Address Learning test (or a figure less than the learning rate) and enter this value into the Learning Rate field of the Address Caching test. If you use a rate larger than the value found with the Address Learning test, test results may be invalid since the DUT will flood or drop any frames that it cannot handle. Next, divide the Maximum number of addresses by the Learning Rate, then double the result and set the DUT's address aging timer. Add 10 seconds to the DUT's address aging timer and assign this value as the AST II Aging Time.

3 In the Number of Addresses pane, do the following:
   - In the Initial field, enter the number of addresses for the start of the test.
   - In the Minimum field, enter the minimum number of addresses for the test.
   - In the Maximum field, enter the maximum number of addresses for the test.

4 In the Frame Size field, select the frame size for the test.

**Note:** The Burst Size is forced to 1 (you cannot change the value in the Burst Size field).

You are now ready to run the test. If you did not use an existing configuration file to configure the test parameters, you can save the current configuration to a file by choosing the File > Save As option. This allows you to use the file to quickly configure the test at a later time. See “Running the Test” on page 174 for information on running the test.

**Table 9-1. Address Caching Test Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Trials</td>
<td>Default is 1. Allows you to specify the number of trials for the test. For a definition of trial, see Table 2-1 on page 14.</td>
</tr>
<tr>
<td>Aging Time</td>
<td>Default is 15 seconds. Allows you to specify the amount of the aging time for the DUT/SUT for the test. AST II automatically verifies that the values for the aging timers for the Address Learning and Address Caching tests are large enough for the tests to be completed. Based in-part on the initial addresses and minimum learning rate values, the application will provide a warning message if the aging timer is too small to finish the test.</td>
</tr>
<tr>
<td>Learning Rate</td>
<td>Default is 1488 per second. Allows you to set the learning rate for the duration of the test (the number of learning frames per second that are transmitted).</td>
</tr>
</tbody>
</table>
### Configuring Test Parameters

Table 9-1. Address Caching Test Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Addresses</td>
<td>Allows you to specify the number of MAC addresses per port for the test.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Initial.</strong> (Default is 65536) The number of addresses at the start of the test.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Minimum.</strong> (Default is 1) The lowest allowable number of addresses for the test. If this rate is reached, the test stops.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Maximum.</strong> (Default is 16777215) The highest allowable number of addresses for the test. If this rate is reached, the test stops.</td>
</tr>
<tr>
<td>Frame Size</td>
<td>Default is 64 bytes.</td>
</tr>
<tr>
<td></td>
<td>Allows you to set the frame size for the duration of the test.</td>
</tr>
<tr>
<td>Burst Size</td>
<td>The burst size is forced to 1 (you cannot change the value in the Burst Size field).</td>
</tr>
</tbody>
</table>
Running the Test

This section shows you how to start, stop, and pause (temporarily stop) the test. Pausing the test allows you to view the real-time data for the current iteration of the test using the Counters tab.

Starting The Test

Once you have completed the general test setup and configured the Address Caching test parameters, you can start the test by doing one of the following:

- Click on the Address Caching test button in the Shortcut bar.

- Click on the Run Current Test button in the toolbar.

- Choose Test > Run Current, or Test > Run > Address Caching.

Once you start the test, the display of the main window changes to the Results display.

Stopping The Test

If you want to stop the test, do one of the following:

- Click on the Stop Test button in the toolbar.

- Choose Test > Stop.

Pausing The Test

If you want to pause (temporarily stop) the test, do one of the following:

- Click on the Pause Test button in the toolbar.

- Choose Test > Pause.

Note: To resume (restart) the test, choose Test > Resume or click on the Resume button.
Viewing Test Results

This section provides information on the test results data that is available for this test. As soon as you start the test, the main window changes from the Setup & Run display to the Results display. This display includes four tabs that you can use to select the test results information you want to view.

For information on the test results data for a specific tab, see the following sections:

- Chart tab, see “Chart Tab” on page 176.
- Summary tab, see “Summary Tab” on page 177.
- Details tab, see “Details Tab” on page 178.
- Counters tab, see Appendix D, “Test Results Counters” for information and field descriptions. This tab is the same for all tests.
Chart Tab

The Chart tab (Figure 9-4) displays the Number of Addresses results for selected ports. Select the ports that you want to view by using the Chart Wizard (see “Using the Chart Wizard” on page 75). The Frame Size and Burst Size for the test appear at the top of the chart.

The charts can also be exported as .jpg files or HTML files using the Results menu (see “Results Menu” on page 65).

Figure 9-4 shows an example of the Chart tab. In this example, the test parameter values are 64 for Frame Size and one (1) for Burst Size.

![Chart Tab (Address Caching Test)](image-url)
Summary Tab

The Summary tab (Figure 9-5) displays the exact same information as the Chart tab but in tabular format. The Frame Size and Burst Size values for the test appear near the top of the tab. The results are organized as follows:

- Each iteration is displayed in a separate column showing the Number of Addresses for that iteration.
- Each port is displayed in its own row.

The summary results can also be exported as .csv or HTML files using the Results menu (see “Results Menu” on page 65).

Figure 9-5 shows an example of the Summary tab. In this example, the test parameter values are 64 for Frame Size and one (1) for Burst Size.

Figure 9-5. Summary Tab (Address Caching Test)
Details Tab

The Details tab (Figure 9-6) displays detailed test results for a selected port pair and the monitor port, for all iterations of the test, in tabular format. You can select the port pair that you want to view by using the Port Pairs pull-down menu. The Frame Size for the test appears near the top of the tab.

The detailed results can also be exported as .csv or HTML files using the Results menu (see “Results Menu” on page 65).

Figure 9-6 shows an example of the Details tab. In this example, the Frame Size is 64.

See Table 9-2 on page 179 for descriptions of the Details tab fields.

![Figure 9-6. Details Tab (Address Caching Test)](image)

<table>
<thead>
<tr>
<th>Number of Addresses</th>
<th>Learning Port</th>
<th>Correct Frames on Learning Port</th>
<th>Other Frames on Learning Port</th>
<th>Test Port</th>
<th>Flood Count on Test Port</th>
<th>Other Frames on Test Port</th>
<th>Monitor Port</th>
<th>Flood Count on Monitor Port</th>
<th>Total Frames Received on Monitor Port</th>
<th>Test Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>5525</td>
<td>Mine 2-1</td>
<td>65536</td>
<td>655536</td>
<td>Mine 2-2</td>
<td>655500</td>
<td>0</td>
<td>Mine 2-2</td>
<td>131072</td>
<td>131072</td>
<td>FAIL</td>
</tr>
<tr>
<td>6518</td>
<td>Mine 2-1</td>
<td>65618</td>
<td>65618</td>
<td>Mine 2-2</td>
<td>656100</td>
<td>0</td>
<td>Mine 2-2</td>
<td>131036</td>
<td>131036</td>
<td>FAIL</td>
</tr>
<tr>
<td>5509</td>
<td>Mine 2-1</td>
<td>65509</td>
<td>65509</td>
<td>Mine 2-2</td>
<td>655000</td>
<td>0</td>
<td>Mine 2-2</td>
<td>131019</td>
<td>131019</td>
<td>FAIL</td>
</tr>
<tr>
<td>6504</td>
<td>Mine 2-1</td>
<td>65604</td>
<td>65604</td>
<td>Mine 2-2</td>
<td>656004</td>
<td>0</td>
<td>Mine 2-2</td>
<td>131003</td>
<td>131003</td>
<td>FAIL</td>
</tr>
<tr>
<td>5512</td>
<td>Mine 2-1</td>
<td>65512</td>
<td>65512</td>
<td>Mine 2-2</td>
<td>655100</td>
<td>0</td>
<td>Mine 2-2</td>
<td>131004</td>
<td>131004</td>
<td>FAIL</td>
</tr>
</tbody>
</table>

Tests results for the monitor port appear here. In this example, flooding occurred in every iteration of the test.
The **Counters Tab** displays the same test results data for all AST II tests. For a list and descriptions of the various counters, see Appendix D, “Test Results Counters.”
Chapter 10
Error Filtering Test

In this chapter...
This chapter covers the following topics:

• About the Error Filtering Test . . . . 182
• Test Overview . . . . 184
• Test Methodology . . . . 185
• Selecting the Ports for the Test . . . . 186
• Configuring Test Parameters . . . . 187
• Running the Test . . . . 191
• Viewing Test Results . . . . 192
About the Error Filtering Test

The Error Filtering test allows you to determine how the DUT/SUT handles errored frames. You can simulate various types of errored frames to determine the ability of the DUT/SUT to recognize specific errors, and filter (drop) the frames that contain the errors.

The following sections provide information about this test, including:

- What this test allows you to measure (see below).
- What this test allows you to determine (see below).
- A diagram of the available traffic distribution patterns (see page 184).
- The methodology of the Error Filtering test (see page 185).
- How to configure test parameters (see page 187).
- How to run the test (see page 191).
- How to view test results (see page 192).

What this Test Allows You to Measure

The Error Filtering test measures the amount of lost (dropped) frames at a given Load, Frame Size, and Burst Size combination.

What this Test Allows You to Determine

In addition to allowing you to vary the Load, Frame Size, and Burst Size, you can also select the particular error type you want to simulate. Table 10-1 lists the various errors you can simulate as well as the pass criteria for each error.

Table 10-1. Available Errors

<table>
<thead>
<tr>
<th>Error</th>
<th>Pass Criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oversize</td>
<td>Frames greater than the specified Oversize value are not forwarded by the DUT/SUT. Specify this value in the Test Setup tab.</td>
</tr>
<tr>
<td>Undersize</td>
<td>Frames less than the specified Undersize value are not forwarded by the DUT/SUT. Specify this value in the Test Setup tab.</td>
</tr>
<tr>
<td>CRC errors</td>
<td>CRC errored frames are not forwarded by the DUT/SUT.</td>
</tr>
<tr>
<td>Dribble Bit</td>
<td>Dribble bit errored frames are corrected and forwarded by the DUT/SUT.</td>
</tr>
<tr>
<td>Alignment</td>
<td>Alignment errored frames are not forwarded by the DUT/SUT.</td>
</tr>
</tbody>
</table>
Note: The type of errors that you can simulate during testing vary according to the type of interface you are testing. See Table 10-2 on page 183 for a list of the error types that can be tested based on the interface type.

By allowing you to vary the Load at a specified Frame Size and Burst Size, as well as specify the error type(s), the Error Filtering test can help you determine the following:

• How increases in the Load at a given Frame Size and Burst Size combination affect the DUT/SUT’s ability to filter certain error type(s).

Note: Although you can vary the Frame Size and Burst Size from test to test, these parameters remain constant during the test (only the Load varies during the test). To vary the Frame Size and Burst Size from test to test, you must reset them and rerun the test.

• The Load at which the DUT/SUT’s ability to filter the error type(s) you selected begins to decline.

• How increases in Frame Size affect the DUT/SUT’s ability to filter the error type(s) you selected.

• How increases in Burst Size affect the DUT/SUT’s ability to filter the error type(s) you selected.

• If the occurrence of certain errors affect the DUT/SUT’s ability to filter other errors. (You can test this by selecting different combinations of error types for the test.)

Table 10-2 lists the error types that can be tested based on the interface type.

Table 10-2. Supported Error Types by Interface

<table>
<thead>
<tr>
<th>Interface</th>
<th>Oversize</th>
<th>Undersize</th>
<th>CRC</th>
<th>Dribble Bit&lt;sup&gt;1&lt;/sup&gt;</th>
<th>Alignment&lt;sup&gt;2&lt;/sup&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>10MB</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>100MB</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>1000MB</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>10 GB</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

<sup>1</sup> The TeraMetrics modules do not support the Dribble Bit error type.

<sup>2</sup> The TeraMetrics modules do not support the Alignment error type.
Test Overview

This section provides information on the basic configuration of the Error Filtering test including:

- The supported traffic distribution patterns (see “Supported Traffic Distributions”).
- Basic traffic flow (see “Traffic Flow” below).

For information on Error Filtering test methodology, see “Test Methodology” on page 185.

Supported Traffic Distributions

*Figure 10-1* shows the supported traffic distribution patterns for this test (either a single port pair or multiple port pairs with one transmitting and one receiving port in each pair). The traffic direction for this test is always unidirectional.

![Figure 10-1. Supported Traffic Distributions](image-url)

**Note:** Unlike some tests (like the Forwarding test), you do not select the traffic distribution using a pull-down menu. When you select the ports you specify the transmitting port and receiving port of each port pair (see “Selecting the Ports for the Test” on page 186 for details).

Traffic Flow

The transmitting ports in each port pair you set up transmit traffic to the receiving ports in sequence. The following table shows how the transmitting ports transmit frames to the receiving ports using the configuration shown in *Figure 10-1.*
Chapter 10: Error Filtering Test

Test Methodology

The steps below describe what occurs during each iteration of the Error Filtering test. This test is run automatically in Profile mode (you do not need to select the mode).

For information on how the test progresses from iteration to iteration in Profile mode, see “Profile Mode (Duration set to Seconds)” on page 25 and “Profile Mode (Duration set to Continuous)” on page 27.

During each iteration of the Error Filtering test, the following steps are executed:

1. VFDs are set for all ports based on port addresses.
2. Trigger 1 is set to match frames with correct destination address.
3. For the specified Frame Size, the following are set:
   - Frame data length
   - Background pattern including unique signature
   - Trigger 2 based on signature location
4. The Burst Size is set to the specified value.
5. The IBG (interburst gap) is calculated for the intended load (the specified Load value). See “Calculating the InterBurst Gap (IBG)” on page 252 for details on how the IBG is calculated.
6. Load is set to the specified Load value.
7. Timed transmission is started on all transmitting ports at the specified Start values for Load, Burst Size, and Frame Size. See “Calculating the Transmit Time” on page 253 for the formula used to calculate the transmission time.
8. Wait for the specified Duration (the Duration defines the length of each iteration). The port counters are updated continually during each iteration.
9. When the receive trigger rate on receiving port(s) becomes 0, the elapsed time is determined from the chassis.
10. Port counters are gathered.
11. Frame loss is determined.
12. Results are displayed.

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Source Port</th>
<th>Destination Ports (simultaneous transmission)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Port Pair</td>
<td>Port #1</td>
<td>2 only</td>
</tr>
<tr>
<td>Multiple Port Pairs</td>
<td>Port #1</td>
<td>2 only</td>
</tr>
<tr>
<td></td>
<td>Port #3</td>
<td>4 only</td>
</tr>
</tbody>
</table>
Selecting the Ports for the Test

This section explains how to select the ports for the Error Filtering test. Before you begin this procedure, make sure you have already set up the SmartCards/modules and have defined the frame setup and any optional settings (see Chapter 5, “General Test Setup”).

To select the ports for the Error Filtering test, follow these steps:

1. In the main window, click on the Test Setup tab.
2. Using the Test Type pull-down menu, select Error Filtering.
3. In the Traffic Distribution pane (see Figure 10-2), set up a port pair by selecting one transmitter and one receiver port. AST II automatically highlights the ports (in gray) to make it easier for you to identify the ports that are available. You do not have to select the highlighted ports.
4. Click the right arrow button to move the port pair to the Port Pairs pane.

**Note:** If this arrow is not available, it means the selection of ports is not valid. Check your selections and reselect the ports.
5. *(Optional)* Repeat Step 3 and Step 4 to set up additional port pairs.

![Figure 10-2. Traffic Distribution Pane (Error Filtering Test)](image-url)
Configuring Test Parameters

This section explains how to configure the test parameters for the Error Filtering test. Before you begin this procedure make sure you have already completed the general test setup, including selecting the ports (see “Selecting the Ports for the Test” on page 186).

See Table 10-3 on page 188 for descriptions of the test parameters.

**Note:** If you already have a configuration file for this test, you can open it and quickly configure the test (includes card setup, test options, frame setup, and test parameters).

To configure the Error Filtering test parameters, follow these steps:

1. In the main window, make sure that the **Test Setup** tab is selected. The selected **Test Type** should be **Error Filtering** as shown in **Figure 10-3**.

![Figure 10-3. Test Setup Tab (Error Filtering Test)](image)

2. In the **Test pane**, enter the number of seconds you want each iteration to run in the **Seconds** text entry field.

3. In the **Number of Trials** field, enter the number of trials you want for the test.

4. In the **Addresses pane**, do one of the following:
   - Check the **Random** checkbox to randomly assign addresses to each port.
   - Use the **Addresses Per Port** arrows to specify the number of address you want assigned to each port.

5. In the **Errors pane**, select the error type(s) for the test. The error type(s) you can test vary depending on the type of interface (see Table 10-2 on page 183 for details). You have the option of specifying more than one error type. If you select more than one type, the test repeats for each error type you select (this has no affect on your **Number**
of Trials setting). For example, if you select Undersize and Oversize, the test repeats twice.

6 In the Frame Size pane, select the desired Frame Size values for the test. This only applies when you are testing CRC, Dribble Bit, or Alignment error types. See Table 10-3 on page 188 for more details on the frame sizes used for other tests.

7 In the Burst Size pane, select the desired Burst Size values for the test.

8 In the Load pane, select the desired Load values for the test.

You are now ready to run the test. If you did not use an existing configuration file to configure the test parameters, you can save the current configuration to a file by choosing the File > Save As option. This allows you to use the file to quickly configure the test at a later time.

See “Running the Test” on page 191 for information on running the test.

Table 10-3. Error Filtering Test Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration</td>
<td>Default is 10 Seconds.</td>
</tr>
<tr>
<td></td>
<td>Allows you to specify the length of each iteration of the test (in seconds).</td>
</tr>
<tr>
<td></td>
<td>Enter the desired amount of time (in seconds).</td>
</tr>
<tr>
<td>Number of Trials</td>
<td>Default is 1.</td>
</tr>
<tr>
<td></td>
<td>Allows you to specify the number of trials for the test. For a definition</td>
</tr>
<tr>
<td></td>
<td>of trial, see Table 2-1 on page 14.</td>
</tr>
<tr>
<td>Addresses</td>
<td>Default is Addresses per port with a value of 1.</td>
</tr>
<tr>
<td></td>
<td>Allows you to specify the number of addresses you want to assign to each</td>
</tr>
<tr>
<td></td>
<td>transmitting port in the test. The options are:</td>
</tr>
<tr>
<td></td>
<td>• Random. Addresses are assigned to the ports in the test randomly.</td>
</tr>
<tr>
<td></td>
<td>• Addresses per port. Each port is assigned the same number of addresses.</td>
</tr>
<tr>
<td></td>
<td>Enter the number of addresses you want.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Only single addresses (one address per port) are used for this</td>
</tr>
<tr>
<td></td>
<td>test. You cannot select more than one address per port for this test.</td>
</tr>
</tbody>
</table>
Chapter 10: Error Filtering Test

Configuring Test Parameters

Errors

Allows you to select the error type(s) you want to simulate for the test. The options are:

<table>
<thead>
<tr>
<th>Type</th>
<th>Pass Criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oversize</td>
<td>Frames greater than the specified Oversize value are not forwarded by the DUT/SUT.</td>
</tr>
<tr>
<td>Undersize</td>
<td>Frames less than the specified Undersize value are not forwarded by the DUT/SUT.</td>
</tr>
<tr>
<td>CRC errors</td>
<td>CRC errored frames are not forwarded by the DUT/SUT.</td>
</tr>
<tr>
<td>Dribble Bit</td>
<td>Dribble bit errored frames are corrected and forwarded by the DUT/SUT.</td>
</tr>
<tr>
<td>Alignment</td>
<td>Alignment errored frames are not forwarded by the DUT/SUT.</td>
</tr>
</tbody>
</table>

Frame Size

Allows you to specify an appropriate frame size for the duration of the test based for each of the error type(s) you are testing. The Oversize option also enables you to specify a frame size based on what the DUT considers to be an oversized frame (some DUTs consider 1519 bytes frames to be oversized, and some do not).

The three options are:

- **Size.** This value determines the frame size for the duration of the test for the CRC, Dribble Bit, and Alignment error types. The default is 64 bytes.
- **Oversize.** This value determines the frame size for the duration of the test for the Oversize error type. The default is 1523 bytes.
- **Undersize.** This value determines the frame size for the duration of the test for the Undersize error type. The default is 63 bytes.

Burst Size

Default is 1.

Allows you to set the burst size for the duration of the test. Enter the desired burst size.
Table 10-3. Error Filtering Test Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
</table>
| **Load**  | Allows you to set the load levels for the duration of the test. *Load* refers to the amount of utilization of the medium. The default values depend on your *Units* setting for *Load* in the *Options* tab. The *Load* default values are:  
  **Start 10 (Units = Percentage), 1000 (Units = Frames/Sec)**  
  **Step 10 (Units = Percentage), 1000 (Units = Frames/Sec)**  
  **Stop 100 (Units = Percentage), 8,000 (Units = Frames/Sec)**  
  The options are:  
  • **Start.** The load at the beginning of the test.  
  • **Step.** The amount the load increments from iteration to iteration.  
  • **Stop.** The largest load for the test. |
Running the Test

This section shows you how to start, stop, and pause (temporarily stop) the test. Pausing the test allows you to view the real-time data for the current iteration of the test using the Counters tab.

Starting The Test

Once you have completed the general test setup and configured the Error Filtering test parameters, you can start the test by doing one of the following:

- Click on the Error Filtering test button in the Shortcut bar.

- Click on the Run Current Test button in the toolbar.

- Choose Test > Run Current, or Test > Run > Error Filtering.

Once you start the test, the display of the main window changes to the Results display.

Stopping The Test

If you want to stop the test, do one of the following:

- Click on the Stop Test button in the toolbar.

- Choose Test > Stop.

Pausing The Test

If you want to pause (temporarily stop) the test, do one of the following:

- Click on the Pause Test button in the toolbar.

- Choose Test > Pause.

Note: To resume (restart) the test, choose Test > Resume or click on the Resume button.
Viewing Test Results

This section provides information on the test results data that is available for this test. As soon as you start the test, the main window changes from the Setup & Run display to the Results display. This display includes four tabs that you can use to select the test results information that you want to view.

For information on the test results data for a specific tab, see the following sections:

- Chart tab, see “Chart Tab” on page 193.
- Summary tab, see “Summary Tab” on page 194.
- Details tab, see “Details Tab” on page 195.
- Counters tab, see Appendix D, “Test Results Counters” for information and field descriptions. This tab is the same for all tests.
Chart Tab

The Chart tab displays results for Undersize or Oversize error types and for selected ports. Select the error type and ports you want to view by using the Chart Wizard (see “Using the Chart Wizard” on page 75). Results for all iterations of the test are displayed.

Note: To view test results for error types other than Undersize or Oversize, use the Details tab (see “Details Tab” on page 195).

The charts can also be exported as .jpg files or HTML files using the Results menu (see “Results Menu” on page 65). Results for all iterations of the test are displayed.

Figure 10-4 shows an example of the Chart tab. In this example, the selected error type is Oversize, and the selected Burst Size is one (1).
Summary Tab

The Summary tab (Figure 10-5) displays the exact same information as the Chart tab but in tabular format. The results are organized as follows:

- The different Load values of the test are displayed with each Load value in its own column.
- Each port is displayed in its own row.

The summary results can also be exported as .csv or HTML files using the Results menu (see “Results Menu” on page 65).

Figure 10-5 shows an example of the Summary tab. In this example, the selected error type is Oversize, and the selected Burst Size is one (1).

![Figure 10-5. Summary Tab (Error Filtering Test)](image)
Details Tab

The Details tab (Figure 10-6) displays detailed test results for each port pair for a single iteration and a selected error type in tabular format. The results for each port pair appears in its own row. You select the Load value and the error type you want to view using the Load% and Error pull-down menus near the top of the tab.

The detailed results can also be exported as .csv or HTML files using the Results menu (see “Results Menu” on page 65).

Figure 10-6 shows an example of the Details tab. In this example, the selected error type is Oversize, the selected Load is 10%, the selected Burst Size is one (1).

See Table 10-4 on page 196 below for descriptions of the Details tab fields.

![Figure 10-6. Details Tab (Error Filtering Test)]
Chapter 10: Error Filtering Test

Viewing Test Results

Table 10-4. Details Tab Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>The transmitting port.</td>
</tr>
<tr>
<td>Test Frames Transmitted</td>
<td>The number of test frames transmitted by this port. Each test frame contains a flag or ‘trigger’ that enables the receiving port to identify it as a test frame.</td>
</tr>
<tr>
<td>To</td>
<td>The receiving port.</td>
</tr>
<tr>
<td>Total Frames Received</td>
<td>The total number of frames received by this port (including test frames and non-test frames). This total is the sum of Test Frames Received and Other Frames Received.</td>
</tr>
<tr>
<td>Test Frames Received</td>
<td>The number of test frames received by this port. If any test frames were dropped, this total will be less than the Test Frames Expected for this port.</td>
</tr>
<tr>
<td>Test Status</td>
<td>Indicates whether the port passed or failed based on the selected error type.</td>
</tr>
<tr>
<td></td>
<td>0 = FAIL (error filtering was unsuccessful).</td>
</tr>
<tr>
<td></td>
<td>1 = PASS (successful error filtering).</td>
</tr>
</tbody>
</table>

Counters Tab

The Counters tab displays the same test results data for all AST II tests. For a list and descriptions of the various counters, see Appendix D, “Test Results Counters.”
Chapter 11
Broadcast Forwarding Test

This chapter describes the AST II Broadcast Forwarding test.

In this chapter...
This chapter covers the following topics:

- About the Broadcast Forwarding Test . . . . 198
- Test Overview . . . . 199
- Test Methodology . . . . 201
- Selecting the Ports for the Test . . . . 202
- Configuring Test Parameters . . . . 204
- Running the Test . . . . 208
- Viewing Test Results . . . . 209
About the Broadcast Forwarding Test

The Broadcast Forwarding test allows you to test the broadcast forwarding performance of the DUT/SUT. This test allows you to measure the throughput and frame loss of the DUT/SUT for broadcast traffic patterns (one-to-many and many-to-many).

The following sections provide information about this test, including:

- What this test allows you to measure (see below).
- What this test allows you to determine (see below).
- A diagram of the available traffic distribution patterns (see page 199).
- The methodology of the Broadcast Forwarding test (see page 201).
- How to configure test parameters (see page 204).
- How to run the test (see page 208).
- How to view test results (see page 209).

What this Test Allows You to Measure

Table 11-1 below lists the key measurements for the Broadcast Forwarding test based on the test mode you select (Profile or Search).

Table 11-1. Broadcast Forwarding Test Measurements

<table>
<thead>
<tr>
<th>Test Mode</th>
<th>Measurements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile</td>
<td>Frame Loss: The amount of lost (dropped) frames at a given Load.</td>
</tr>
<tr>
<td>Search</td>
<td>Throughput: The maximum rate at which the DUT/SUT can forward traffic with no frame loss, or at the specified Acceptable Frame Loss. Frame Loss: The amount of lost (dropped) frames at a given Load.</td>
</tr>
</tbody>
</table>

What this Test Allows You to Determine

By allowing you to vary the Load, Frame Size, and Burst Size independently, as well as select the desired test mode (Profile or Search), the Broadcast Forwarding test can help you determine the following for one-to-many and many-to-many traffic distributions:

- The amount of frame loss at a given Load, Frame Size, and Burst Size combination.
- How increases in Load affect the DUT/SUT’s frame loss when forwarding broadcast traffic at a given Frame Size and Burst Size combination.
- How increases in Burst Size affect the DUT/SUT’s frame loss when forwarding broadcast traffic at a given Frame Size.
Chapter 11: Broadcast Forwarding Test

Test Overview

This section provides information on the basic configuration of the Broadcast Forwarding test, including:

- The supported traffic distribution patterns (see “Supported Traffic Distributions”).
- Basic traffic flow (see “Traffic Flow” on page 200).

For information on the test methodology, see “Test Methodology” on page 201.

Supported Traffic Distributions

*Figure 11-1* shows the supported traffic distribution patterns for this test (the traffic direction for this test is always unidirectional). You specify the desired traffic distribution (one-to-many or many-to-many), when you select the transmitting (Broadcast Sources) and receiving ports (Broadcast Receivers) in the Test Setup tab (see “Selecting the Ports for the Test” on page 202 for details).

<table>
<thead>
<tr>
<th>Option 1: One-to-many, unidirectional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Broadcast Source</td>
</tr>
<tr>
<td>Port 1</td>
</tr>
<tr>
<td>Port 2</td>
</tr>
<tr>
<td>Port 3</td>
</tr>
<tr>
<td>Port 4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option 2: Many-to-many, unidirectional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Broadcast Source</td>
</tr>
<tr>
<td>Port 1</td>
</tr>
<tr>
<td>Port 2</td>
</tr>
<tr>
<td>Port 3</td>
</tr>
<tr>
<td>Port 4</td>
</tr>
<tr>
<td>Port 5</td>
</tr>
</tbody>
</table>

*Figure 11-1*. Supported Traffic Distributions

- How increases in *Frame Size* affect the DUT/SUT’s frame loss when forwarding broadcast traffic.
- The DUT/SUT’s throughput (see *Table 11-1 on page 198*).

**Note:** Although this test does not allow you to measure the latency of the DUT/SUT when forwarding broadcast traffic, you can do so by using the Broadcast Latency test (see Chapter 12, “Broadcast Latency Test”).
Traffic Flow

Traffic is transmitted the same way for both one-to-many and many-to-many traffic distributions. Each transmitting port (Broadcast Source port) begins transmitting traffic at the same time, and transmits traffic to the same set of destination ports (Broadcast Receiver ports) based on the destination port addresses. Each transmitting port also transmits traffic to all of its receiving ports simultaneously.

The following tables show the traffic flow using the configurations shown in Figure 11-1 on page 199.

**One-to-Many:**

<table>
<thead>
<tr>
<th>Broadcast Source Port</th>
<th>Broadcast Receiver Ports (simultaneous transmission)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port #1</td>
<td>2 3 4</td>
</tr>
</tbody>
</table>

**Many-to-Many:**

<table>
<thead>
<tr>
<th>Broadcast Source Port</th>
<th>Broadcast Receiver Ports (simultaneous transmission)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port #1</td>
<td>3 4 5</td>
</tr>
<tr>
<td>Port #2</td>
<td>3 4 5</td>
</tr>
</tbody>
</table>
Chapter 11: Broadcast Forwarding Test

Test Methodology

The steps below describe what occurs during each iteration of the Broadcast Forwarding test in both Profile and Search mode.

For information on:

- How the test progresses from iteration to iteration in Profile mode, see “Profile Mode (Duration set to Seconds)” on page 25 and “Profile Mode (Duration set to Continuous)” on page 27.
- How the test progresses from iteration to iteration in Search mode, see “Search” on page 18.
- The algorithms used to determine the selected test measurement (such as throughput) in Search mode, see Appendix A, “Search Algorithms.”

During each iteration of the Broadcast Forwarding test, the following steps occur:

1. VFDs are set for all ports based on port addresses.
2. Trigger 1 is set to match frames with correct destination address.
3. For the specified Frame Size, the following are set:
   - Frame data length.
   - Background pattern, including unique signature.
   - Trigger 2 based on signature location.
4. The Burst Size is set to the specified value.
5. The IBG (interburst gap) is calculated for the intended load (the specified Load value). See “Calculating the InterBurst Gap (IBG)” on page 252 for details on how the IBG is calculated.
6. Load is set to the specified Load value.
7. Timed transmission is started on all transmitting ports at the specified Start values for Load, Burst Size, and Frame Size. See “Calculating the Transmit Time” on page 253 for the formula used to calculate the transmission time.
8. Wait for the specified Duration (the Duration defines the length of each iteration). The port counters are updated continually during each iteration.

Note: If you set the Duration option to Continuous, the test continues until you manually stop it.

9. When the receive trigger rate on receiving port(s) becomes 0, the elapsed time is determined from the chassis.
10. Port counters are gathered.
11. Frame loss is determined.
12. Results are displayed.
Selecting the Ports for the Test

This section explains how to select the ports for the Broadcast Forwarding test. Before you begin this procedure, make sure you have already set up the SmartCards/modules and have defined the frame setup and any optional settings (see Chapter 5, “General Test Setup”).

To select the ports for the Broadcast Forwarding test, follow these steps:

1. In the main window, click on the Test Setup tab.
2. Using the Test Type pull-down menu, select Broadcast Forwarding (Figure 11-2).

![Figure 11-2. Test Setup Tab (Broadcast Forwarding Test)](image)

3. In the Traffic Distribution pane of the window (Figure 11-3), select the transmitting ports in the Broadcast Sources section, and select the receiving ports in the Broadcast Receivers section.

   In this example, there is one transmitting port and there are three receiving ports. You can select a number of transmitting ports and receiving ports.
Note: See “Supported Traffic Distributions” on page 199 for details on the supported traffic distribution options.

Figure 11-3. Traffic Distribution Pane (Broadcast Forwarding Test)

4 (Optional) Set up a monitor port if you want to monitor the traffic from the DUT/SUT. See Table 2-1 on page 14 for a description of monitor ports. Also, make sure you have configured the DUT/SUT so that it copies all of the frames it transmits to the monitor port.

Note: See “Traffic Flow” on page 200 for details on how the traffic is transmitted.
Chapter 11: Broadcast Forwarding Test

Configuring Test Parameters

This section explains how to configure the test parameters for the Broadcast Forwarding test. Before you begin this procedure, make sure you have already completed the general test setup, including selecting the ports (see “Selecting the Ports for the Test” on page 202).

See Table 11-2 on page 205 for descriptions of the test parameters.

Note: If you already have a configuration file for this test, you can open it and quickly configure the test (includes card setup, test options, frame setup, and test parameters).

To configure the Broadcast Forwarding test parameters, follow these steps:

1. In the main window, make sure that the Test Setup tab is selected. The selected Test Type should be Broadcast Forwarding, as shown in Figure 11-4.

2. In the Test pane, click on one of the following radio buttons to select the desired Duration option:
   - Seconds (enter the number of seconds you want each iteration to run).
   - Continuous (the test runs continuously until you stop it by clicking on the Stop button or choosing Test > Stop).

3. In the Number of Trials text entry field, enter the number of trials you want for the test.

4. In the Measurement pane, do one of the following:
   - Select Profile to run the test in Profile mode.
   - Select Search to run the test in Search mode.

5. In the Frame Size pane, select the desired Frame Size values for the test.
6 In the Burst Size pane, select the desired Burst Size values for the test.

7 In the Load pane, select the desired Load values for the test (the names of the options are different depending on test mode you selected).

You are now ready to run the test. If you did not use an existing configuration file to configure the test parameters, you can save the current configuration to a file by choosing the File > Save As option. This allows you to use the file to quickly configure the test at a later time.

See “Running the Test” on page 208 for information on running the test and “Viewing Test Results” on page 209 for information on test results.

### Table 11-2. Broadcast Forwarding Test Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Duration</strong></td>
<td>Default is <strong>10 seconds</strong>. Allows you to specify whether you want the iterations of the test to run for a specified amount of time, or to run continuously until you manually stop the test. The options are:</td>
<td><strong>Profile and Search</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Seconds.</strong> The iterations of the test run for the amount of time you specify. Enter the desired amount of time (in seconds).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>Continuous.</strong> The test runs continuously until you manually stop it (to stop the test, click the Stop button or choose Test &gt; Stop). This option is not available when the test mode is set to Search. The Frame Size, Burst Size, and Load parameter values do not vary during the test (the values used are the specified Start values that remain constant throughout the test). This option is useful if you want to test how the DUT/SUT handles traffic when the Frame Size, Burst Size, and Load are constant.</td>
<td></td>
</tr>
<tr>
<td><strong>Number of Trials</strong></td>
<td>Default is <strong>1.</strong> Allows you to specify the number of trials for the test. For a definition of trial, see Table 2-1 on page 14.</td>
<td><strong>Profile and Search</strong></td>
</tr>
<tr>
<td><strong>Measurement</strong></td>
<td>Default is <strong>Profile.</strong> Allows you to specify the test mode you want to use. The options are:</td>
<td><strong>N/A</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Profile.</strong> Provides an overall view of the DUT/SUT’s broadcast forwarding performance.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>Search.</strong> Provides a more detailed analysis of the DUT/SUT’s broadcast forwarding performance than Profile mode. A binary algorithm is used to determine throughput and frame loss.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>See “Profile Mode (Duration set to Seconds)” on page 25 and “Search” on page 18 for more information.</td>
<td></td>
</tr>
</tbody>
</table>
### Frame Size

Default is **64 bytes** for **Start** and **Step**, and **1518 for Stop**.

Allows you to set the **Frames sizes** throughout the test for both **Profile** and **Search** mode. The options are:

- **Start.** The **Frame size** at the beginning of the test.
- **Step.** The amount the **Frame size** increments from iteration to iteration.
- **Stop.** The largest **Frame size** for the test.
- **Custom.** Allows you to specify custom frame sizes for the test. See "Using Custom Frame Sizes for the Test" on page 104 for details.

### Burst Size

Default is **1** for all options.

Allows you to set the **Burst sizes** throughout the test for both **Profile** and **Search** mode. The options are:

- **Start.** The **Burst size** at the beginning of the test.
- **Step.** The amount the **Burst size** increments from iteration to iteration.
- **Stop.** The largest **Burst size** for the test.
- **Custom.** Allows you to specify custom burst sizes for the test. See "Using Custom Burst Sizes for the Test" on page 105 for details.
Table 11-2. Broadcast Forwarding Test Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load</td>
<td>Allows you to set the load levels for the duration of the test. Load is the amount of utilization of the medium. The options vary, depending on the test mode that you select (Profile or Search). The default values depend on your Units setting for Load in the Options tab. The Load default values are:</td>
<td>Profile and Search</td>
</tr>
<tr>
<td>Profile.</td>
<td>Start 10 (Units = Percentage), 1000 (Units = Frames/Sec)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Step 10 (Units = Percentage), 1000 (Units = Frames/Sec)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Stop 100 (Units = Percentage), 8000 (Units = Frames/Sec)</td>
<td></td>
</tr>
<tr>
<td>Search.</td>
<td>Initial 10 (Units = Percentage), 1000 (Units = Frames/Sec)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Min 10 (Units = Percentage), 1000 (Units = Frames/Sec)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Max 100 (Units = Percentage), 8000 (Units = Frames/Sec)</td>
<td></td>
</tr>
<tr>
<td>Profile:</td>
<td>The options are:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Start. The Load at the beginning of the test.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Step. The amount the Load increments from iteration to iteration.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Stop. The largest Load for the test.</td>
<td></td>
</tr>
<tr>
<td>Search:</td>
<td>The options are:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Initial. The Load at the beginning of the test.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Min. The minimum allowable Load value for the test. If this value is reached, the test stops.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Max. The maximum allowable Load value for the test. If this value is reached, the test stops.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Resolution. Default is 1 (Units = Percentage), 100 (Units = Frames/Sec)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The finest adjustment possible for the Load from iteration to iteration. If the required adjustment to the current Load for the next iteration is less than the Resolution, the trial stops. See “Resolution” on page 18 for details and an example.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Backoff Rate. Default is 0.5.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The rate the Load decreases after the DUT fails (frame loss exceeds the specified Acceptable Frame Loss value) at the current Load. Enter an integer or decimal value. The minimum value you can enter is 0.01. See “Backoff Rate” on page 14 for the formula used to calculate the actual amount of the decrease in Load.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Acceptable Frame Loss. Default is 1000.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The number of frames that can be lost without frame loss being declared.</td>
<td></td>
</tr>
</tbody>
</table>
Running the Test

This section shows you how to start, stop, and pause (temporarily stop) the test. Normally, you stop the test if you set Duration to Continuous (the test runs until you manually stop it). Pausing the test allows you to view the real-time data for the current iteration of the test using the Counters tab.

Starting The Test

Once you have completed the general test setup and configured the Broadcast Forwarding test parameters, you can start the test by doing one of the following:

- Click on the Broadcast Forwarding test button in the Shortcut bar.

![Broadcast Forwarding]

- Click on the Run Current Test button in the toolbar.

- Choose Test > Run Current, or Test > Run > Broadcast Forwarding.

Once you start the test, the display of the main window changes to the Results display.

Stopping The Test

If you want to stop the test, do one of the following:

- Click on the Stop Test button in the toolbar.

![Stop]

- Choose Test > Stop.

Pausing The Test

If you want to pause (temporarily stop) the test, do one of the following:

- Click on the Pause Test button in the toolbar.

![Pause]

- Choose Test > Pause.

**Note:** To resume (restart) the test, choose Test > Resume or click on the Resume button.
Viewing Test Results

This section provides information on the test results data that is available for this test.

As soon as you start the test, the main window changes from the Setup & Run display to the Results display. This display includes four tabs that you can use to select the test results information you want to view.

For information on the test results data for a specific tab, see the following sections:

- Chart tab, see “Chart Tab” on page 210.
- Summary tab, see “Summary Tab” on page 211.
- Details tab, see “Details Tab” on page 212.
- Counters tab, see Appendix D, “Test Results Counters” for information and field descriptions. This tab is the same for all tests.
Chapter 11: Broadcast Forwarding Test

Viewing Test Results

Chart Tab

The Chart tab (Figure 11-5) displays results for selected ports and selected Frame Size and Burst Size values. Select the ports that you want to view by using the Chart Wizard (see “Using the Chart Wizard” on page 75). Select the Frame Size and Burst Size values that you want to view by using the Frame Size and Burst Size pull-down menus. Results for all iterations of the test are displayed.

The charts can also be exported as .jpg files or HTML files by using the Results menu (see “Results Menu” on page 65).

Figure 11-5 shows an example of the Chart tab. In this example, the selected test parameter values are 128 for Frame Size, and 50 for Burst Size.
Summary Tab

The Summary tab (Figure 11-6) displays the exact same information as the Chart tab but in tabular format. Like the Chart tab, the Summary tab allows you to select the Frame Size and Burst Size values that you want to view by using the Frame Size and Burst Size pull-down menus. The results are organized as follows:

- The different Load values of the test are displayed with each Load value in its own column.
- Each port is displayed in its own row.

The summary results can also be exported as .csv or HTML files by using the Results menu (see “Results Menu” on page 65).

Figure 11-6 shows an example of the Summary tab. In this example, the selected test parameter values are 128 for Frame Size, and 50 for Burst Size.

![Figure 11-6. Summary Tab](image-url)
Details Tab

The Details tab (Figure 11-7) displays detailed test for all ports for a single iteration in tabular format. You can select the Frame Size, Burst Size and Load values for the iteration you want to view by using the Frame Size, Burst Size, and Load pull-down menus. If you set up a monitor port for the test, this tab displays test results for that port.

The detailed results can also be exported as .csv or HTML files by using the Results menu (see “Results Menu” on page 65).

Figure 11-7 shows an example of the Details tab. In this example, the selected test Load value is 10%, Frame Size is 128, and Burst Size is 50.

See Table 11-3 on page 213 for descriptions of the Details tab fields.

Figure 11-7. Details Tab
### Table 11-3. Details Tab Field Descriptions

<table>
<thead>
<tr>
<th>Field (Broadcast Source Port)</th>
<th>Description (Broadcast Source Port)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Name</td>
<td>The name of the Broadcast Source port.</td>
</tr>
<tr>
<td>Test Frames Transmitted</td>
<td>The number of test frames transmitted by this Broadcast Source port. Each test frame contains a flag or ‘trigger’ that enables the receiving port to identify it as a test frame.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field (Broadcast Receiver Ports)</th>
<th>Description (Broadcast Receiver Ports)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Name</td>
<td>The name of the Broadcast Receiver port.</td>
</tr>
<tr>
<td>Test Frames Expected</td>
<td>The number of test frames this Broadcast Receiver port expects to receive. This number is calculated by totaling all of the test frames that are destined for this port.</td>
</tr>
<tr>
<td>Total Frames Received</td>
<td>The total number of frames received by this Broadcast Receiver port (including test frames and non-test frames). This total is the sum of Test Frames Received and Other Frames Received.</td>
</tr>
<tr>
<td>Test Frames Received</td>
<td>The number of test frames received by this Broadcast Receiver port. If any test frames were dropped, this total will be less than the Test Frames Expected for this port.</td>
</tr>
<tr>
<td>Test Frames Lost</td>
<td>The number of test frames destined for this Broadcast Receiver port that were not received (frame loss). This is the difference between the Test Frames Expected and Test Frames Received.</td>
</tr>
<tr>
<td>Other Frames Received</td>
<td>The number of frames that were incorrectly received by this Broadcast Receiver port, or frames that were not part of the test (non-test frames). This is the difference between the Total Frames Received and Test Frames Received.</td>
</tr>
</tbody>
</table>
Counters Tab

The *Counters* tab displays the same test results data for all AST II tests. For a list and descriptions of the various counters, see *Appendix D, “Test Results Counters.”*
Chapter 12

Broadcast Latency Test

This chapter describes the AST II Broadcast Latency test.

In this chapter...

This chapter covers the following topics:

- About the Broadcast Latency Test . . . . 216
- Test Overview . . . . 217
- Test Methodology . . . . 218
- Selecting the Ports for the Test . . . . 219
- Configuring Test Parameters . . . . 221
- Running the Test . . . . 223
- Viewing Test Results . . . . 224
About the Broadcast Latency Test

The Broadcast Latency test allows you to determine the latency of the DUT/SUT when forwarding broadcast traffic. This test uses a one-to-many traffic pattern and the latency is measured for each receiving port of the DUT/SUT in the test. The Broadcast Latency test is run in Profile mode (you do not have to select the mode).

This chapter provides the following information about the Broadcast Latency test:

- What this test allows you to measure (see below).
- What this test allows you to determine (see below).
- A diagram of the available traffic distribution patterns (see page 217).
- The methodology of the Broadcast Latency test (see page 218).
- How to configure test parameters (see page 221).
- How to run the test (see page 223).
- How to view test results (see page 224).

What this Test Allows You to Measure

The Broadcast Latency test allows you to measure the latency (in milliseconds) of each receiving port of DUT/SUT in the test. The latency measurement is the delay that occurs from when the DUT/SUT receives the frame to when it forwards the frame.

What this Test Allows You to Determine

By allowing you to vary the Frame Size, the Broadcast Latency test can help you determine the following for one-to-many traffic distributions.

- The latency (in milliseconds) for each receiving port of the DUT/SUT at a given Frame Size.
- The combined latency (in milliseconds) for all receiving ports of the DUT/SUT at a given Frame Size.
- How increases in Frame Size affect the DUT/SUT’s combined latency (all receiving ports), on a port-by-port basis.

Note: If you want to test the overall broadcast forwarding performance of the DUT/SUT, you can do so using the Broadcast Forwarding test (see Chapter 11, “Broadcast Forwarding Test”).
Test Overview

This section provides information on the basic configuration of the Broadcast Latency test, including:

- The supported traffic distribution patterns (see “Supported Traffic Distributions”).
- Basic traffic flow (see “Traffic Flow”).

For information on the test methodology, see “Test Methodology” on page 218.

Supported Traffic Distributions

*Figure 12-1* shows the supported traffic distribution pattern for this test (the traffic direction for this test is always unidirectional). You select the desired traffic when you select the Broadcast Source (transmitting) port and the Broadcast Receiver (receiving) ports for the test in the Test Setup tab.

![Figure 12-1. Supported Traffic Distributions](image)

Traffic Flow

The Broadcast Source transmitting port transmits a single test frame to each of the Broadcast Receiving ports in sequence.

<table>
<thead>
<tr>
<th>Broadcast Source Port</th>
<th>Broadcast Receiver Ports (order of transmission)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port #1</td>
<td>2 3 4</td>
</tr>
</tbody>
</table>
Test Methodology

This section describes what occurs during each iteration of the Broadcast Latency test. This test is run automatically in Profile mode (you do not need to select the mode).

**Note:** Since single frames are transmitted during each iteration of the test, you do not need to specify the length of the iterations.

**During each iteration of the Broadcast Latency test, the following steps are executed:**

1. VFDs are set for all ports based on port addresses.
2. Trigger 1 is set to match frames with correct destination address.
3. For the specified Frame Size, the following are set:
   - Frame data length.
   - Background pattern including unique signature.
   - Trigger 2 based on signature location.
4. The latency measurement is set up.
5. A single test frame is transmitted from the Broadcast Source transmitting port to the specified Broadcast Receiving ports.
6. The latency is measured for each receiving port of the DUT/SUT in the test. The latency measurement is the difference in time (delay) between when the DUT/SUT receives the frame, and when it forwards the frame.
7. Results are displayed.
Selecting the Ports for the Test

This section explains how to select the ports for the Broadcast Latency test. Before you begin this procedure, make sure you have already set up the SmartCards/modules and have defined the frame setup and any optional settings (see Chapter 5, “General Test Setup”).

To select the ports for the Broadcast Latency test, follow these steps:

1. In the main window, click on the Test Setup tab.
2. Using the Test Type pull-down menu, select Broadcast Latency (Figure 12-2).

Choose Broadcast Latency here.

3. In the Traffic Distribution pane of the window, select the transmitting port using the Broadcast Sources pull-down menu, and select the receiving ports in the Broadcast Receivers area. In the example shown in Figure 12-3 on page 220, three receiving ports have been selected.
Chapter 12: Broadcast Latency Test

Selecting the Ports for the Test

Figure 12-3. Traffic Distribution Pane (Broadcast Latency Test)

Note: See “Traffic Flow” on page 217 for details on how the traffic is transmitted.
Configuring Test Parameters

This section explains how to configure test parameters for the Broadcast Latency test. Before you begin this procedure make sure you have already completed the general test setup, including selecting the ports (see “Selecting the Ports for the Test” on page 219). See Table 12-1 on page 222 for descriptions of the test parameters.

**Note:** If you already have a configuration file for this test, you can open it to quickly configure the test (includes card setup, test options, frame setup, and test parameters).

To configure the Broadcast Latency test parameters, follow these steps:

1. In the main window, make sure the **Test Setup** tab is selected. The selected **Test Type** should be **Broadcast Latency**, as shown in Figure 12-4.

![Figure 12-4. Test Setup Tab (Broadcast Latency Test)](image)

2. In the **Number of Trials** field, enter the number of trials you want for the test.
3. In the **Frame Size** pane, select the desired frame size values for the test.

You are now ready to run the test. If you did not use an existing configuration file to configure the test parameters, you can save the current configuration to a file by choosing **File > Save As** option. This allows you to use the file to quickly configure the test at a later time.

See “Running the Test” on page 223 for information on running the test and “Viewing Test Results” on page 224 for a recommended testing procedure.
### Table 12-1. Broadcast Latency Test Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Trials</td>
<td>Default is 1. Allows you to specify the number of trials for the test. For a definition of trial, see <em>Table 2-1 on page 14.</em></td>
</tr>
</tbody>
</table>
| Frame Size      | Default is 64 bytes for **Start and Step**, and 1518 for **Stop**. Allows you to set the Frames sizes throughout the test for both Profile and Search mode. The options are:  
  - **Start.** The Frame size at the beginning of the test.  
  - **Step.** The amount the Frame size increments from iteration to iteration.  
  - **Stop.** The largest Frame size for the test.  
  - **Custom.** Allows you to specify custom frame sizes for the test. See “Using Custom Frame Sizes for the Test” on page 104 for details. |
Chapter 12: Broadcast Latency Test

Running the Test

This section shows you how to start, stop, and pause (temporarily stop) the test. Pausing the test allows you to view the real-time data for the current iteration of the test using the Counters tab.

Starting The Test

Once you have completed the general test setup and configured the Broadcast Latency test parameters, you can start the test by doing one of the following:

- Click on the Broadcast Latency test button in the Shortcut bar.
- Click on the Run Current Test button in the toolbar.
- Choose Test > Run Current, or Test > Run > Broadcast Latency.

Once you start the test, the display of the main window changes to the Results display.

Stopping The Test

If you want to stop the test, do one of the following:

- Click on the Stop Test button in the toolbar.
- Choose Test > Stop.

Pausing The Test

If you want to pause (temporarily stop) the test, do one of the following:

- Click on the Pause Test button in the toolbar.
- Choose Test > Pause.

Note: To resume (restart) the test, choose Test > Resume or click on the Resume button.
Viewing Test Results

This section provides information on the test results data that is available for this test. As soon as you start the test, the main window changes from the Setup & Run display to the Results display. This display includes four tabs that you can use to select the test results information you want to view.

For information on the test results data for a specific tab, see the following sections:

- **Chart tab**, see “Chart Tab” on page 225.
- **Summary tab**, see “Summary Tab” on page 226.
- **Details tab**, see “Details Tab” on page 227.
- **Counters tab**, see Appendix D, “Test Results Counters” for information and field descriptions. This tab is the same for all tests.
Chart Tab

The Chart tab (Figure 12-5) displays the latency results (in microseconds) for selected Frame Size and Burst Size values for all ports in the test. Select the Frame Size and Burst Size values that you want to view by sing the Frame Size and Burst Size pull-down menus.

Note: Do not use the Chart Wizard to specify the test results you want displayed for this test.

The charts can also be exported as .jpg files or HTML files using the Results menu (see “Results Menu” on page 65).

Figure 12-5 shows an example of the Chart tab. In this example, the selected test parameter values are 128 for Frame Size, and one (1) for Burst Size.

Figure 12-5. Chart Tab
Summary Tab

The Summary tab (Figure 12-6) displays the exact same latency results as the Chart tab but in tabular format. Like the Chart tab, the Summary tab allows you to select the Frame Size and Burst Size values that you want to view by using the Frame Size and Burst Size pull-down menus.

The summary results can also be exported as .csv or HTML files using the Results menu (see “Results Menu” on page 65).

Figure 12-6 shows an example of the Summary tab. In this example, the selected test parameter values are 128 for Frame Size, and one (1) for Burst Size.

![Figure 12-6. Summary Tab](image)
Details Tab

The Details tab (Figure 12-7) displays latency results for a selected Frame Size in tabular format. You can select the Frame Size by using the Frame Size pull-down menu.

The detailed results can also be exported as .csv or HTML files using the Results menu (see “Results Menu” on page 65).

Figure 12-7 shows an example of the Details tab. In this example, the selected Frame Size is 128.

![Figure 12-7. Details Tab](image)

Counters Tab

The Counters tab displays the same test results data for all AST II tests. For a list and descriptions of the various counters, see Appendix D, “Test Results Counters.”
Chapter 13
Forward Pressure Test

This chapter describes the AST II Forward Pressure test.

In this chapter...
This chapter covers the following topics:

• About the Forward Pressure Test . . . . 230
• Test Overview . . . . 232
• Test Methodology . . . . 233
• Selecting the Ports for the Test . . . . 234
• Configuring Test Parameters . . . . 236
• Running the Test . . . . 239
• Viewing Test Results . . . . 240
About the Forward Pressure Test

The Forward Pressure test allows you to determine how the DUT/SUT handles congestion. Specifically, this test allows you to determine if forward pressure exists when the receive ports of the DUT/SUT become congested. Forward pressure is when the DUT/SUT inhibits or aborts its back-off algorithms in an attempt to increase its forwarding performance under congested conditions.

The Forward Pressure test enables you to simulate congestion on specific receiving ports of the DUT/SUT to determine if forward pressure occurs.

Forward pressure is indicated if no frame loss occurs under congested conditions. If the DUT/SUT performs correctly when receiving traffic where the Interframe Gap is less than the legal limit, it will eventually run out of buffer space and start dropping frames. For tests with a short duration, the DUT/SUT may be able to buffer enough of the received frames and not drop frames. For this reason, it is advisable to run tests with sufficient duration (or continuously) to ensure that the buffer capacity of the DUT/SUT is exceeded.

The following sections provide information about this test, including:

- What this test allows you to measure (see below).
- What this test allows you to determine (see below).
- A diagram of the available traffic distribution patterns (see page 232).
- The methodology of the Forward Pressure test (see page 233).
- How to configure test parameters (see page 236).
- How to run the test (see page 239).
- How to view test results (see page 240).

What this Test Allows You to Measure

The Forward Pressure test measures frame loss in terms of the amount of lost (dropped) frames at a given frame size.

What this Test Allows You to Determine

By allowing you to vary the Frame Size and Burst Size, the Forward Pressure test can help you to determine the following:

- If forward pressure exists on the receiving ports (no frame loss occurs on the receiving port).
- How increases in Frame Size affect the frame loss of the ports in the test.
- How increases in Burst Size affect the frame loss of the ports in the test.
Note: Only cards that can transmit greater than wire rate can run the Forward Pressure test. Cards that cannot perform the test are not displayed in the Port Selection list so that they cannot be selected for the test. The following is the list of cards that can transmit greater than wire rate:

- GX-1405B/Bs
- GX-1420B
- ML-5710A
- ML-7710
- ML-7711/7711s
- SX-7210
- SX-7410B
- SX-7411
- LAN-3100A
- LAN-3101A/B
- LAN-3102A
- LAN-3111A/As
- LAN-3200A/As
Test Overview

This section provides information on the basic configuration of the Forward Pressure test, including:

- The supported traffic distribution patterns (see “Supported Traffic Distributions”).
- Basic traffic flow (see “Traffic Flow”).

For information on the test methodology, see “Test Methodology” on page 233.

Supported Traffic Distributions

*Figure 13-1* shows the supported traffic distribution patterns for this test (either a single port pair or multiple port pairs). The traffic direction for this test is always unidirectional. Select the desired traffic distribution when you select the transmitting (A) and receiving (B) ports for the test in the Test Setup tab.

![Figure 13-1. Supported Traffic Distributions](image)

Traffic Flow

Each transmitting port in each port pair that you set up transmits traffic to its paired receiving ports simultaneously. The following table shows how the transmitting ports transmit frames to the receiving ports using the configuration shown in *Figure 13-1*.

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Source Port</th>
<th>Destination Ports</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Port Pair</td>
<td>Port #1</td>
<td>2 only.</td>
</tr>
<tr>
<td>Multiple Port Pairs</td>
<td>Port #1</td>
<td>2 only.</td>
</tr>
<tr>
<td></td>
<td>Port #3</td>
<td>4 only.</td>
</tr>
</tbody>
</table>
Test Methodology

The steps listed below describe what occurs during each iteration of the Forward Pressure test. This test is run automatically in Profile mode (you do not need to select the mode).

For information on how the test progresses from iteration to iteration in Profile mode, see “Profile Mode (Duration set to Seconds)” on page 25 and “Profile Mode (Duration set to Continuous)” on page 27.

During each iteration of the Forward Pressure test, the following steps are executed:

1. VFDs are set for all ports based on port addresses.
2. Trigger 1 is set to match frames with correct destination address.
3. For the specified Frame Size, the following are set:
   - Frame data length
   - Background pattern including unique signature
   - Trigger 2 based on signature location
4. The Burst Size is set to 1.
5. The IBG (interburst gap) is calculated for the intended load (the specified Load value). See “Calculating the InterBurst Gap (IBG)” on page 252 for details on how the IBG is calculated.
6. Timed transmission is started on all transmitting ports at the specified Start values for Frame Size. See “Calculating the Transmit Time” on page 253 for the formula used to calculate the transmission time.
7. Wait for the specified Duration (the Duration defines the length of each iteration). The port counters are updated continually during each iteration.

Note: If you set the Duration option to Continuous, the test continues until you manually stop it.

8. When the receive trigger rate on receiving port(s) becomes 0, the elapsed time is determined from the chassis.
9. Port counters are gathered.
10. Frame loss is determined.
11. Results are displayed.
Selecting the Ports for the Test

This section explains how to select the ports for the Forward Pressure test. Before you begin this procedure, make sure you have already set up the SmartCards/modules and have defined the frame setup and any optional settings (see Chapter 5, “General Test Setup”).

To select the ports for the Forward Pressure test, follow these steps:

1. In the main window, click on the Test Setup tab.
2. Using the Test Type pull-down menu, select Forward Pressure (Figure 13-2).

Choose Forward Pressure here.

3. In the Traffic Distribution pane (Figure 13-3), set up a port pair by selecting one transmitter port (A list) and one receiver port (B list). AST II automatically highlights the ports (in gray) to make it easier for you to identify the ports that are available. You do not have to select the highlighted ports.

4. Click the right arrow to move the port pair to the Pairs pane.
Note: If this arrow is not available, it means the selection of ports is not valid. Check your selections and reselect the ports.

5  (Optional) Repeat Step 3 and Step 4 to set up additional port pairs.

Figure 13-3. Traffic Distribution Pane (Forward Pressure Test)

Note: See “Traffic Flow” on page 232 for details on how the traffic is transmitted.
Chapter 13: Forward Pressure Test
Configuring Test Parameters

Configuring Test Parameters

This section explains how to configure the test parameters for the Forward Pressure test. Before you begin this procedure make sure you have already completed the general test setup, including selecting the ports (see “Selecting the Ports for the Test” on page 234).

See Table 13-1 on page 237 for descriptions of the test parameters.

Note: If you already have a configuration file for this test, you can open it to quickly configure the test (includes card setup, test options, frame setup, and test parameters).

To configure the Forward Pressure test parameters, follow these steps:

1. In the main window, make sure that the Test Setup tab is selected. The Test Type should be set as Forward Pressure, as shown in Figure 13-4.

   ![Figure 13-4. Test Setup Tab (Forward Pressure Test)](image)

   **Figure 13-4. Test Setup Tab (Forward Pressure Test)**

2. In the Test pane, click on one of the following radio buttons to select the desired Duration option:
   - Seconds (enter the number of seconds you want each iteration to run).
   - Continuous (the test runs continuously until you stop it by clicking on the Stop button or choosing Test > Stop).

3. In the Number of Trials field, enter the number of trials you want for the test.

4. In the Addresses pane, do one of the following:
   - Check the Random checkbox to randomly assign addresses to each port.
   - Use the Addresses Per Port arrows to specify the number of address you want assigned to each port.

5. In the Frame Size pane, select the desired Frame Size values for the test.

   **Note:** The Burst Size is forced to 1 (you cannot modify the Burst Size field).
You are now ready to run the test. If you did not use an existing configuration file to configure the test parameters, you can save the current configuration to a file by choosing the **File > Save As** option. This allows you to use the file to quickly configure the test at a later time.

See “*Running the Test*” on page 239 for information on running the test.

**Table 13-1.** Forward Pressure Rate Test Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Duration</strong></td>
<td>Default is <strong>10 Seconds</strong>. Allows you to specify whether you want the iterations of the test to run for a specified amount of time, or to run continuously until you manually stop the test. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Seconds.</strong> The iterations of the test run for the amount of time you specify. Enter the desired amount of time (in seconds).</td>
</tr>
<tr>
<td></td>
<td>• <strong>Continuous.</strong> The test runs continuously until you manually stop it (to stop the test, click the <strong>Stop</strong> button or choose <strong>Test &gt; Stop</strong>).</td>
</tr>
<tr>
<td></td>
<td>The <strong>Frame Size</strong> parameter does not vary during the test (the value used is the specified <strong>Start</strong> value, which remains constant throughout the test). This option is useful if you want to test how the DUT/SUT handles traffic when the <strong>Frame Size</strong> is constant.</td>
</tr>
<tr>
<td><strong>Number of Trials</strong></td>
<td>Default is <strong>1</strong>. Allows you to specify the number of trials for the test. For a definition of <strong>trial</strong>, see <em>Table 2-1 on page 14</em>.</td>
</tr>
<tr>
<td><strong>Addresses</strong></td>
<td>Default is <strong>Addresses per port</strong> with a value of <strong>1</strong>. Allows you to specify the number of addresses you want to assign to each transmitting port in the test. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Random.</strong> Addresses are assigned to the ports in the test randomly.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Addresses per port.</strong> Each port is assigned the same number of addresses. Enter the number of addresses you want.</td>
</tr>
</tbody>
</table>
Table 13-1. Forward Pressure Rate Test Parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame Size</td>
<td>Default is 64 bytes for <strong>Start</strong> and <strong>Step</strong>, and 1518 for <strong>Stop</strong>.</td>
</tr>
<tr>
<td></td>
<td>Allows you to set the <strong>Frames sizes</strong> throughout the test. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Start.</strong> The Frame size at the beginning of the test.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Step.</strong> The amount the Frame size increments from iteration to iteration.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Stop.</strong> The largest Frame size for the test.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Custom.</strong> Allows you to specify custom frame sizes for the test.</td>
</tr>
<tr>
<td></td>
<td>See “Using Custom Frame Sizes for the Test” on page 104 for details.</td>
</tr>
<tr>
<td>Burst Size</td>
<td>The Burst Size is forced to 1 (you cannot set the Burst Size).</td>
</tr>
</tbody>
</table>
Running the Test

This section shows you how to start, stop, and pause (temporarily stop) the test. Normally, you stop the test if you set Duration to Continuous (the test runs until you manually stop it). Pausing the test allows you to view the real-time data for the current iteration of the test using the Counters tab.

Starting The Test

Once you have completed the general test setup and configured the Forward Pressure test parameters, you can start the test by doing one of the following:

- Click on the Forward Pressure test button in the Shortcut bar.

- Click on the Run Current Test button in the toolbar.

- Choose Test > Run Current, or Test > Run > Forward Pressure.

Once you start the test, the display of the main window changes to the Results display.

Stopping The Test

If you want to stop the test, do one of the following:

- Click on the Stop Test button in the toolbar.

- Choose Test > Stop.

Pausing The Test

If you want to pause (temporarily stop) the test, do one of the following:

- Click on the Pause Test button in the toolbar.

- Choose Test > Pause.

Note: To resume (restart) the test, choose Test > Resume or click on the Resume button.
Viewing Test Results

This section provides information on the test results data that is available for this test. As soon as you start the test, the main window changes from the Setup & Run display to the Results display. This display includes four tabs that you can use to select the test results information you want to view.

For information on the test results data for a specific tab, see the following sections:

- Chart tab, see “Chart Tab” on page 241.
- Summary tab, see “Summary Tab” on page 242.
- Details tab, see “Details Tab” on page 243.
- Counters tab, see Appendix D, “Test Results Counters” for information and field descriptions. This tab is the same for all tests.
Chart Tab

The Chart tab (Figure 13-5) displays Frame Loss Rate results for selected ports, and selected Frame Size and Burst Size values. Select the ports that you want to view by using the Chart Wizard (see “Using the Chart Wizard” on page 75). Select the Frame Size and Burst Size values that you want to view by using the Frame Size and Burst Size pull-down menus. Results for all iterations of the test are displayed.

The charts can also be exported as .jpg files or HTML files using the Results menu (see “Results Menu” on page 65).

Figure 13-5 shows an example of the Chart tab. In this example, the selected test parameter values are 128 for Frame Size, and one (1) for Burst Size.
Summary Tab

The Summary tab (Figure 13-6). This tab displays the exact same information as the Chart tab but in tabular format. Like the Chart tab, the Summary tab allows you to select the Frame Size and Burst Size values that you want to view by using the Frame Size and Burst Size pull-down menus. The results for each port is displayed in its own row.

The summary results can also be exported as .csv or HTML files using the Results menu (see “Results Menu” on page 65).

Figure 13-6 shows an example of the Summary tab. In this example, the test parameter values are 64 for Frame Size, and one (1) for Burst Size.

![Figure 13-6. Summary Tab](image)

Select the Frame Size you want to view here.
Select the Burst Size you want to view here.
Details Tab

The Details tab (Figure 13-7) displays detailed results for the transmitting and receiving ports for a single iteration in tabular format. You can select the Frame Size and Burst Size for the iteration that you want to view by using the Frame Size and Burst Size pull-down menus.

The detailed results can also be exported as .csv or HTML files using the Results menu (see “Results Menu” on page 65).

Figure 13-7 shows an example of the Details tab. In this example, the selected test parameter values are 64 for Frame Size, and one (1) for Burst Size.

See Table 13-2 or descriptions of the Details tab fields.

![Figure 13-7. Details Tab](image)

Table 13-2. Details Tab Field Descriptions

<table>
<thead>
<tr>
<th>Field (Transmitting Ports)</th>
<th>Description (Transmitting Ports)</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>The transmitting port.</td>
</tr>
<tr>
<td>Test Frames Transmitted</td>
<td>The number of test frames transmitted by this port. Each test frame contains a flag or ‘trigger’ that enables the receiving port to identify it as a test frame.</td>
</tr>
</tbody>
</table>
### Table 13-2. Details Tab Field Descriptions (continued)

<table>
<thead>
<tr>
<th>Field (Receiving Ports)</th>
<th>Description (Receiving Ports)</th>
</tr>
</thead>
<tbody>
<tr>
<td>( To )</td>
<td>The receiving port.</td>
</tr>
<tr>
<td>( Test \text{ Frames Expected} )</td>
<td>The number of test frames this port expects to receive. This number is calculated by totaling all of the test frames that are destined for this port.</td>
</tr>
<tr>
<td>( Test \text{ Frames Received} )</td>
<td>The number of test frames received by this port. If any test frames were dropped, this total will be less than the ( Test \text{ Frames Expected} ) for this port.</td>
</tr>
<tr>
<td>( Total \text{ Frames Received} )</td>
<td>The total number of frames received by this port (including test frames and non-test frames).</td>
</tr>
<tr>
<td>( Test \text{ FrameLost} )</td>
<td>The number of lost (dropped) test frames by this port. If no test frames were lost, forward pressure may exist on this port.</td>
</tr>
</tbody>
</table>

### Counters Tab

The \textit{Counters} tab displays the same test results data for all AST II tests. For a list and descriptions of the various counters, see \textit{Appendix D, “Test Results Counters.”}
Appendix A

Search Algorithms

This appendix contains the search algorithms that AST II uses in Search mode for the Forwarding, Broadcast Forwarding, Address Learning, and Address Caching tests.

In this Appendix...

This appendix covers the following topics:

• About the Search Algorithms . . . . 246
• Forwarding Test . . . . 247
• Broadcast Forwarding Test . . . . 248
• Address Learning Test . . . . 249
• Address Caching Test . . . . 250
About the Search Algorithms

In *Search* mode, the Forwarding, Broadcast Forwarding, Address Learning, and Address Caching tests use search algorithms to adjust the variable test parameter up or down from iteration to iteration.

**Forwarding and Broadcast Forwarding Tests**

For the Forwarding and Broadcast Forwarding tests, the algorithms are used to adjust the *Load* up or down from iteration to iteration. Specifically, the search algorithms are used to calculate the *Load* for the next iteration of the test after the DUT passes or fails at the current *Load*. In general, the *Load* is increased if the DUT passes at the current *Load*, and decreased if the DUT fails at the current *Load*. For information on the pass/fail criteria, see *Table 2-5 on page 29*.

The search algorithms for the Forwarding and Broadcast Forwarding tests are described in the following sections:

- Forwarding test, see *page 247*.
- Broadcast Forwarding test, see *page 248*.

**Address Learning and Address Caching Tests**

For the Address Learning test, the algorithms are used to adjust the *Learning Rate* up or down from iteration to iteration. Specifically, the search algorithms are used to calculate the *Learning Rate* for the next iteration of the test after the DUT passes or fails at the current *Learning Rate*. The *Learning Rate* is increased if the DUT passes at the current *Learning Rate*, and decreased if the DUT fails at the current *Learning Rate*.

The criteria for pass or failure is the same for both of these tests, and is based on whether or not flooding occurred on the *monitor* port.

- **Pass**: Flooding did not occur.
- **Fail**: Flooding did occur.

For the Address Learning test, the test measurement is the *Address Learning Rate* (the maximum rate at which the DUT/SUT can learn new MAC addresses without flooding or dropping frames). For the Address Caching test, the test measurement is the *Address Caching Capacity* (the maximum number of MAC addresses that a DUT/SUT can cache [store] and successfully forward frames to without flooding or dropping frames).

The search algorithms for the Forwarding and Broadcast Forwarding tests are described in the following sections:

- Address Learning, see *page 249*.
- Address Caching, see *page 250*. 
Forwarding Test

The algorithm used to determine the throughput includes the following steps (this algorithm is the same for the Broadcast Forwarding test).

1. Based on the measured frame loss for the current iteration, the Load is adjusted for the next iteration as follows:
   - If the frame loss is less than or equal to the Acceptable Frame Loss, the Load for the next iteration is calculated using this formula. The next iteration begins at the new, increased Load value.
     \[
     \frac{(Current\ Load + Max)}{2}
     \]
   - If the frame loss is greater than the Acceptable Frame Loss, the Load for the next iteration is calculated using this formula. The next iteration begins at the new, decreased Load value.
     \[
     Current\ Rate \times \frac{(Backoff\ Rate) \times (Current\ Rate - Min\ Rate)}{Max\ Load}
     \]

2. This process continues for the duration of the test. The final throughput measurement is reached when the required adjustment (increase or decrease) in the Load is less than the specified Resolution value (see “Resolution” on page 18 for a definition).

Note: If either the specified minimum (Min) or maximum (Max) Load is reached, the trial stops.
Broadcast Forwarding Test

The algorithm used to determine the throughput includes the following steps (this algorithm is the same for the Forwarding test).

1. Based on the measured frame loss for the current iteration, the Load is adjusted for the next iteration as follows:
   - If the frame loss is less than or equal to the Acceptable Frame Loss, the Load for the next iteration is calculated using this formula. The next iteration begins at the new, increased Load value.
     \[
     \frac{(Current\ Load + Max)}{2}
     \]
   - If the frame loss is greater than the Acceptable Frame Loss, the Load for the next iteration is calculated using this formula. The next iteration begins at the new, decreased Load value.
     \[
     Current\ Rate - [(Backoff\ Rate) \times (Current\ Rate - Min\ Rate%)]
     \]

2. This process continues for the duration of the test. The final throughput measurement is reached when the required adjustment (increase or decrease) in the Load is less than the specified Resolution value (see “Resolution” on page 18 for a definition).

Note: If either the specified minimum (Min) or maximum (Max) Load is reached, the trial stops.
Address Learning Test

The algorithm used to determine the *address learning rate* includes the following steps.

1. Based on whether or not flooding occurred on the *monitor* port, one of the following occurs:
   - If flooding did not occur, the *Learning Rate* is **increased** for the next iteration using this formula. The next iteration begins at the new, increased *Learning Rate* value.
     \[
     \frac{(Current + Max)}{2}
     \]
   - If flooding occurred, the *Learning Rate* is **decreased** for the next iteration using this formula. The next iteration begins at the new, decreased *Learning Rate* value.
     \[
     \frac{(Last Passed Rate + Min)}{2}
     \]

2. This process continues for the duration of the test. The final *address learning rate* measurement is reached when the required adjustment (increase or decrease) in the *Learning Rate* is less than two (2).

**Note:** Unlike the other tests, you do not need to specify a resolution value to determine the accuracy of the test. For this test, the resolution is always two (2).
Address Caching Test

The algorithm used to determine the address caching capacity includes the following steps.

1. Based on whether or not flooding occurred on the monitor port, one of the following occurs:
   • If flooding did not occur, the Number of Addresses is increased for the next iteration using this formula. The next iteration begins at the new, increased Number of Addresses value.
     \[
     \text{New Number of Addresses} = \frac{(\text{Current} + \text{Max})}{2}
     \]
   • If flooding occurred, the Number of Addresses is decreased for the next iteration using this formula. The next iteration begins at the new, decreased Number of Addresses value.
     \[
     \text{New Number of Addresses} = \frac{(\text{Last Passed Rate} + \text{Min})}{2}
     \]

2. This process continues for the duration of the test. The final address caching capacity measurement is reached when the required adjustment (increase or decrease) in the Number of Addresses is less than two (2).

Note: Unlike the other tests, you do not need to specify a resolution value to determine the accuracy of the test. For this test, the resolution is always two (2).
Appendix B
Formulas

This appendix contains the formulas that are used to calculate certain values during the tests such as the interburst gap (IBG).

In this appendix...
This appendix contains the following formulas:

• Calculating the InterBurst Gap (IBG) . . . . 252
• Calculating the Transmit Time . . . . 253
• Calculating the Number of Bursts . . . . 254
Calculating the InterBurst Gap (IBG)

The IBG is defined in RFC 2285 as “the interval between two bursts.” The IBG is calculated automatically by AST II for the test based on your Frame Size, Load, Burst Size, and Speed settings using the formula shown in Figure B-1. The IBG is expressed in terms of nanoseconds (ns).

\[
\text{IBG} = \frac{\left[\frac{100}{\text{Intended Load}} - 1\right] \times \text{Burst Size} \times (\text{IFG} + 64 + 8 \times \text{Frame Size})}{\text{Speed}} + \text{IFG}
\]

Where:

- \(\text{Frame Size}\) = The specified frame size in bytes (including the CRC).
- \(\text{Intended Load}\) = The specified Load value in percent (the range is from 1% to 100%).
- \(\text{Burst Size}\) = The specified number of frames in the burst (integer value).
- \(\text{Speed}\) = The speed of the DUT/SUT to which this port is connected in bits per second. Ethernet is 10,000,000 bits per second, Fast Ethernet is 100,000,000 bits per second, Gigabit Ethernet is 1,000,000,000 bits per second.
- \(\text{IFG}\) = The interval (delay) between the transmission of each frame in a burst. The IFG only applies if the Burst Size is greater than one (1).

**Figure B-1.** IBG Formula

**Note:** You can also use the IBG Calculator window to calculate the IBG (see “Using the IBG Calculator” on page 255).
Calculating the Transmit Time

The transmit time (\(T_{xtime}\)) is the duration of each burst in microseconds based on your Burst Size, Frame Size, and Speed settings. The \(T_{xtime}\) is calculated using the formula shown in Figure B-2.

\[
T_{xtime} = \frac{96 + (\text{Burst Size} - 1) + (\text{Burst Size} \times (64 + 8 \times \text{Frame Size}))}{\text{Speed}}
\]

Where:

- \(\text{Burst Size}=\text{Burst Size as specified}\).
- \(\text{Frame Size}=\text{Frame Size as specified}\).
- \(\text{Speed}=10, 100, \text{or } 1000, \text{for } 10Mbps, 100Mbps, \text{or } 1GB \text{ and } 10GB \text{ respectively}\).

Note: You can also use the IBG Calculator window to calculate the \(T_{xtime}\). The Burst Time value shown in the IBG Calculator window (see Figure B-4 on page 255) is the same as the \(T_{xtime}\). The Burst Time is expressed in nanoseconds; the \(T_{xtime}\) is expressed in terms of microseconds.
Calculating the Number of Bursts

The number of bursts is the total number of bursts transmitted during each iteration of the test. The number of bursts is calculated using the formula shown in Figure B-3 (the number of bursts is always rounded up to the nearest integer).

In order to calculate the number of bursts, you must first calculate the IBG (see page 252) and the transmit time (see page 253).

\[
\text{Number of Bursts} = \frac{\text{Duration}}{\text{Txtime} + \text{IBG}}
\]

Where:

- \( \text{Duration} \) = The specified \( \text{Duration} \) (length of each iteration of the test).
- \( \text{Txtime} \) = Transmit time for a burst in microseconds.
- \( \text{IBG} \) = The interval between two bursts (in nanoseconds).

**Figure B-3.** Number of Bursts Formula

**Note:** You can also use the IBG Calculator window to calculate the number of bursts. The Burst Time value shown in the IBG Calculator window (see Figure B-4 on page 255) is the same as the Txtime (the Burst Time is expressed in nanoseconds, the Txtime is expressed in terms of microseconds).
Using the IBG Calculator

Although AST II automatically calculates the IBG for you based on your Frame Size, Load, Burst Size, and Speed settings, you can use the IBG Calculator window to calculate the IBG. You can also use it to calculate the number of bursts and Txtime (transmit time). The procedure below shows you how to use this window to calculate these values.

To calculate the IBG using the IBG Calculator window, follow the steps below:

1. Open the IBG Calculator window (Figure B-4) by doing one of the following:
   - Choose Help > IBG Calculator.
   - Click the IBG Calculator button on the toolbar.
2. Using the Speed pull-down menu, select one of the following options:
   - 10M (10 Mbps - Ethernet).
   - 100M (100 Mbps - Fast Ethernet).
   - 1G (1 Gigabit per second - Gigabit Ethernet).
   - 10G (10 Gigabit per second - Gigabit Ethernet).
3. In the Load field, enter the desired load.
4. In the Frame Size field, enter the desired frame size.
5. In the Burst Size field, enter the desired burst size.
6. In the Duration field, enter the desired duration.

The IBG appears in the IBG (ns) field based on the values you entered in Step 2 through Step 6. Other values such as the Burst Time (displayed as Burst Time) and the number of bursts (displayed as Burst Count) appear below the IBG (ns) field.

Figure B-4. IBG Calculator Window
Appendix C
Valid Test Parameter Values

Table C-1 summarizes the variations in the allowable Test Setup parameter values for the various AST II tests. Consult this table for the valid entries for each parameter.

**Table C-1.** Valid Test Parameter Values and Ranges

<table>
<thead>
<tr>
<th>Test Parameter</th>
<th>Value/Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acceptable Frame Loss (Forwarding Test)</td>
<td>From 0 to 1000000000. Default is 1000.</td>
</tr>
<tr>
<td>Addresses per port</td>
<td>From 1 to 256. (Default is 1.) For address-handling tests (the Address Learning and Address Caching tests), the range of allowable values is from 1 to 16777215.</td>
</tr>
<tr>
<td>Aging Time (Address Learning and Address Caching Tests)</td>
<td>From 1 - 3600 seconds. Default is 15 seconds.</td>
</tr>
<tr>
<td>Backoff Rate (Forwarding Test)</td>
<td>From 0 to 1000000000. Default is 0.5.</td>
</tr>
<tr>
<td>Burst Size</td>
<td>From 1 to 1024. (Default is 1.) For some tests such as the Forwarding and Broadcast Forwarding tests allow you to specify custom Burst Sizes for the test. Other tests such as the Address Learning and Address Caching tests, force the Burst Size to 1 (you cannot set the Burst Size).</td>
</tr>
<tr>
<td>Duration</td>
<td>From 1 to 3000 seconds. (Default is 10.) For the Address Learning and Address Caching tests, the maximum is 3600 seconds.</td>
</tr>
</tbody>
</table>
### Table C-1. Valid Test Parameter Values and Ranges (continued)

<table>
<thead>
<tr>
<th>Test Parameter</th>
<th>Value/Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame Size (all tests except Error Filtering)</td>
<td>From <strong>24</strong> to <strong>16387</strong> bytes.</td>
</tr>
<tr>
<td></td>
<td>Depending on the type of test and the test mode, you are required to specify one, or a number of frame sizes (tests that increment Frame Size require more than one size to be specified). Some tests such as the Forwarding and Broadcast Forwarding tests allow you to specify custom Frame Sizes for the test. When using custom frame sizes, AST II allows a maximum of <strong>2048</strong> different sizes. The defaults custom sizes are the recommended values specified in RFC-2285 (<strong>64, 128, 256, 512, 1024, 1280, 1518</strong>).</td>
</tr>
<tr>
<td>Frame Size (Error Filtering test only)</td>
<td>The allowable ranges vary depending on the frame size option. The allowable ranges per option are:</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Initial MAC address pattern</td>
<td>6 octets. Default is <strong>00 00 00 00 00 00</strong>.</td>
</tr>
<tr>
<td>Learning Rate (Address Learning and Address Caching tests)</td>
<td>From <strong>1</strong> - <strong>10000000</strong> frames per second.</td>
</tr>
<tr>
<td></td>
<td>See the chapters that cover the Address Learning and Address Caching tests for the defaults for the initial, minimum, and maximum values.</td>
</tr>
<tr>
<td>Load</td>
<td>Units = Percent: From <strong>1</strong> to <strong>200</strong>.</td>
</tr>
<tr>
<td></td>
<td>Units = Frames per second: From 1 to the maximum number of frames per second for the technology.</td>
</tr>
<tr>
<td>Load% variation</td>
<td>From <strong>0.00001</strong> to <strong>200</strong> percent.</td>
</tr>
<tr>
<td>Load FPS variation</td>
<td>From <strong>1</strong> to <strong>2000000</strong> frames per second.</td>
</tr>
<tr>
<td>MAC address port offset</td>
<td><strong>0, 1, 2, 3, or 4</strong>. Default is <strong>2</strong>.</td>
</tr>
<tr>
<td></td>
<td>For address-handling tests (Address Caching and Address Learning), the port information can be stored in 1 or 2 bytes.</td>
</tr>
<tr>
<td>MAC address node offset</td>
<td><strong>0, 1, 2, 3, 4, or 5</strong>. Default is <strong>5</strong>.</td>
</tr>
<tr>
<td></td>
<td>For address-handling tests, the address information can be stored in 1 to 3 bytes.</td>
</tr>
</tbody>
</table>
### Table C-1. Valid Test Parameter Values and Ranges (continued)

<table>
<thead>
<tr>
<th>Test Parameter</th>
<th>Value/Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAC address port increment</td>
<td>From 1 to 64. Default is 1.</td>
</tr>
<tr>
<td>Number of Addresses</td>
<td>Non-addressing tests. From 1 to 16777215. Default is 1.</td>
</tr>
<tr>
<td></td>
<td>Addressing tests. From 1 to 256. Default is 1.</td>
</tr>
<tr>
<td>Number of Trials</td>
<td>From 1 to 10. Default is 1.</td>
</tr>
<tr>
<td>(Forwarding Test)</td>
<td></td>
</tr>
<tr>
<td>Protocol Format</td>
<td>Ethernet II (with a choice of 45 different protocol types).</td>
</tr>
<tr>
<td></td>
<td>IEEE 802.3</td>
</tr>
<tr>
<td>Resolution</td>
<td>From 0 to 100000000. Default is 1.</td>
</tr>
<tr>
<td>(Forwarding Test)</td>
<td></td>
</tr>
</tbody>
</table>
Appendix D

Test Results Counters

This appendix provides information on the test results counters that are displayed in the Counters tab for all of the AST II tests.

In this Appendix...

This appendix covers the following topic:

- Counters Tab Fields . . . . 262
## Counters Tab Fields

*Table D-1* lists and describes the test results counters that are displayed in the *Counters* tab for all of the AST II tests.

### Table D-1. Counters Tab Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Received Frames</td>
<td>The total number of frames received by this port (including test frames and non-test frames).</td>
</tr>
<tr>
<td>Transmitted Frames</td>
<td>The total number of test frames transmitted by this port. Each test frame contains a flag or “trigger” that enables the receiving port to identify it as a test frame.</td>
</tr>
<tr>
<td>Received Triggers</td>
<td>The number of “triggers” received by this port.</td>
</tr>
<tr>
<td>Received Bytes</td>
<td>The total number of bytes received by this port (includes test frames and non-test frames).</td>
</tr>
<tr>
<td>CRC errors</td>
<td>The total number of frames containing CRC errors received by this port.</td>
</tr>
<tr>
<td>Align Errors</td>
<td>The total number of alignment errors (misaligned frames) received by this port.</td>
</tr>
<tr>
<td>Oversize Errors</td>
<td>The total number of oversized frames received by this port.</td>
</tr>
<tr>
<td>Undersize Errors</td>
<td>The total number of undersized frames received by this port.</td>
</tr>
</tbody>
</table>
Appendix E
ESD Requirements

Spirent Communications manufactures and sells products that require industry standard precautions to protect against damage from electrostatic discharge (ESD). This document explains the proper process for handling and storing electrostatic discharge sensitive (ESDS) devices, assemblies, and equipment.

The requirements presented in this document comply with the EIA Standard, ANSI/ESD S20.20-1999: Development of an Electrostatic Discharge Control Program, and apply to anyone who handles equipment that is sensitive to electrostatic discharge. Such equipment includes, but it not limited to:

- All electronic assemblies manufactured by Spirent Communications
- Discrete and integrated circuit semiconductors
- Hybrid microcircuits
- Thin film passive devices
- Memory modules

**Caution:** Failure to comply with the requirements explained in this document poses risks to the performance of ESDS devices, as well as to your investment in the equipment.

**General Equipment Handling**

Whenever you handle a piece of ESDS equipment, you must be properly grounded to avoid harming the equipment. Also, when transporting the equipment, it must be packaged properly. Follow the requirements below to help ensure equipment protection.

- Wrist straps must be worn by any person handling the equipment to provide normal grounding.
- The use of foot straps is encouraged to supplement normal grounding. If foot straps are used exclusively, two straps (one on each foot) should be used. Note that foot straps are only applicable in environments that use ESD flooring and/or floor mats.
- Hold ESDS equipment by the edges only; do not touch the electronic components or gold connectors.
- When transporting equipment between ESD protected work areas, the equipment must be contained in ESD protective packaging. Equipment that is received in ESD
Appendix E: ESD Requirements

protective packaging must be opened either by a person who is properly grounded or at an ESD protected workstation.

- Any racks or carts used for the temporary storage or transport of ESDS equipment must be grounded either by drag chains or through direct connection to earth ground. Loose parts that are not protected by ESD-safe packaging must not be transported on carts.

Workstation Preparation

The ideal setup for working with ESDS equipment is a workstation designed specifically for that purpose. Figure E-1 illustrates an ESD protected workstation. Please follow the requirements listed below to prepare a proper ESD protected workstation.

- The ESD Ground must be the equipment earth ground. Equipment earth ground is the electrical ground (green) wire at the receptacles.

- An ESD protected workstation consists of a table or workbench with a static dissipative surface or mat that is connected to earth ground. A resistor in the grounding wire is optional, providing that surface resistance to ground is \( \geq 10^5 \) to \( \leq 10^9 \) \( \Omega \).

- The workstation must provide for the connection of a wrist strap. The wrist strap must contain a current limiting resistor with a value from \( \geq 250\text{K} \) \( \Omega \) to \( \leq 10\text{M} \) \( \Omega \).

- ESD protective flooring or floor mats are required when floor-grounding devices (foot straps/footwear) are used or when it is necessary to move in between ESD protected workstations when handling ESDS equipment.

![ESD Protected Workstation](image)

**Figure E-1.** ESD Protected Workstation

**Note:** The equipment needed for proper grounding is available in ESD service kits, such as the ESD Field Service Kit available from Spirent Communications (P/N 170-8505). For additional information regarding Spirent Communications ESD standards and procedures, please see the ESD Control Procedure document (P/N 900-0211-001).
Appendix F
Fiber Optic Cleaning Guidelines

Spirent Communications manufactures and sells products that contain fiber optic components, including fiber optic transmitters and receivers. These components are extremely susceptible to contamination by particles of dirt or dust, which can obstruct the optic path and cause performance degradation. To ensure optimum product performance, it is important that all optics and connector ferrules be kept clean.

This document presents guidelines for maintaining clean fiber optic components. Spirent Communications recommends that these guidelines be followed very closely.

Caution: • Failure to comply with the guidelines explained in this document poses risks to the performance of fiber optic-based devices, as well as to your investment in the equipment.

• Whenever you handle a piece of equipment that contains fiber optic components, you must be properly grounded to avoid harming the equipment. Refer to the Appendix in this document titled ESD Requirements for more details on ESD.

Cleaning Guidelines

To ensure the cleanliness of fiber optic components, follow the guidelines below:

• Use fiber patch cords (or connectors if you terminate your own fiber) only from a reputable supplier. Low-quality components can cause many hard-to-diagnose problems during an installation.

• Dust caps are typically installed on fiber optic components to ensure factory-clean optical devices. These protective caps should not be removed until the moment of connecting the fiber cable to the device. Ensure that the fiber is properly terminated, polished, and free of any dust or dirt. Also make sure that the location of installation is as free of dust and dirt as possible.

• Should it be necessary to disconnect the fiber device, reinstall the protective dust caps.

• If you suspect that the optics have been contaminated, alternate between blasting with clean, dry, compressed air and flushing with methanol to remove particles of dirt.
Appendix G
Revision History

Spirent Communications increments the revision letter in a manual’s part number when the technical content changes. When minor non-technical changes (cosmetic or editorial) are made, the revision letter does not increment.

This revision history for the AST II User Guide begins with Revision A.

**Revision A**: (August 1999) First release of this manual.

**Revision B**: (March 2001) Updated the manual to include AST II 2.00 updates.

**Revision C**: (November 2001) Updated the manual to include AST II 2.10 updates.

**Revision D**: (August 2003) Updated the manual to include AST II 3.00 updates. The following changes were made to the manual:

- Updated overall layout and format of the manual and made general text corrections.
- Changed software version references to version 3.00 throughout the manual.
- Updated the list of related manuals (see “Related Manuals” on page 5).
- Updated technical support contact information (see “How to Contact Us” on page 6). Added references to Spirent Communications’ Customer Service Center website throughout manual.
- Updated the supported hardware list to include the SmartBits 6000C chassis, the ATM-3451A/3453 modules, and the LAN-3306A/3320A/3321A/3324A/3325A/3327A modules (see “SmartBits Hardware Requirements” on page 42). Also updated all other card descriptions and included SmartBits 6000C references throughout the manual.
- Updated the AST II operating system support under “PC Requirements” on page 44.
- Updated the AST II software installation procedure under “Installing AST II” on page 45.
- Updated the AST II connection procedures and included additional information that pertains to multiple chassis environments (see “Connection Procedures” on page 46).
- Updated Card Setup tab information to include the new Interface field (see “Card Setup Tab” on page 61). Also added this field to the port configuration procedure (see “Configuring Ports Individually” on page 90) and port configuration parameter table (see Table 5-1 on page 91). Updated screen shots of the Card Setup tab throughout the manual.
• Deleted the reference to the ASTIIapi.ini file as a means of modifying the delay between test iterations. (The reference was deleted from the Duplex parameter description in Table 5-1, “Card Setup Parameters,” on page 91.) The delay between test iterations can now be specified by the new Delay After Transmit parameter on the Options tab.

• Updated Options tab information to include the new Stagger Start and Delay After Transmit parameters (see “Options Tab” on page 60). Also added these parameters to the option setup procedure (see “Setting the Test Options” on page 94) and test options table (see Table 5-2 on page 96). Updated screen shots of the Options tab throughout the manual.

• Updated the Frame Setup procedure, including the addition of the new IP Header and Type of Service parameters (see “Setting the Frame Setup Parameters” on page 98 and Table 5-3 on page 100). Also modified the Protocol Type field and Configure IP Header checkbox descriptions.

• Clarified Aging Time and Number of Addresses field descriptions in the Address Learning test configuration procedure (see “Configuring Test Parameters” on page 155). Also replaced the Address Learning test results Chart tab image; the new image shows the Pass/Fail test indication (see Figure 8-4 on page 160).

• Clarified Aging Time, Learning Rate, and Number of Addresses field descriptions in the Cache Learning test configuration procedure (see “Configuring Test Parameters” on page 171). Also replaced the Address Caching test results Chart tab image; the new image shows the Pass/Fail test indication (see Figure 9-4 on page 176).

• Removed information on Counters tab debug buttons from Appendix D, “Test Results Counters.” (The debug buttons were removed from the Counters tab in the AST II 3.00 application.) Also removed the reference to these debug buttons in the section, “Counters Tab” on page 78.

Revision E: (December 2003) Updated the manual to indicate the AST II software version update from 3.00 to 3.10. No other content in the manual was affected by this software update.
This glossary describes the terminology, abbreviations, and acronyms introduced in this guide, as well as terms based on telecommunications technology and standards.

**Note:** Key terms and concepts for the various AST II tests are listed and described in Chapter 2, “Basic AST II Theory.”

**Address Caching Capacity**
The number of MAC addresses that a DUT/SUT can cache (store) without flooding or dropping frames. You use the Address Caching test to determine the address caching capacity of the DUT/SUT (see Chapter 9, “Address Caching Test.”).

**Address Learning Rate**
The rate of traffic (frames per second) at which the DUT/SUT can learn new MAC addresses without flooding or dropping frames. You use the Address Learning test to determine the rate at which the DUT/SUT is able to learn MAC addresses (see Chapter 8, “Address Learning Test.”).

**Autonegotiation**
Autonegotiation (AN) is an optional standard function defined in the 1998 IEEE 802.3 specification. It enables device interfaces to achieve their highest possible mode of operation over a link segment by providing a means for them to exchange information about their capabilities (such as speed and duplex) over the link. AN is a process that takes control of the interface media when a connection to another network interface is established. AN detects the operating capabilities of the other interface (known as the Link Partner) and also advertises the capabilities of the local interface. The highest common performance mode is then selected and configured.

This allows simple, automatic connection of device interfaces that support different modes of operation. In effect, AN automatically switches to the correct technology, such as 10BASE-T, 100BASE-TX, 100BASE-T4, or a corresponding full duplex mode. Once the highest common performance mode has been determined, AN gives control of the interface media to the appropriate transmission technology and becomes transparent until the connection is broken. For example, if one side of the link only supports 10 Mbps at half duplex and the other 10/100 Mbps at half duplex, AN establishes the link at 10 Mbps speeds at half duplex. If the AN option is selected, speed and duplex selection for individual cards is disabled.
**Broadcast Latency**

The time it takes for the DUT/SUT to forward a broadcast frame to each destination port in a broadcast domain.

**Burst**

A sequence of a specified number of frames transmitted with the minimum legal interframe gap (see “Interframe Gap (IFG)” on page 271 for a definition of the interframe gap). The number of frames in a burst is called the burst size.

**Burst Count**

The number of bursts transmitted back-to-back during a transmission. For information on how this is calculated, see “Calculating the Number of Bursts” on page 254.

**Burst Size**

The number of frames transmitted back-to-back in a burst. You specify number of frames using the Burst Size test parameter (this parameter applies to all tests). You can also specify custom burst sizes (see “Using Custom Burst Sizes for the Test” on page 105 for more information). If Burst Size is greater than one (1) the traffic is considered bursty. If it is set to one (1) the traffic is considered continuous. When Burst Size is greater than one (1), AST II automatically sets the interframe gap (IFG) to the minimum permissible delay for the technology.

**DUT**

Device under test.

**Errored Frames**

Frames that are over-sized, under-sized, misaligned, or contain an errored Frame Check Sequence (FCS). Use the Error Filtering test to determine the ability of the DUT/SUT to recognize specific errors, and filter (drop) the frames that contain the errors (see Chapter 10, “Error Filtering Test.”).

**Forward Pressure**

Forward pressure occurs when the DUT/SUT inhibits or aborts its back-off algorithms in an attempt to increase its forwarding performance under congested conditions. Forward pressure is indicated if no frame loss occurs under congestion (when forward pressure occurs, the Interframe Gap is smaller than the legal limit). Use the Forward Pressure test to test for this condition (see).

**Frame Size**

The size of the frames in terms of bytes. You can specify this using the Frame Size test parameter. You can also specify custom frame sizes (see “Using Custom Frame Sizes for the Test” on page 104 for more information).

**Fully-Meshed**

One of the traffic distribution patterns. All ports in the test transmit to every other port in the test and receive traffic from all other ports in the test simultaneously. See Table 2-1 on page 14 for an example of the fully meshed traffic distribution pattern.
**Head of line Blocking**

Head of line blocking occurs when the DUT/SUT restricts the flow of traffic from an external source in an attempt to reduce or minimize frame loss under congested conditions. Head of line blocking is indicated by frame loss on an uncongested port of the DUT/SUT when another port is congested. Use the Congestion Control test to test for this condition (see *Chapter 7, “Congestion Control Test”*). Although the test used to test for the head of line blocking condition is sometimes called the “Head of line Blocking” test, in AST II it is referred to as the Congestion Control test.

**Interburst Gap (IBG)**

The IBG is the interval (delay) between bursts in a transmission in terms of microseconds. The IBG is based on several variables. See “Calculating the InterBurst Gap (IBG)” on page 252 for the formula used to calculate the IBG.

**Interframe Gap (IFG)**

The IFG is the interval (delay) between the transmission of each frame in a burst. The IFG only applies if the Burst Size test parameter is greater than one (1). The IFG value must not be less than the minimum permissible value specified by the standard for the medium being tested. For 10 Mbps Ethernet, the minimum is 9.6 µs, for 100 Mbps Ethernet, it is 960 ns, and for 1 Gbps Ethernet, it is 96 ns.

**Latency**

The length of time from when the DUT receives a frame to when it forwards that frame. AST II implements the cut-through type of latency measurement. The latency measurement is based on the first bit in (received) to the first bit out (forwarded).

**Load**

The amount of utilization of the medium in terms of frames per second or as a percentage of the full wire rate. You set the units for the Load using the Options tab (see “Setting the Test Options” on page 94).

**Minimum Interframe Gap**

The minimum permissible gap (delay) between frames specified by the standard for the medium being tested. For 10Mbps Ethernet the minimum is 9.6 µs, for 100Mbps Ethernet it is 960 ns, and for 1 Gbps Ethernet it is 96 ns. You use the Forward Pressure test to see if your DUT/SUT is in conformance with these minimum IFG values. Although the test used to test for the minimum IFG is sometimes called the “Minimum IFG” test, in AST II it is referred to as the Forward Pressure test.

**Non-Meshed**

One of the traffic distribution patterns. All of the non-meshed traffic distribution pattern options are port pairs. You can set up the test to have a single port-pair, or multiple port-pairs. There are three options for this traffic distribution pattern. See *Table 2-1 on page 14* for examples of the non-meshed traffic distribution pattern options.
**Partially-Meshed**

One of the traffic distribution patterns. There are three basic options: one-to-many, many-to-one, and many-to-many. Since you must also specify the traffic direction (bidirectional or unidirectional) there are a total of six possible partially meshed traffic pattern options. See *Table 2-1 on page 14* for examples of the partially meshed traffic distribution pattern options.

**Rx**

Abbreviation for a SmartCard/module receiving (destination) port.

**SUT**

System under test.

**Traffic Distribution**

Refers to the pattern (distribution) of the traffic flow during the test. The traffic distribution pattern options vary depending on the type of test you have selected. The three option for AST II are fully-meshed, partially-meshed (fanout), and non-meshed (pair-wise). See “Fully-Meshed” on page 270, “Non-Meshed” on page 271, and “Partially-Meshed” on page 272.

**Traffic Orientation**

Refers to the direction of the traffic flow during the test. The traffic orientation options vary depending on the type of test you have selected. The two option for AST II are bidirectional and unidirectional. See *Table 2-1 on page 14* for descriptions of these different traffic orientation options.

**Throughput**

The maximum rate at which the DUT/SUT can forward traffic with no frame loss, or at a user-specified acceptable frame loss. You use the Forwarding and Broadcast Forwarding tests to measure throughput (see *Chapter 6, “Forwarding Test”* and *Chapter 11, “Broadcast Forwarding Test”* for more information).

**Tx**

Abbreviation for a SmartCard/module transmitting (source) port.

**txtime**

Transmit time for a *burst* in microseconds. See “Calculating the Transmit Time” on page 253 for the formula used to calculate the transmit time.
Index

A
Address Caching test
description 166
pass/fail criteria 35
search algorithms 250
selecting ports 170
starting and stopping 174
supported traffic distribution types 167
test methodology 168
test setup parameters 172
test setup steps 171
test structure 34
traffic flow 168
viewing test results 175
Address Learning test
description 150
pass/fail criteria 35
search algorithms 249
selecting ports 154
starting and stopping 158
supported traffic distribution types 151
test methodology 153
test setup parameters 156
test setup steps 155
test structure 34
traffic flow 152
viewing test results 159
AST II
benefits of 10
description 8
features and capabilities 9
general test structure 23
hardware requirements 42
installing 45
online help 5
PC requirements 44
related manuals 5
summary of tests 11
supported hardware 42
supported RFCs 10
test methodology 20

B
benefits of AST II 10
Broadcast Forwarding test
binary search parameters 29
description 198
pass/fail criteria 29
search algorithms 248
Search mode 28
selecting ports 202
starting and stopping 208
supported traffic distribution types 199
test methodology 201
test setup parameters 205
test setup steps 204
traffic flow 200
used to determine 198
viewing test results 209
Broadcast Latency test
description 216
selecting ports 219
starting and stopping 223
supported traffic distribution types 217
test methodology 218
test setup steps 221
traffic flow 217
used to determine 216
viewing test results 224
bursts
calculating number of 254
custom sizes 105

C
Card Setup tab
description 61
parameter values 91
setting parameters 88
Chart tab
Address Caching test results 176
Address Learning test results 160
Broadcast Forwarding test results 210
Broadcast Latency test results 225
Congestion Control test results 144
Error Filtering test results 193
Forward Pressure test results 241
Forwarding test results 128
general information 73
selecting the display format 74
Chart Wizard, using 75
configuration files
editing a previously-saved file 109
loading a previously-saved file 108
using 106
Congestion Control test
description 134
selecting ports 137
starting and stopping 142
supported traffic distribution types 135
test methodology 136
test setup parameters 140
test setup steps 139
traffic flow 135
used to determine 134
viewing test results 143
connection indicator light 71
connections
AST II to SmartBits 50
Ethernet 48
PC to SmartBits 47
serial 49
SmartBits connection names 52
SmartBits to DUT 54
synchronizing chassis 46
Conventions used in this guide 4
Counters tab
field descriptions 262
general information 78
csv files, exporting test results 82
D
Details tab
Address Caching test results 178
Address Learning test results 162
Broadcast Forwarding test results 212
Broadcast Latency test results 227
Congestion Control test results 146
Error Filtering test results 195
Forward Pressure test results 243
Forwarding test results 130
general information 77
DUT
connecting to 54
preparing 53
E
Edit menu 62
Error Filtering test
available errors 182
description 182
selecting ports 186
starting and stopping 191
supported error types by interface 183
supported traffic distribution types 184
test methodology 185
test setup parameters 188
test setup steps 187
traffic flow 184
used to determine 182
viewing test results 192
Ethernet connection 48
exporting test results 80
F
feature overview, AST II 9
fiber optic cleaning guidelines 265
File menu 62
formulas
InterBurst Gap (IBG) 252
number of bursts 254
transmit time (Txtime) 253
Forward Pressure test
description 230
selecting ports 234
starting and stopping 239
supported traffic distribution types 232
test methodology 233
test setup parameters 237
test setup steps 236
traffic flow 232
used to determine 230
viewing test results 240
Forwarding test
binary search parameters 29
description 112
pass/fail criteria 29
recommended testing method 127
search algorithms 247
Search mode 28
selecting ports 119
starting and stopping 126
test methodology 118
test setup parameters 122
test setup steps 121
traffic distribution types 113
traffic flow 117
used to determine 113
viewing test results 127
Frame Setup tab
description 59
parameter values 100
setting parameters 98
frame sizes, custom 104
G
general test terminology 14
H
hardware requirements 42
Help menu 66
HTML files, exporting test results to 79
I
installing AST II 45
InterBurst Gap (IBG)
calculation formula 252
using IBG calculator 255
Index

M
main window
Card Setup tab 61
connection indicator light 71
Frame Setup tab 59
general information 56
menus 61
Options tab 60
overview of displays 56
Results display 72
Setup and Run display 57
shortcut bar 70
SmartCard/module port display 52
Test Setup tab 58
toolbar 68
menus (main window)
Edit menu 62
File menu 62
Help menu 66
Results menu 65
SmartBits menu 64
Test menu 64
View menu 63
modules
port display 52
reserving 85, 87
unreserving 87
viewing 86

O
online help, AST II 5
Options tab 60
parameter values 96
setting parameters 94

P
parameters
changing 88
general values for various tests 257
PC requirements 44
ports
changing parameters 88
configuring all ports simultaneously 89
configuring ports individually 90
numbering 52
Profile mode
definition 24
duration set to continuous 27
duration set to seconds 25

R
reserving modules 85, 87
Results display
Chart tab 73
Counters tab 78
Details tab 77
general information 72
Status bar 79
Summary tab 75
Results menu 65
RFCs supported 10
running a test
Address Caching test 174
Address Learning test 158
Broadcast Forwarding test 208
Broadcast Latency test 223
Congestion Control test 142
Error Filtering test 191
Forward Pressure test 239
Forwarding test 126

S
saving test results 80
search algorithms
Address Caching test 250
Address Learning test 249
Broadcast Forwarding test 248
Forwarding test 247
general information 246
Search mode
Broadcast Forwarding test 28
definition 24
Forwarding test 28
serial connection 49
Setup and Run display 57
shortcut bar (main window) 70
SmartBits menu 64
Status bar (Results display) 79
Summary tab
Address Caching test results 177
Address Learning test results 161
Broadcast Forwarding test results 211
Broadcast Latency test results 226
Congestion Control test results 145
Error Filtering test results 194
Forward Pressure test results 242
Forwarding test results 129
general information 75
supported hardware 42
synchronizing chassis 46

T
technical support contact 6
Test menu 64
test methodology 20
test options
description of 96
setting 94
test results
Address Caching test 175
Address Learning test 159
Broadcast Forwarding test 209
Broadcast Latency test 224
Congestion Control test 143
Error Filtering test 192
Forward Pressure test 240
Forwarding test 127
saving to .csv files 82
saving to HTML files 80
Test Setup tab 58
  Address Caching test 171
  Address Learning test 155
  Broadcast Forwarding test 204
  Broadcast Latency test 221
  Congestion Control test 139
  Error Filtering test 187
  Forward Pressure test 236
  Forwarding test 121

tests, AST II
  Forwarding test 112
general steps to setup and run 39
general structure of 23
  modes 24
  number of trials 23
  parameters 23
  phases of 20
  preparing the DUT 53
  summary of 11

toolbar (main window) 68
traffic distribution types
  Address Caching test 167
  Address Learning test 151
  Broadcast Forwarding test 199
  Broadcast Latency test 217
  Congestion Control test 135
  Error Filtering test 184
  Forward Pressure test 232
  Forwarding test 113

traffic flow
  Address Caching test 168
  Address Learning test 152
  Broadcast Forwarding test 200
  Broadcast Latency test 217
  Congestion Control test 135
  Error Filtering test 184
  Forward Pressure test 232
  Forwarding test 117
transmit time (Txtime) formula 253
trials, number of 23

U
unreserving modules 87
User Guide
  content overview 2
  related manuals 5
  revision history 267

V
View menu 63